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CHAPTER 1 Introduction

Product Overview | ALL

Welcome to NetSimplicity’s Meeting Room Manager (MRM), the easiest-to-use, most
customizable room and resource scheduling application in the market. MRM can be easily
tailored to your organization’s specific operational approach to meeting room
management. It allows users connected to your network to quickly view and change
information about existing meetings and easily reserve new meetings.

MRM allows users to create and manage meeting reservations using a DHTML-enabled
web browser such as Microsoft Internet Explorer (versions 6.0 or 7.0) or or Mozilla Firefox (
versions 1.5 or 2.0).

Once installed on a server meeting the system requirements, internal and external users
can manage reservations using a web browser or Microsoft Outlook.

Documentation Overview | ALL

This Administrators Guide has been created for MRM users who administrate their
organization’s MRM database. Additional documentation available for this version of
Meeting Room Manager is as follows:

+ MRM 7 Installation Guide

+ MRM 7 Administrators Guide
+ MRM 7 User Guide

+ MRM 7 Release Notes

C;j Meeting Room Manager
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+ MRM 7 Fixed Issues List
+ NetSimplicity Knowledge Base

Each of these documents is available on the NetSimplicity Support Site. Log in at:

http://www.netsimplicity.com/support

Meeting Room Manager Editions Overview

ALL

There are two versions of MRM 7 available; Enterprise and Pro. The major differences
between the two are described in the table below. This manual has been written for the

Enterprise version.Enterprise

Feature Pro Enterprise
MRM Outlook Scheduling NO YES

MRM Services Management Optional YES

Active Directory Synchronization NO YES

Wait List YES YES

LCD Panels Optional Optional
Polyvision Room Wizard Support Optional Optional

Understanding Users | ALL

To help you understand how MRM was designed to work, this manual has been written
with five common user types in mind. These five types are based on a sample
organization’s structure. Each section in this manual displays the name tiles of
corresponding user types. This indicates which sections of the manual apply to which

users.
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Because MRM is easily customized, your organization may choose to combine some of
these roles and give them to one user or split up some of these roles between multiple

individuals.

Here are the five user types assigned to fictional staff in an organization with its head

office in New York and an office in Seattle.

Kate, Global MRM Administrator, New York

« activating purchased modules
- creating security groups

- assigning users to their respective security groups

« setting database options
+ adding locations

Kate

Kate is responsible for high level management and configuration of the
database. She is responsible to set up MRM for users and change settings
in the future as necessary. These setup tasks include:

- customizing the forms, images, and labels in the interface

« setting up the Services Management module for use

Luke, Local MRM Administrator, Seattle

confirmation

+ reporting usage data to local management

Qij Meeting Room Manager

- creating local resources in the database

Luke is responsible for local management of the database and reservations.
These local management tasks include:

« confirming meetings that have been requested or otherwise require a
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Juliette, Local Service Administrator, Seattle | Juliette

Juliette is responsible to manage services locally by using the Manage
Services form. The local services management tasks include:

. setting up local service items, their availability, and their pricing
« confirming and refusing order requests

This role is dependent upon the Services Management module being enabled.

Charlie, User, Seattle | Charlie

Charlie is responsible for scheduling reservations and placing service
requests as required.

Though users are granted permissions to create reservations, Kate as global
administrator may choose to require that each booking placed by a user is
confirmed by an administrator like Luke.

Users like Charlie often do not have permission to view or change other
user’s reservations. In circumstances where it would be useful, Charlie may be assigned as
a delegate for other users’ reservations. When acting on the organizer’s behalf, Charlie is
granted the permissions of the meeting’s organizer.

Bob, Requesting User, Seattle | Bob

Bob is responsible for requesting meetings as required through the
Meeting Request form. He cannot choose the room in which the meeting
will be held.

Because Bob is not a user who accesses the MRM interface, the only section
of this manual that applies to him is the “Request a Meeting” section of the
“Meeting Requests” chapter. Sections of this manual which apply to all user
types do not apply to requesting users.
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There are two typical cases where the
Meeting Request form would be
used. The first is referred to as a
centralized process. A few
administrators control the database
and anyone who wishes to make a
reservation must place a request and
have it confirmed and assigned to a
resource by an administrator.

The second process is called a de-
centralized process. Most staff use
the Meeting Room Manager user
interface to schedule self-service
bookings. The Meeting Request form
is used only for guests who require
the use of resources. For example, a
consultant may need to host a
meeting or use a room as an office for
a short period. To save administrators
the time of creating usernames for
these short term guests and to
provide an extra element of security,
these guests can only request
meetings.

Q‘S Meeting Room Manager
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System Requirements | ALL

Server Requirements (In House Installations Only)

On the Server:
Minimum
« Pentium Il or better processor
+ 300 MB of available hard-drive space
+ 512 MB of RAM
+ Microsoft Windows 2000 or 2003 Server
+ Microsoft IS 5.0 or 6.0
+ Microsoft.NET Framework 2.0
+ Microsoft Data Access Components (MDAC) 2.8 or above
« Microsoft SQL Server 2000 or 2005 (Workgroup or higher-level editions are
recommended. MRM will operate with Desktop and Express editions.)

Recommended
. 2GB of RAM

+ 128 MB of additional RAM for every 20 concurrent licenses
- Dual processors operating at 3 GHz (Intel Xeon)

On Each Workstation:
+ Web browser, one of:
« Microsoft Internet Explorer 6.0 or 7.0
+ Mozilla Firefox 1.5 or 2.0
+ Recommended resolution of 1024 x 768

+ Email features (optional): Microsoft Outlook 2003 or 2007 is recommended but
other MAPI-compliant email clients can be used

« For the optional Outlook integration feature:
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« Microsoft Outlook 2003 or 2007
« .NET Framework 2.0

Optional Report Customization Features

MRM includes a Crystal Reports viewer to enable users to generate and view standard
reports. Optionally, customers may create new reports and modify existing reports by
licensing Business Objects Crystal Reports XI

« Outlook Integration features (optional): Outlook 2000 or above

Installation and Activation | Kate

Installation and product activation instructions for MRM are available in the MRM 7
Installation Guide which can be downloaded from the NetSimplicity Support Site located
at: http://www.netsimplicity.com/support

SQL Server 2005 Configuration

You must perform this configuration if you are using Microsoft SQL 2005. If this procedure
is not done, MRM emails may not be sent out.

To configure SQL 2005:

1. Select Start>Microsoft SQL Server 2005Configuration Tools>SQL Server
Surface Area Configuration.

Click on Surface Area Configuration For Features.
From the list, select OLE Automation.

Check Enable OLE Automation.

Click OK to save the change

ok W

Configuration finished.

Q_al Meeting Room Manager
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Setup Wizard | Kate

The setup wizard is part of the installation process and determines some of the database
configuration settings. These settings are as follows:
« Virtual directory name and location
« SQL Server username and password for MRM to use to access the SQL database.
« Web server authentication: Meeting Room Manager authentication or Microsoft
Windows authentication

To change these settings, run the setup wizard on the server by selecting Start > All
Programs > Meeting Room Manager 7 > Setup Wizard.

For details on the steps through the setup wizard, refer to the MRM 7 Installation Guide
which can be downloaded from the NetSimplicity Support Site at: http://
www.netsimplicity.com/support

Run Meeting Room Manager | ALL

To run MRM from your web browser:

1. Launch your web browser.

2. Inthe address line of your browser, type the name of your web server followed by the
virtual directory name. For example:

http://webserver1/MRM7/

3. Depending upon your user settings, you may be asked for a username and password
in order to log into the MRM database. For details, refer to the “Log In” section of the
“Security” chapter.

If you are the administrator logging into your database for the first time, use the
username Admin with no password. Ensure that you set up the security settings
before making your database live to users. Refer to the “Security” chapter for details.

The first time MRM is run with a new database, you are prompted to add a
resource each time the grid loads until at least one resource has been added.
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Juliette

Prepare Database for Users | Kate

To prepare your database for your users, take the following steps according to the details
in the corresponding chapters of this manual:

1. Set Database Options
Refer to the “Reservation Database Configuration” chapter for details.

The SMTP server must be configured before users are granted access to
your database. Refer to the “Configure the Mail Server” section of the
“Reservation Database Configuration” chapter.

2. Set Security Definitions
Refer to the “Security” chapter for details.

3. Customize the Database (optional)
Refer to the “Customizations” chapter for details.

4., Create Locations and Resources
Refer to the “Locations” and “Resources & Requirements” chapters for details.

5. Create Services Item(s) (optional)
Refer to the “Services Management Module” chapter for details.

User Licenses | ALL

MRM controls the number of users that can be logged into your database based on the
number of concurrent licenses that have been purchased.

A concurrent user license is in use once a user logs in. When a user clicks the Log Out
button or the IIS server times out the user’s session, the concurrent license is released for
use by another user. To change the IIS server’s session time out settings, refer to the
“Adjust Session Timeout” section of this chapter.

Users will encounter the “No Concurrent User Licenses Available” message once all
licenses are in use. This can be avoided if everyone uses their own username to log in and
everyone logs out when finished using MRM

M
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If your users are seeing this message frequently, you may choose to purchase additional
licenses. For pricing information or to place an order, please contact the sales center at
1.866.248.0480.

For an example of license usage, an organization with 200 staff members, each with their
own username, may have purchased 20 concurrent user licenses. In this case, only 20
usernames can be logged into the database at the same time.

To check the frequency at which users are being locked out, use the Locked Out Users
Report. Refer to the section of this chapter entitled “Locked Out Users Report” to find out
how.

Release Concurrent Licenses | Kate

A concurrent user license is in use once a user logs in. Upon clicking the Log Out button or
the IS server timing out the user’s session, the concurrent user license is released for use
by another user.

If a user does not click the Log Out button before closing the web browser, MRM waits for
the IIS session to time out. MRM administrators with the Change Permissions permission
enabled can disconnect users in order to release the license without waiting for the IIS
session to time out.

To release a concurrent license:

1. Logged in as a user with administrative permissions, click the Admin icon.
The Admin Console opens.

2. Click the Users icon. The list of users opens.

3. Atthe bottom of the list, click the Active Users icon.

The Active Users window opens to display the list of currently active users. It also
displays the number of concurrent licenses enabled.

4. To theright of the username you wish to disconnect, click the Disconnect text.

5. Click OK to exit the Active Users window.
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Locked Out Users Report | Kate

MRM allows global administrators like Kate to view a report on how many users are being
locked out because all concurrent licenses are in use. This report displays the username,
time, and date of each lockout. It can be filtered to show the lockouts for one user is
particular, one date in particular, or a combination of the two.

To view the Locked Out Users report:

1. Click the Admin icon to open the Admin console.

d> W N

6.

Adjust Session Timeout | Kate

Click the Users icon to open the list of users.
At the bottom of the list, click the Locked Out Users icon.

The report’s dialog box opens. To filter the report, select the following:

« Username field: Select a username in order to view the number of times this user
has been locked out of MRM. To see all users, select All Users from the menu.

- Date field: Enter a date or click on the calendar to select a date to view which users
were locked out of MRM. To view all dates, leave this field blank.

. Click the Update Selected to view the results.

The report details are displayed in the lower portion of the screen.

Click OK to return to user list.

For MRM, the concurrent user licenses’ IIS session time out time is set in the web.config
file which can be found in the MRM installation folder. By default, this folder is “C:/
Program Files/Meeting Room Manager 7"

To adjust session time out:

1.

Q_al Meeting Room Manager

Open the web.config text file in a text reading program such as Notepad.
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2. By default, the following is a line in the web.config text file:

<forms loginUrl="default.aspx" name="ASPXMRM" protection="All" timeout="20" />

Change the “20” to the number of minutes that you wish MRM to wait after an active
user becomes inactive before disconnecting the user from the user license.



CHAPTER 2 Reservation Database
Configuration

Understanding Your Reservation Database | ALL

Your reservation database consists mainly of reservations, but it also contains options,
user interface images and labels, and form layout information such as customized tabs
and fields. Each of these customizable settings are covered in this chapter.

Options | Kate

Options are a group of administrative setup options that are specific to your reservation
database. They are usually set by the global administrator as they affect every user that
accesses your reservation database.

To access and edit options, select the Admin icon, then the Options icon.

The following sections describe the functions of each of the tabs on the Options form.

Schedule Tab | Kate

Business Hours

This setting only determines the default setting. Business hours are set by location in the
Location Detail form.

The Business Hours Start Time and End Time fields are the hours that your
organization opens for business and closes. Only the reservations which are scheduled to

C;j Meeting Room Manager
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take place within business hours are displayed in the Day and Time Line views of the
reservation grid. Reservations can still be scheduled outside of business hours, even
though these reservations are not visible on the grid in the Day and Time Line views.

Default Interval

The default time interval is the number of minutes between each interval in the grid, such
as five, fifteen, or thirty minutes.

Setup/Cleanup Time

Time may be scheduled outside of the reservation to allow for preparation of the meeting
room as well as cleanup after the meeting is finished. The time is reserved outside the
scheduled meeting start and end and is set to default at zero minutes.

Enter new values to change the default setup and cleanup times. To hide this option
completely in the Reservation form, enter -1 as the default time.

Colors Tab | Kate

The Colors tab allows for color-coding to be assigned to each different type of reservation.
The colors assigned here are then used on the grid to display the reservation type of each
reservation.

Creating Reservation Types

Before assigning colors to each reservation type, it is best to define the reservation types
required by your organization.

To define reservation types:

1. Click the Reserveicon.

2. On the General tab, click the down arrow next to the reservation type field.
The list of defined reservation types opens.

3. Click Add.
The Value List Entry window opens.

4. Enter the new reservation type name and description. Click OK.
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5.

Repeat steps 2 to 4 until all required reservation types have been added.

Cell Color

The colors used to display reservations on the grid are defined with this procedure.

To assign a color to a reservation type:

1.
2.
3.

Click Add. A blank entry appears in the Cell Color panel.
Click the pull-down icon next to the new entry.
The list of defined reservation types opens.

Select the appropriate reservation type.

To assign colors to the new entry, click the white space beneath the Confirmed or Not
Conf. columns.

. The Color Picker window appears. Select the desired color.

To assign a color that is not included in the Color Picker, enter the html code for
the desired color in the text field below the color palette and click OK. For example,
248752 is a shade of green, while 808080 is a shade of gray.

A different shade of the same color is recommended for confirmed and
unconfirmed meetings of the same type.

To delete color assignments, check the box next to the assignment you wish to
delete, and click Delete.

Font Colors

To add a new font color:

1.
2.
3.

ol -
a

) Meeting Room Manager

Click Add.
Enter the new color’s name.
To the left of the new color, click on the white space.

The Color Picker window opens.

Select the required color.
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Color assignments can be deleted by checking the box next to the assignment you
wish to delete, and then clicking the Delete button.

Email Messages Tab | Kate

Reservation Related Email Messages

Fifteen email notifications can be sent through MRM. Ten of these pertain to reservations
while five pertain to service orders.

MRM prompts users to send email notifications at the appropriate time. Then if the user
agrees to send the message, MRM generates the appropriate email based on its template.
Once the email is generated, the user can just send the email as-is or modify it first.

The Option’s Email Messages tab contains the reservation based email templates which
can be adjusted to suit your organization. Services order email templates can also be
adjusted in the corresponding service’s administrative form. Refer to the “Service Order
Email Messages” section of the “Services Management Module” chapter for more details.

Each email template contains the intended recipient, the subject, the body, and the
message prompt that the end user sees.

The following is the list of reservation related email messages:

Notification Email. When a user saves a meeting with requirements, the user is
prompted to send this email. It is intended be sent to the head of the department to
which the selected requirements belong.

Meeting Change Email. When a user saves changes to a meeting with attendees or
requirements, the user editing the meeting is prompted to send this email to all attendees
and department heads that were initially notified of the meeting.

Cancellation Email. When a user cancels a meeting with attendees or requirements, the
user cancelling the meeting is prompted to send this email to all attendees and
department heads that were initially notified of the meeting.

Confirmation Email. This email is sent by the user responsible for confirming meetings. It
is sent from the Meeting Confirmation form.
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Outlook Invitation. This invitation can be sent by users who wish to send an Outlook
Invitation to attendees who use Outlook as their mail client. This invitation can be sent by
clicking the Invitation icon in the Attendees tab of the Reservation form.

Email Invitation. This email can be sent by users as an alternative to the Outlook
Invitation. This email can be sent by clicking the Email icon in the Attendees tab of the
Reservation form.

Override Admin Notification. When a user with priority rights saves a reservation that
overrides an existing reservation, he is prompted to send this notification to the local
administrator, like Luke.

Override End User Notification. When a user with priority rights saves a reservation that
overrides an existing reservation, he is prompted to send this notification to the user who
created the reservation he just overrode.

Wait List Assigned Notification. When a desired space becomes available, and a wait list
entry is automatically pushed into the space, Meeting Room Manager automatically
sends this notification to the user who created the wait list entry.

Wait List Status Email. When an administrator is viewing the wait list, he has the option
to send an email to any wait list entry’s creator to let her know the current status of her
wait list entry. This email can only be sent manually by clicking the email icon next to an
entry on the wait list.

Modify Email Message Templates

The Options Email Messages tab contains the templates for each of the reservation
related notifications. The following descriptions are for the fields used on the Email
Messages Tab to edit these templates.

Email Pull-Down Menu. This menu allows you to select which email notification or
invitation that you are editing such as Confirmation Email or Outlook Invitation.

The Field Reference Field. This reference field allows you to insert data that is specific to
each meeting. For example, selecting <General/Meeting Title> displays the meeting title
for whichever meeting the email is about. These references can be used in any of the
customizable fields within the Email Messages tab by clicking Insert.

Q_al Meeting Room Manager
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The To Field. This field allows you to select whom the notification is sent to. You can
select from All Departments, Departments of Selected Items, or Never Send an Email. The
All Departments and Departments of Selected Items options pull the email addresses that
were assigned to each tab using the from designer. In addition to or as an alternative to
the All Departments and Departments of Selected Items options, specific email addresses
can also be entered. The Never Send an Email option only sets the default to not send this
particular notification.

The CC Field. This field allows you to type in an email address that all notifications of this
kind are to be sent to. For example, if one person is in charge of confirming reservations,
his or her email address can be entered in this area.

The Subject Field. This field displays the notification’s subject. It is recommended to use
the <General/Meeting Title> reference field in the subject.

The Body Field. The Body field represents the body of the message that is sent out. It
should be generic for all types of meetings. Anything specific to a particular meeting
should be represented by a field reference. Keep in mind that all notifications can be
customized at the time they are sent.

The Message Field. This field represents the prompt that is displayed to the user
reserving the meeting. It is meant to ask the user if they wish to send notification. This
field is only available for the Notification Email, the Cancellation Email, and the Meeting
Change Email. It can be changed if you wish to customize this prompt according to your
organization’s specific needs.

Confirmation Tab | Kate

Confirm

This setting lets the global administrator choose which situations require confirmation by
a local administrator like Luke.

Confirm Meetings with Requirements: Only meetings with requirements selected
require confirmation and display in the Confirmation form until confirmed. This is the
default setting.
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No Confirmations: No meetings require confirmation. In this case, you are not able to
address meeting requests.

Confirm All Meetings: Every meeting that is saved requires confirmation and displays in
the Confirmation form until confirmed.

For more information on confirmations, refer to the “Confirmations” chapter.

Confirm Paste. The Confirm Paste feature can be turned on or off. When on, users who
paste a copied meeting onto the grid are asked to confirm the placement.

Schedule Limit Tab | Kate

The Schedule Limit tab allows the global administrator to set limits on the length of
recurring reservations and the maximum future booking window for all other
reservations.

Maximum Recurrence Length. This field sets the maximum number of months in the
future that occurrences can be booked from the date of the first occurrence in the series.
The default setting is unlimited. You may select a number from the value list or enter your
own number into the field itself.

Future Booking Window. This field sets the maximum number of months in advance
that reservations can be made. The default setting is unlimited. Either enter the number
of months in advance that any user can book up to, such as 6 months, or select a date
from the calendar which any user can book up to, such as December 31st, 20009.

Grid View Tab | Kate

The Grid View tab sets the defaults for each grid view. These settings affect all users.

View. This field allows you to select which view you are going to edit: the day, week,
month, or time line . For a description of each view, refer to the “Reservation Grid” section
of the “Reservations” chapter.

Q_al Meeting Room Manager
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Visible. Checking the visible box makes the corresponding view available to users. When
this box is not checked, the corresponding view is not visible.

Refresh Rate. This field determines the refresh rate for the selected view. The default is
300 seconds, or five minutes.

Field Reference. This drop-down list lets you choose what information is automatically
displayed in the meeting’s listing. For example, choosing <Meeting Room> shows the
room booked for the meeting. Multiple listings can be displayed in a grid and your
choices are shown in the content field. This is most useful with the week and month
views, but it can be used for the day view.

Content. This field contains the information that is displayed for each reservation on the
grid. To modify or add more fields, type in generic information to be displayed for the
selected view, or click Insert beside the Field Reference field to add the selected field
reference.

Insert. Click on an area in the content field where the field reference should be inserted,
and select tidin st atem7liss Ahis klafs et MidsHVS a4 Mt uGGLtE MGY Wddll b3Pu-2
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When this checkbox is enabled, reservations can be delegated to a user who may act on
the behalf of the reservation’s organizer. When acting as a delegate, this user is granted
the permissions of the meeting’s organizer.

Users can be assigned as delegates to individual reservations as required. If many
reservations are involved, you may assign a user as a delegate to other users. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supercede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

To add a delegate to your username, refer to the “Edit Your User Profile” section of the
“Security” chapter.

To add a delegate to a specific reservation, refer to the “Delegate a Reservation” section of
the “Reservation” chapter.

Administrators like Kate may add a delegate to a username. Refer to the “Usernames”
section of the “Security” chapter for details.

Enable Priority Rights

This field allows you to enable the priority rights feature set. For information on how to
implement this, refer to the “Implement Priority Rights” section of the “Security” chapter.

When this checkbox is enabled, the waiting list checkbox is automatically enabled.

Enable Waiting List

This field allows you to enable the wait list feature set. It is automatically enabled if the
priority rights checkbox is enabled. Refer to the “Wait List” chapter for more details.

Enable Active Directory

If you are using MRM Enterprise Edition, this field allows you to enable the integration of
Windows authentication security in Meeting Room Manager with your existing Microsoft
Active Directory Services security. For information on how to set up the integration once it
has been enabled, see the Active Directory section of the Security chapter.

Allow Unmapped Users to Access MRM

When you check the Enable Active Directory field, the Allow Unmapped Users to Access
MRM field is automatically enabled.

M
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This field allows users who belong to an unmapped Active Directory security group to log
in to Meeting Room Manager as a member of the Default group. This saves the MRM
administrator, like Kate, the time of mapping every group by allowing her to only map
those which require more advanced security settings.

When you uncheck this field, users who belong to an unmapped Active Directory security
group are denied access to Meeting Room Manager.

This field is grayed out and cannot be checked if the Enable Active Directory field is
unchecked.

Allow to Load All Locations

When disabled, this field prevents the All Locations display filter from loading in the
reservation grid. Instead of loading all locations’ reservations at once, users can choose to
load a specific location’s reservations in the reservation grid. This allows the grid to load
faster.

It is recommended that you disable this field if you have a large database with many
locations, resources, or reservations. It is also recommended that you disable the Allow to
Load Parent Locations field on this tab to further improve the loading speed of the
reservation grid.

This field is enabled by default.

Allow to Load Parent Locations

When disabled, this field prevents users from viewing all of the reservations which belong
to a parent location at once in the reservation grid. Users can instead display the
reservations at one lowest level location, or sublocation, at once therefore allowing the
grid to load faster.

It is recommended that you disable this field if you have a large database with many
locations, resources, or reservations. It is also recommended that you disable the Allow to
Load All Locations field on this tab to further improve the loading speed of the
reservation grid.

This field is enabled by default.
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Configure the Mail Server | kate

MRM can automatically send out emails to notify users and administrators. To do this, the
SMTP service must be correctly configured and running on the web server or your mail
server.

To configure the SMTP service, open your reservation database with Microsoft SQL Server
Enterprise Manager. Then open the Options table and add the following records if they
are not already present:

+ In the Setting field, enter ReplyAddress and in the Value field, enter the actual email
address of the MRM administrator (e.g. ‘'mrmadmin@company.com’).
+ In the Setting field, enter SMTPServer, and in the Value field, enter localhost.

If you plan to use a different mail server than the web server, enter the DNS name or
IP address of the mail server in the Value field instead of localhost.

DNS names typically look similar to this example: smtp.mail.net

After the eamail server is configured, emails automatically sent by MRM will be sent to the
appropriate users and attendees.

Examples of emails automatically sent by MRM are the wait list resolution email which
notifies the owner of a wait list entry when the entry has been scheduled as a reservation,
and the override notification email which notifies the administrator and meeting owner
when a reservation has been overridden by a user with priority rights.

If the SMTP service is not correctly configured, automatically sent emails appear to
be sent by Meeting Room Manager but remain on the email queue of the SMTP server.

In order for emails to be sent correctly, attendee and user email addresses must be
SMTP addresses, not X.400 addresses.

Send Email from the Server | Kate

MRM provides global administrators with the option to send the notification, invitation or
confirmation emails directly from the web server instead of the default method of using
the email client application installed on the user's workstation.

23
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To send emails, set the following options in the MRM database:

+ The CDONTS object must be installed on the web server during IS installation.

« The SMTP service must be correctly configured and running on the web server. If
you do not want to use the web server as a mail server, you can point to your mail
server instead. In this case there is no need for COONTS or SMTP.

To enable the corresponding options within the MRM database:

1. Open your reservation database with Microsoft SQL Server Enterprise Manager.

2. Inthe Options table add one of the following records if they are not already present:
+ In the Setting field, enter SetEmail

« In the Value field, enter EmailFromServer.
« In the Setting field, enter ReplyAddress

+ In the Value field, enter the actual email address of the MRM administrator (e.g.
‘mrmadmin@company.com’).

+ In the Setting field, enter SMTPServer
+ In the Value field, enter localhost.

« If you plan to use a different mail server than the web server, enter the DNS name or
IP address of the mail server in the Value field instead of localhost.

+ DNS names typically look similar to this example: smtp.mail.net

With any of these options set, all emails originate from the web server and appear to
come from the set reply address regardless of the user who actually entered or edited the
reservation.

When MRM prompts a user to send a notification email, the user has the option to
select Yes to have the email sent from the server or No to abort the sending of the email.

If the SMTP service is not correctly configured, emails appear to be sent by Meeting
Room Manager but remain on the email queue of the SMTP server.

In order for emails to be sent correctly, attendee and user email addresses must be
SMTP addresses, not X.400 addresses.
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Set Email to Use Outlook API | Kate

If all of your Meeting Room Manager users use Outlook as their email client, you can use
Outlook’s API setting.

To change your Meeting Room Manager database’s setting from Non-Outlook API to
Outlook API:

1. Inyour reservation database, open the Options table and navigate to the SETEMAIL
setting.

2. Change the value for the SETEMAIL setting to OutlookAPI.

The default value for the SETEMAIL setting is NONOutlookAPI.

Audit Log | Kate

MRM keeps an audit log to maintain an record of what reservations have been added,
modified, or deleted, and by which user.

To view these records, simply open the reservation database’s Audit Log table. This table
displays the action taken, date of the action, user name, record ID, record type, record title,
meeting start, meeting end, and room ID.

Save Rules | Kate

Save rules are conditions which check a reservation’s data before it is saved. In many
cases, a save rule’s purpose is to prevent a reservation from saving if it doesn’t meet the
rule’s requirements.

There are three types of save rules:

+ Mandatory

This type of save rule prevents a reservation from saving if it doesn’t meet the rule’s
requirements. It displays a message to the user who is attempting to save the
reservation, explaining what needs to be changed before the reservation can be

.
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saved. When the user clicks OK in the message prompt, he is returned to the
Reservation form to adjust the details before re-attempting to save.

An example of a mandatory save rule is one that requires at least thirty minutes of
preparation time when a projector is booked.

Prompt

This type of save rule presents a message to the user saving the reservation. This
message provides two options to the user: Cancel and OK. Clicking Cancel returns the
user to the Reservation form so he can adjust the reservation as suggested in the
message. Clicking OK saves the reservation despite the message.

An example of a prompt save rule is one that notifies the user that the reservation
uses less than 50% of the room’s capacity for attendees.

Warning

This type of save rule simply gives the user a message before saving the reservation. It
is used as an information notice only.

An example of a warning save rule is one that reminds the user saving the reservation
that since she ordered a projector but no laptop, she should bring her own laptop to
connect to the projector for the meeting.

The following save rules are provided with MRM but are inactive by default:

26

Meeting Occurs in the Past: This save rule is a prompt which notifies a user if he has
attempted to schedule a reservation in the past. He may choose to proceed or to go
back and adjust the time and/or date of his reservation.

Match Tab Fields: This save rule is a mandatory type rule which checks for a match
between a resource item and a reservation item on matching tabs. This rule does not
apply to information held in services management tabs. Details for setting up your
database to make use of this save rule are described in the “Prepare Requirements’
Availability” section of the “Resources and Requirements” chapter.

Inventory Check: This save rule is a mandatory type rule which checks that selected
requirements are available to be reserved, according to the inventory information in
the database. This rule does not apply to requirements held in services management
tabs. Details for setting up your database to make use of this save rule are described in
the “Implement Inventory Tracking” section of the "Resources and Requirements”
chapter.
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+ Invitation Check: This save rule is a prompt which asks if the user would like to send
an email invitation to attendees. The user can click Yes to send the invitation or No to
save the reservation without sending an email invitation to attendees.

All save rules can be made active or inactive as required.

To create your own Save Rules, knowledge of SQL statements is required.

Save Rules Form

To open the Save Rules form:
1. Click the Admin icon.

2. Click the Save Rules icon.

3. The Save Rules form opens, displaying the list of existing rules.

Add a Save Rule

To add a save rule:

1. Click Add on the Save Rules form.

2. Inthe Rule Details form, enter a name for the save rule in the Rule Name field.
Example 1: Projector Requires 30 Minutes Prep
Example 2: Fifty Percent Room Capacity
Example 3: Laptop for Digital Projector

3. Fill'in the Rule Description field.

Example 1: Requires at least 30 minutes of prep time when a digital projector is
booked.

Example 2: Notifies when less than 50% of a room’s capacity is used.

Example 3: Reminds user to bring a laptop for the digital projector

‘5] Meeting Room Manager 7
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Enter your SQL statement into the Rule Query field.

Example 1: IF=DateDiff(“n", “<ACTUAL START DATE> <ACTUAL START TIME>",
“<MEETING START DATE> <MEETING START TIME>") < 30 AND “<Equipment/Digital
Projector>" =True

Example 2: SQL="SELECT Room_ID FROM Rooms WHERE Room_ID IN (<ROOM ID>)
AND (<General/#Attending>/[General/Capacity]) < 0.5"

Example 3: IF= “<Equipment/Digital Projector>" =True AND “<Equipment/
Laptop>"=False

Enter the message in the Rule Message field. This is the message that the user is
presented with.

Example 1: “You have booked a digital projector for your reservation. Please add at
least thirty minutes of preparation time to your reservation.”

Example 2: “You are only using 50% of this room’s capacity. Click OK to proceed or
Cancel to return to your reservation and select a smaller room.”

Example 3: “You have booked a digital projector, but no laptop for your reservation.
Please remember to bring your own laptop to the meeting in order to use the digital
projector.”

When your save rule is triggered, if the reservation meets the rule’s criteria, the
message will be displayed. If the reservation does not meet the rule’s criteria, the
message will not be displayed.

Select either mandatory, prompt, or warning to set the rule’s classification.

For a description of each type, refer to the beginning of this section.
Example 1: Mandatory

Example 2: Prompt

Example 3: Warning

In the Rule Applies To field, select one of the choices in the pull-down menu:
« All: Select this option if the rule applies to both the web client and the MRM plug-in
for Microsoft® Outlook. This option is selected by default.

+ Web Only: Select this option if
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8.

+ no one in your organization uses the MRM plug-in for Microsoft Outlook, or if

« the rule only applies to users of the web client, or if

« the rule refers to fields which are not available in the MRM Reservation form in
Outlook.

« Outlook Only: Select this option if the rule only applies to users of the MRM plug-in
for Microsoft Outlook.

If you chose Outlook Only or All, ensure that all fields referenced in the save rule
are available in the MRM Reservation form in Outlook or errors will occur. It is
recommended that you attempt to invoke the save rule from Outlook to ensure that it
is compatible.

Click OK to add the save rule.

Edit a Save Rule

To edit a save rule:

1.
2.
3.

4,

In the Save Rules form, select an existing rule by clicking on its title.
The rule’s Rule Details form opens.

Make changes as needed.

Some fields in the default save rules cannot be changed.

Click OK to save changes and close the form.

Enable or Disable a Save Rule

To enable or disable a save rule:

1.

In the Save Rules form, look under the Active column to view a save rule’s current
status.

2. Click on the rule whose status you wish to change. This opens the rule’s detail form.

w
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Enable the rule by checking the Active checkbox or disable it by removing the check
mark.

Click OK to save your changes.
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Delete a Save Rule
To delete a save rule or multiple save rules:

1. Inthe Save Rules form, click the checkbox to the left of each save rule you wish to
delete.

Default save rules cannot be deleted. If you do not wish to use them, you can
disable them as described in the section above.

2. Click Delete.

3. Click Yes to confirm deletion.

4. The list displays the remaining save rules.

MRM Window Service Admin | Kate

The MRM Window Service Admin automates email reminders and Active Directory
Services security integration.

Setup and Configuration

The MRM Window Service Admin setup takes place during the installation of Meeting
Room Manager. The Setup Wizard asks for database connection details and the username
and password of the Windows® user who has permissions to this service.

For more information regarding the Setup Wizard, refer to the MRM 7 Installation Guide,
available by download from the NetSimplicity Support Site. Log in at:

http://www.netsimplicity.com/support

Setup Log On Information

If you wish to use Active Directory Services integration, you need to setup log on
information for the MRM Window Service Admin. To setup the log on information:

1. Select Start > Control Panel > Administrative Tools > Services.
2. Right-click MRM and select Properties.
3. Select the Log On tab.
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4. Select This Account and enter a domain username and password which has
administrative permissions on your network.

Use the following username format: domain\username
Example: Acme\Kate

5. Click OK to save the log on information.

Refer to the “Use Active Directory Services” section of the “Security” chapter for more
information about setting up Active Directory® Services integration for use.

Setup Database Connection

To alter your database connection details after the initial setup:

1. Open the service by selecting Start > All Programs > Meeting Room Manager 7 > MRM
Window Service Admin > Database Connection tab.

2. Make your database connection changes.
3. Click the Test Connection button to test your changes.

4. Once you are satisfied with your changes, click the Save button to save them.

Stop or Start the Service
To stop or start this service:

1. Opentheservice by selecting Start > All Programs > Meeting Room Manager 7 > MRM
Window Service Admin > Database Connection tab.

2. Click the Stop or Start button.

3. The status indicator displays the service’s current status as either Running or Stopped.

It is recommended that if you wish to not use any of the auto-email reminders that
you disable each of the triggers rather than stop this service. Refer to the “Automated
Email Reminders” section of the “Customizations” chapter for details.

It is recommended that if you do not wish to use Active Directory Services security
integration that you turn the feature off in the database options rather than stop this
service. Refer to the “Options: Others Tab” section of the “Reservation Database
Configuration” chapter for details.

M
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Automating the Text Data Extraction Script

MRM can integrate with external systems which reference a regularly updated text file to
display meeting room usage and other event information on display panels.

The text file provided by MRM contains daily event data for the current 24 hours, from 12
am this morning to 12 am tonight. The file presents data in a standardized format and can
be set to update at the frequency your organization prefers.

In order to make use of this integration, you must first activate the trigger that extracts
the necessary data into the standardized text file.

To activate the data extraction trigger:

1. Open the MRM Window Service Admin by selecting Start > All Programs > Meeting
Room Manager 7 > MRM Window Service Admin.

2. On the Database Connection tab, enter the database connection information
ensuring that you use a username which has administrative permissions to the SQL
server, particularly the ‘enable xp_cmdshell’ permission.

3. Select the Triggers tab and double-click the trigger called Data_Extraction_Script.
4. Inthe Trigger Detail form, click inside the Trigger Statement box.
5. Provide the path and name for the text file using the following format:

spExportTextFile @TextFilePathAndFileName ='c:\Temp\CustomizedText.txt'

Replace ‘c:\Temp\CustomizedText.txt’ with the filename and path that you wish to
save the text file to each time it is generated. Ensure that you keep the single quotes.

6. Inthe Schedule field, select the frequency that you wish the trigger to run at. This is
the frequency that the text file will be refreshed.

The typical rate is once every 10 minutes, but you may wish to make it more or
less frequent depending upon your organization’s requirements.

7. Inthe Status field, select Active to make the trigger active.

8. Click Save Trigger to save your changes and activate the trigger. It will now run at the
interval you have specified and be saved to the file and path you specified.

The stored procedure which is referenced by the trigger, spExportTextFile, can be
opened in SQL Enterprise Manager and used as a data extraction template, allowing MRM
to integrate with external systems according to their requirements.
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Modifications of this nature should only be performed by qualified individuals and
cannot be supported by NetSimplicity.

Automating the XML Data Extraction Script

MRM can integrate with external systems which reference a regularly updated XML file to
display meeting room usage and other event information on display panels.

The text file provided by MRM contains daily event data for the current 24 hours, from 12
am this morning to 12 am tonight. The file presents data in a standardized format and can
be set to update at the frequency your organization prefers.

In order to make use of this integration, you must first activate the trigger that extracts
the necessary data into the standardized text file.

To activate the data extraction trigger:

1. Open the MRM Window Service Admin by selecting Start > All Programs > Meeting
Room Manager 7 > MRM Window Service Admin.

2. Onthe Database Connection tab, enter the database connection information
ensuring that you use a username which has administrative permissions to the SQL
server, particularly the ‘enable xp_cmdshell’ permission.

3. Select the Triggers tab and click Add a New Trigger.
4. Inthe Trigger Detail form, enter ExportXMLData as the name for the new trigger.

5. Clickinside the Trigger Statement box and provide the path and name for the text file
using the following format:

ExportXMLData @TextFilePathAndFileName ='c:\ExportXMLDataFile XML'

Replace ‘c:\ExportXMLDataFile XML with the filename and path that you wish to save
the text file to each time it is generated. Ensure that you keep the single quotes.

6. Inthe Schedule field, select the frequency that you wish the trigger to run at. This is
the frequency that the text file will be refreshed.

The typical rate is once every 10 minutes, but you may wish to make it more or
less frequent depending upon your organization’s requirements.

7. Inthe Status field, select Active to make the trigger active.
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8. Click Save Trigger to save your changes and activate the trigger. It will now run at the
interval you have specified and be saved to the file and path you specified.

The stored procedure which is referenced by the trigger, ExportXMLData, can be
opened in SQL Enterprise Manager and used as a data extraction template, allowing MRM
to integrate with external systems according to their requirements.

Modifications of this nature should only be performed by qualified individuals and
cannot be supported by NetSimplicity.

Custom Triggers

If you are familiar with SQL queries, you can create customized triggers to run on your
MRM installation.

To create or modify a custom trigger:

1. Open the MRM Window Service Admin by selecting Start > All Programs > Meeting
Room Manager 7 > MRM Window Service Admin > Triggers tab.

2, Clickthe Add New Trigger button to create a new trigger, or double-click the name of
the trigger you wish to modify.

3. Inthe Trigger Detail form, enter or adjust the name of the trigger.

4. Inthe Schedule frame of the form, set the schedule for the trigger to run. Choose
from:
+ Once at <time>: This schedule forces the trigger to run every day at the specified
time.

+ Occurs every <#> minute(s): This schedule forces the trigger to run at a specified
minute interval such as every one minute.

5. Inthe Trigger Statement field, enter the SQL query for this trigger.
6. If your trigger sends an email, you can create the email template in the Email
Information frame of the form. If it does not send an email, skip to step 9.
» Compose the subject and body of the email by clicking in the appropriate field and
entering field references and your own customized text.
« The Insert Field pull-down menu contains the field references which can be used to
compose the subject and body of the email. The available field references are based
on the tables which are pulled in the trigger statement.
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- To use a field reference, place your cursor where you wish the field reference to be
added, then select the field reference from the pull-down menu, and then click
Insert.

7. Enter each recipient’s email address into the To field. Separate each email address
with a semicolon (;).

8. Once you have finished setting up the email information and trigger statement, send
a test email by entering an email address you have access to in the Send Test Email To
field, then clicking the Test Email button.

« If the test email is sent successfully, a prompt indicates this. You can visit the inbox
of the email address you sent the test to in order to view the test email.

« If there is no data in the database which can be used to test this email reminder, the
prompt indicates this.

9. Once you are satisfied with the trigger you have created, ensure that it is active by
selecting Active in the Status section of the form.

10.Click Save Trigger to save your changes and activate the trigger. It will now run at the
interval you have specified and send notification emails as you have specified.

Text and XML data export formatting
This section describes how MRM exports XML and text data so that an administrator can
use it for tasks such as displaying it on an LCD screen.

The administrator doing this procedure must have a working knowledge of SQL
Server.

Setting up MRM to export data:

MRM can export data in either text or XML format. To set up MRM to do this, follow the
directions given in either the:

+ “Automating the Text Data Extraction Script” on page 32.
» “Automating the XML Data Extraction Script” on page 33.

Q_al Meeting Room Manager 3
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In these sections, you will learn how to trigger MRM to send out the file and set how
frequently it is sent out.

MRM exports data as shown below

MRM Data Data Type Text XML Export Tag
Export
Column
[General/Meeting Title] Text 1 <Eventname>
[Meeting Start] DateTime 2 <Starttime>
[Meeting End] DateTime 3 <Endtime>
[Notes] Text 4 Not supported in MRM
[RoomName] Text 5 <Roomname>
[DateCreated] DateTime 6 <Createdate>
[DateModified] DateTime 7 Not supported in MRM
[Groupevent] Text 8 <Groupevent>
[ReservationID] Number 9 Not supported in MRM
XML export data example

Below is a sample MRM XML export:
<?xml version="1.0" encoding="1SO-8859-1"?>
<Events>
<Event>
<CustomerID> 0 </Customer|D>
<Eventname>
<|[CDATA[Ex: GJC Demo 3D X-Ray]]>
</Eventname>
<Starttime>04-23-2008 09:00:00</Starttime>
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<Endtime>04-23-2008 17:00:00</Endtime>
<Roomname>

<|[CDATA[Experience]]>

</Roomname>

<Createddate>04-11-2008 17:42:07</Createddate>
<Groupevent>0</Groupevent>

</Event>

</Events>

Text export data example

Below is a sample MRM text export:

Challenge Theatre 08000830 05102006051020069025
Publishing Lab 08000830 05102006051020069026
Instructional Centre 09000930 Staff Meeting 05102006051020069019

Text is exported in tab-delimited format. Contact NetSimplicity’s technical support
department if you wish to change how the text data is exported.

.
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CHAPTER 3 Security

Security Overview | Kate

MRM security uses a group-based permissions setup. The global administrator defines
security groups which each have their own unique permissions. Users are assigned to
these security groups. Permissions can be everything from who can view another user’s
meetings to who can modify the Reservation form using the form designer.

In MRM Enterprise Edition, setting up security in Meeting Room Manager can be made
easier by integrating your existing Windows Active Directory user groups and names.

Users are required to log in using their assigned username each time they access your
reservation database unless Windows authentication is in place.

Implementing Active Directory in MRM | Kate

Microsoft Windows Active Directory (AD) services can be integrated with MRM Enterprise
Edition to provide a faster way to manage security in MRM, especially for large
corporations. Implementing AD in MRM requires SQL Server 2000 or 2005. The use of AD
in MRM is optional. This depends on your organization’s security practices.
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Step One: Enable AD in MRM

1. On the top row of the main screen, click the Admin icon. The Administration screen
appears.

Options
Options are a aroup of administrative
7 setup options that can be changed.

2. Click the Options icon. The Project Options screen appears.
3. Click the Others tab.

4. Inthe Active Directory section, click the Enable Active Directory checkbox and click
OK.
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Step Two: Configuring MRM log on information

1. Select Start>All Programs>Meeting Room Manager7>MRM Window Service
Admin. The MRM Windows Service Admin screen appears

2. Click the Database Connection tab.

L4 Domain: / Server:0A-OPT\SQL2005 / Database: MRMSample770 =)<
MRM Windows Service Admin &1’/
AD Synchroriization | Triggers 1 .
MRM Windows Service Status
MRMWService status: Running i
Database Connection
SQL Server Name: |
DB Name: |
User Name: |
Passwank l Test Connection
£ W f stioe Save

3. Inthe Database Connection section, fill out the fields as needed and click Save.

Step Three: Mapping MRM security groups to AD security groups
To allow users not belonging to mapped groups to access MRM:

+ Check the Allow unmapped members to access MRM checkbox in the Active
Directory section of the Project Options form and click OK.

¥ New York
Seattle
Floor 7
Floor 8
Floor 2
b Canada

[ Allow unmapped members to access MRM

These unmapped members are now granted permissions according to the Default
MRM security group. It acts like a guest account and has limited access rights.

o
=i
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To map an MRM security group to its corresponding AD security group:

Each MRM security group can be mapped to only one AD security group. If the AD user
group contains nested groups, the MRM security group is mapped to them as well. MRM
security groups can be mapped to AD security groups on multiple domains.

1. On the top row of the main screen, click the Admin icon. The Administration screen
appears.

i " Y ¥e)) ‘ o) o & |
(]| MeetingRoom @) QL SN ) b % k) 2
Reserve Mestings Resources Conl Reports Admin Logof </
June 2006 “
S M T WT F S
b
1" 2 1‘ Locations Add Resources
> @ &=~ S
HToday: 5152806 | Resource Tvpe A Security Growps
& available Locations =
&3 Set Current Location
2. Click the Security Groups icon. The Security Settings-Groups screen appears.
3. Select the security group you wish to map to an AD user group.
4. Select the Active Directory Mapping tab.
Hesina oom & x 8
Raserve Resources Admin Logoff 4
4 July 2008 [
S M T W T F § »
1 @&k B
6 7 8 9 1W0aDiz
13 14 15 16 17 18 19
27 28 23 30 3
<DToday: 771172008 ——————————
‘ 0 > e " l Active Directory Mapping
@ Available Locations
b New York ® Type group name.
¥ Seattle [ Checkhame
Floor 7
Floor 8
Floor © € Select group name
P Canada X
b uk

5. Enter the domain, username, and password needed to connect to your domain with
administrative permissions, then click Login.
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6. Inthe Domain Name section, check one of the following and click Check Name to
validate the name:

- Type Group Name. This option is case sensitive.

- Select group name.
If the name is valid you see: The Active Directory group name is validated.
If the name is invalid you see: Invalid Active Directory group name.

7. Click the Save button to map your selection.

- If the mapping is correct, the Security Settings - Groups screen appears.

« If the group is already mapped to another MRM security group, you see: This Active
Directory group name is already mapped to another MRM user group.

8. Follow steps 6 and 7 until all MRM security groups are mapped to AD user groups.

Step Four: Prioritizing AD security groups

While Windows users can be assigned to more than one AD security group, MRM users
can only be assigned to one MRM security group. This step prioritizes the AD security
groups so MRM knows which permissions to apply to a user who belongs to multiple AD
groups.

For example, an MRM user is assigned to the following AD domains:

« Users
« Administrator
« Seattle office

You would want to make the administrator domain the top priority, followed by the
Seattle office and lastly users.

To prioritize AD security groups:

1. Select Start>All Programs>Meeting Room Manager 7>MRM Window Service
Admin. The MRM Windows Service Admin screen appears.
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2. Click the AD Synchronization tab.
€t Domain: / Server:0A-OPTNSQL2005 / Database:MRMSample770 (=3
MRM Windows Service Admin &7
Database Connection Triggers ]
Set Schedule
Daily frequency - Every day(s) {* Once at: 'ﬁ
" QOccurs Every: l hour(s) Run Now
Set User Group Priority
MRM User Group Name | Active Directory User Group Name
Up
Down
Save Setting

In the Set User Group Priority field, the list of mapped AD security groups is shown.

Only AD user groups that are mapped to an MRM security group are displayed.
3. Highlight a group by clicking on it, then move it into the desired position by clicking

Up or Down.

The group at the top of the list has highest priority while the group at the bottom has

the least.
4. Repeat step three until all of the groups are in the desired order.
5. Click Save Setting.

AD has now been integrated with MRM.
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Windows Authentication | Kate

Why Windows Authentication?

Windows authentication lets each MRM user automatically log in based on their network
username. This provides the following benefits:

+ Improved security

« Less administration

« Centralized security management (domain user manager)

Enable Windows Authentication

This feature can only be turned on through the setup wizard. Refer to the Installation
Guide, available on the NetSimplicity Support Site. Log in at:

http://www.netsimplicity.com/support

Connect Using Windows Authentication

When Windows Authentication is in place, there are four factors which are considered
before a user is granted or denied access to MRM:

+ Does the user already exist in the MRM database?
+ Is Active Directory® integration enabled?
+ Is the Active Directory option "Allow Unmapped Groups to Access MRM" enabled?

« Does the user belong to an Active Directory® user group that is mapped to an MRM
security group?

As a result of these four factors, there are five possible scenarios for a user who attempts
to access MRM:

+ If the user already exists in the MRM database, he is logged into MRM according to his
existing permissions.
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« If the user does not exist in the MRM database and Active Directory is disabled, his
username is created in the MRM Default security group and he is logged in with the
corresponding permissions.

« If the user does not exist in the MRM database, Active Directory is enabled, and the
user belongs to an Active Directory group which is mapped, his username is created
as a member of the mapped MRM security group. He is then logged in with the
corresponding permissions.

« If the user does not exist in the MRM database, Active Directory is enabled, the user
belongs to an Active Directory group which is not mapped, and the "Allow Unmapped
Groups to Access MRM" option is enabled, his username is created as a member of the
MRM Default security group. He is then logged in with the corresponding
permissions.

« If the user does not exist in the MRM database, Active Directory is enabled, the user

belongs to an Active Directory group which is not mapped, and the "Allow Unmapped
Groups to Access MRM" option is disabled, the user is denied access to MRM.

To log into Meeting Room Manager using Windows authentication, users must be
connected to the network to which the MRM server belongs. If a user is not logged into
this network, when he attempts to connect to MRM he will receive a Windows prompt to
enter his Windows username and password.

Before an Active Directory user can be recognized by Meeting Room Manager, the
user must have logged into the network domain at least once since the username was
created in Active Directory® Services.

General Permissions | Kate

The following is the list of the permissions categorized as general permissions. Refer to
the “Security Groups” section of this chapter for instructions on how to change these
permissions for a security group.

Address Form Design. This permission allows a user to customize the layout, tabs, and
fields in the Address Book form and the Attendee Detail form. This permission should only
be assigned to administrators.
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Reservation Form Design. This permission allows a user to customize the layout of the
Reservation form and Reservation Search form. Both this permission and the Change
Options permission must be enabled in order to allow design of the Request Meeting
form. This permission should only be assigned to administrators.

Resource Details Form Design. This permission allows a user to customize the layout of
the Resource Details form and the Resource Search form. This permission should only be
assigned to administrators.

Change Options. This permission allows a user to change options that affect all users
such as project options, save rules, customizations to the labels and images of the
interface, and resource types. Both this permission and the Reservation Form Design
permission must be enabled in order to allow design of the Request Meeting form. This
permission should only be assigned to administrators.

Print Reports. This permission allows a user to preview and print the reports that come
with Meeting Room Manager. Users that do not have this permission enabled can only
print and preview the customizable day/week/month view report from the printer icon at
the top right of the main screen. This permission is normally assigned to all users but may
be disabled for guests or read-only users.

Modify Value Lists. This permission allows a user to add, edit, or delete items in any value
list. Value lists can be assigned to any text field on the Reservation Form or the Room
Detail Form by simply enabling the value list field property. This permission should only
be assigned to administrators.

Change Permissions. This permission allows a user to adjust security settings, such as
adding, editing, and deleting security groups and usernames. This permission should only
be assigned to administrators.

Manage Locations. The ability to add, edit or delete locations can be granted to users.
This permission should only be assigned to administrators.

View Hidden Tabs. Each tab contains a property that may be modified to hide the tab
from view. This permission allows a user to view these tabs. This permission should only
be assigned to administrators.

Modify Locked Tabs. Each tab contains a property that may be modified using the Form
Designer to lock the tab. By locking the tab, no modifications can be made to the tab by
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users assigned to security groups without this permission. This permission allows a user to
modify these tabs. This permission should only be assigned to administrators.

Manage Filters. The ability to add, edit or delete resource filters can be granted to users.
This permission should only be assigned to administrators. Recall that any user can use
the custom filter on a per-use basis.

Order <Service Name>. This permission controls the ability to order services from the
Reservation form. It is named for the service it corresponds to. For example, Enable
Catering corresponds to the Catering service, while Enable Equipment corresponds to the
Equipment service. This permission should be assigned to all users who need to book
corresponding services for their meetings. For more information about services, refer to
the “Services Management Module” chapter.

Location Permissions | Kate

The following is the list of the permissions categorized as location permissions. Refer to
the “Security Groups” section of this chapter for instructions on how to change these
permissions for a security group.

Visible Location. Determines if the user can see the location.

View Others Meetings. Determines if the user can view meeting details at the location.
Add/Edit Meetings. Determines if the user can add or edit meetings at the location.
Delete Meetings. Determines if the user can delete meetings at the location.

Confirm Meetings. Determines if the user can confirm meetings at the location.

Change Others Meetings. Determines if the user can change the meetings reserved by
others at the location or if checked, also allows the user to open, view and change private
meetings. For more details see "Setting viewing permission for private meetings" on
page 129.

Manage Rooms. Determines if the user can manage rooms at the location.
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Manage <Service Name>. Determines if the user can manage services. It is named for
the service it corresponds to. For example, Manage Catering corresponds to the Catering
service, while Manage Equipment corresponds to the Equipment service. This permission
should only be provided to each service administrator according to the location and
service she administrates. For more information about services management, refer to the

“Services Management Module” chapter.

Priority Rights. Determines if the user can push reservations created by users without
this permission to the wait list.

Security Groups

Kate

Security in MRM uses a group-based permissions setup. Security groups are created, each
containing a unique permissions set. Users are then created and assigned to these

security groups which can also be referred to as user groups.

Add a Security Group and Assign Permissions

To create a new security group and assign permissions to it:

1. Click the Admin icon.

2. Click the Security Groups icon. The list of existing security groups opens.

3. Click Add User Group.

The Permission Detail form opens.

4. Enter the name and description for the new security group.

5. To assign permissions, there are two tabs that permissions are categorized into:

- General Permissions: Refer to the “General Permissions” section of this chapter for

details.

Q_al Meeting Room Manager
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+ Location Permissions: Refer to the “Location Permissions” section of this chapter
for details.

To enable a permission, check the corresponding checkbox, or to disable a
permission, uncheck the corresponding checkbox.

@ For faster permissions assignment, use the All and None buttons vertically to
assign the permission to all locations, horizontally to assign all permissions to one
location, or at the bottom of the page to enable or disable all permissions.

When you have finished editing the security group’s permissions, click Save to save
your changes and return to the list of security groups.

Edit a Security Group’s Permissions.

To edit a security group’s permissions:

1.
2.
3.

50

Click the Admin icon.

Click the Security Groups icon to open the list of existing security groups.
Click the security group name.

The Permission Detail form opens.

To assign permissions there are two tabs that permissions are categorized into:

- General Permissions: Refer to the “General Permissions” section of this chapter for
details.

+ Location Permissions: Refer to the “Location Permissions” section of this chapter
for details.

To enable a permission, check the corresponding checkbox, or to disable a
permission, uncheck the corresponding checkbox.

For faster permissions assignment, use the All and None buttons vertically to
assign the permission to all locations, horizontally to assign all permissions to one
location, or at the bottom of the page to enable or disable all permissions.

. When you have finished editing the security group’s permissions, click Save to save

your changes and return to the list of security groups.
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Reassign Users to a Different Security Group
To reassign users from one security group to another:
1. Click the Admin icon.
2. Click the Security Groups icon.
The list of existing security groups opens.
3. Click the name of the security group you wish the users to now be assigned to.

4. Inthe detail form, select the Members tab.
Usernames

Once security groups have been created, usernames can be created and assigned to the
security group whose permissions are appropriate for the user.

Create or Edit a Username
To create or edit a user:
1. Click the Admin icon.
2. Click the Users icon.
The list of users opens.

3. To:
. Add a new user, click Add User.

« To edit an existing user, click Edit to the right of the username.

4. Enter the user’s information to each field, specify the security group whose
permissions apply to this username, and assign delegates if required.
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5. When finished adding the new user, click OK to save your changes
-OR-

When finished changing an existing user’s permissions, click the Update button to
save your changes.

Manage a Username’s Delegates

Overview of the Delegate Feature

In Meeting Room Manager, reservations can be delegated to a user who may act on the
behalf of the reservation’s organizer. When acting as a delegate, this user is granted the
permissions of the meeting’s organizer.

Users can be assigned as delegates to individual reservations as required. If many
reservations are involved, you may assign a user as a delegate to other users. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supercede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

The Delegate Feature’s Effect on Permissions

When a user is working with reservations for which he has been added as a delegate, he
acts on behalf of the organizer and uses the organizer’s permissions. Typically this grants
him more permissions than he normally has for these reservations.

Overview of Managing Delegate Settings

As the administrator, you may add or remove delegates for a username or change
delegate settings. Since each organizer may adjust his delegate settings when he edits his
user profile, you may choose to leave this setting up to each user or set it up on their
behalf.

Time Frame Based Delegation

You may wish to assign a delegate to username for a specific time period. The delegate is
given permission to act on the behalf of the organizer for meetings which are scheduled
during the specified time frame.
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Permanent Delegation

You may wish to assign a delegate to username on a permanent basis. This setting may be
modified at a later date if required, but while it is set, the delegate is given permission to
act on behalf of the organizer for any of his reservations.

View a Username’s Delegates

Both the permanent and the time frame based delegate settings are set in the username’s
properties. They can be accessed by an administrator through the username’s User Details
form or by the user himself in the Edit Your User Profile form. This section addresses only
the User Details form.

To view a username’s delegates:

1. Clickthe Admin icon.

N

Click the Users icon.

w

Click on the username whose settings you wish to view.

s

In the username’s User Details form, click the Delegates tab.

The list of the username’s delegates is shown.

Modify a Username’s Delegate Settings
To modfiy a username’s delegate settings:
1. Follow the instructions in the “View a Username’s Delegates” section.

2. Toadd anew delegate, click Add New Delegate.
« If you wish to modify an existing delegate’s settings, skip to step five.

« If you wish to delete a delegate from the username’s list, skip to step six.

3. Inthe Delegate User List, navigate to the user you wish to select as this user’s
delegate.

By default, the Delegate User List displays entries whose first names begin with
the letter A. To display entries beginning with other letters of the alphabet, use the
letters across the top of the form. To display all entries, click the All Users tab.

4. Check the box next to the delegate and click Add User.
The delegate is added to the list on the Delegates tab as permanent by default.
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. You may now modify each delegate’s settings:

- If you wish to change a permanent delegate to a time frame based delegate,
uncheck the Permanent checkbox. Then enter the desired start date into the From
field and the end date into the To field.

- If you wish to change a time frame based delegate’s status to permanent, check the
Permanent checkbox.

« If you wish to modify a delegate’s time frame, edit the desired start date in the From
field and the end date in the To field.
You may enter hours behind a delegate’s start or end date to narrow your time
frame further.

If you wish to remove a username’s delegate, click Remove next to the delegate’s
name.

. Click OK.

The users you have specified as delegates for the username have been added as
delegates to all reservations created by this user for the given time period. If the user
creates additional reservations during this time period, these delegates will be added
to their properties as well.

Delete a Username

To delete a username:

1.
2.

Click the Admin icon.
Click the Users icon.

The list of users opens.

3. Check the box beside the user you wish to delete.
4. Click Delete.
5. Click OK.
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LogIn | ALL

Unless Windows authentication is used, users have to log into the reservation database
they are trying to access. Each username’s permissions depend upon the security group
that the username is assigned to.

When MRM is launched, the Login screen appears, asking for your username and
password. Enter your valid username and password, and click OK to log in.

Refer to the “Run Meeting Room Manager” section of the “Introduction” chapter for
details on how to connect to your reservation database.

Edit Your User Profile | ALL

You may be prompted to edit your user profile the first time you log into MRM. Later, you
can edit your user profile by clicking the Edit User Profile icon at the top right of the main
screen.

While editing your user profile, you can change your basic information on the General tab.
You can also adjust your delegate settings on the Delegates tab.

General Tab

» Username

This is the name you enter on the login page if using MRM authentication. If
Windows authentication is in use, this field cannot be edited.

« Password

This is the password you enter on the login page if using MRM authentication. If
Windows authentication is in use, this field cannot be edited.

Full Name

This is your full name.

Email Address

This is the email address which will receive any email notifications sent by MRM.

Default Location
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This setting resets your My Location setting each time you log in. You can change
your My Location setting without affecting your default location. This allows you to
temporarily choose a different location as your current location view if you're
travelling to that office, for example. You would do this to ensure that you see
meetings in the time they occur at the location you're travelling to.

For more information on your My Location setting, refer to the “My Location” section
of the “Locations” chapter.

Delegates Tab

Overview of the Delegate Feature

In MRM, reservations can be delegated to a user who may act on the behalf of the
reservation’s organizer. When acting as a delegate, this user is granted the permissions of
the meeting’s organizer.

Users can be assigned as delegates to individual reservations as required. If many
reservations are involved, you may assign a user as a delegate to other users. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supercede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

When a user is working with reservations for which he has been added as a delegate, he
acts on behalf of the organizer and uses the organizer’s permissions. Typically this grants
him more permissions than he normally has for these reservations.

You or your administrator may add or remove delegates for your username or change
your delegate settings. When you check your delegate settings, you may find that your
administrator has already assigned delegates for you.

Time Frame Based Delegation

You may wish to assign a delegate to your username for a specific time period. The
delegate is given permission to act on your behalf for meetings which are scheduled
during the specified time frame.
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Permanent Delegation

You may wish to assign a delegate to your username on a permanent basis. This setting
may be modified at a later date if required, but while it is set, the delegate is given
permission to act on your behalf for any of your reservations.

View Your Delegates

Both the permanent and the time frame based delegate settings are set in each
username’s properties. They can be accessed by your administrator or you may edit them
yourself in the Edit Your User Profile form. This section addresses only the Edit Your User
Profile form.

To view your list of delegates:
1. Click the Edit Your User Profile icon at the top right of the main screen.
2. Click the Delegates tab.
The list of your delegates is shown.
To modify your delegate settings:
1. Follow the instructions in the “View Your Delegates” above.

2. Toadd a new delegate, click the Add New Delegate link.
» To modify an existing delegate’s settings, skip to step five.

+ To delete a delegate from the username’s list, skip to step six.

3. Inthe Delegate User List, navigate to the user you wish to select as your delegate.

By default, the Delegate User List displays entries whose first names begin with
the letter A. To display entries beginning with other letters of the alphabet, use the
letters across the top of the form. To display all entries, click the All Users tab.

4. Check the box next to the delegate and click Add User.
The delegate is added to the list on the Delegates tab as permanent by default.

5. To modify the delegate’s settings:
+ To change a permanent delegate to a time frame based delegate, uncheck the
Permanent checkbox. Then enter the desired start date into the From field and the
end date into the To field.
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«+ To change a time frame based delegate’s status to permanent, check the
Permanent checkbox.

» To modify a delegate’s time frame, edit the desired start date in the From field and
the end date in the To field.

You may enter hours behind a delegate’s start or end date to narrow your time
frame further.

6. To remove a delegate, click Remove next to the delegate’s name.
7. Click OK.

The users you have specified as your delegates have been added as delegates to all
reservations created by this user for the given time period. If you create additional
reservations during this time period, these delegates will be added to their properties
as well.

Log Out | ALL

Logging out ends the user session and releases the concurrent user license that you were
using, making it available to other users. If a user closes his web browser without clicking
the Logoff button, the user session will time out after 20 minutes by default. The time out
duration can be changed in the web.config file. Refer to the “Adjust Session Timeout”
section of the “Introduction” chapter for more information.

To log out of Meeting Room Manager:

1. Click Logoff.

2. The default database Logged Off page opens.

3. To log back into the MRM default database, click on Login.

Implement Priority Rights | kate

Priority Rights Overview

In some organizations there are staff members who may choose the resources they’d like
even if they have already been booked by another employee. In MRM, these staff
members are referred to as priority users.
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What kinds of staff are priority users? Perhaps they are managers and partners who have
first priority to use the facilities because of their standing in the organization. Or maybe
they are sales people who host client meetings and require rooms that can cater to their
equipment needs. Who you choose to designate as a priority user is up to you, based on
how your organization is structured.

MRM allows administrators to assign priority rights to any security group whose users
need them. Users with priority rights are granted the option to override existing
reservations created by regular users in order to use the facilities they need. Priority users
cannot override another priority users’ bookings.

The priority rights feature set must be enabled in project options before any of the
features can be used. Refer to the “Options: Others Tab” section of the “Reservation
Database Configuration” chapter for details.

Priority Rights by Location

Priority rights are controlled according to location. This allows administrators to pick and
choose the rooms that a security group’s users have priority rights to.

If the sales and marketing departments share the facilities of the fourth floor at the New
York office, the administrator may wish to only allow sales and marketing managers to
have priority over their own department’s meeting rooms. In this case, the administrator
would divide the rooms on the fourth floor into two sublocations: sales and marketing.
Then sales managers can be given priority rights only to sales resources and marketing
managers can be given priority rights only to marketing resources.

Terms

The following terms are used to describe the priority rights reservation workflow:

Priority Reservations. Priority reservations are reservations scheduled by a user who has
priority rights for the corresponding location. Priority reservations can bump regular
reservations even if they are already confirmed by an administrator. Priority reservations
themselves cannot be bumped, even by users who also have priority rights.

Regular Reservations. Regular reservations are reservations that are scheduled by a user
who does not have the priority rights enabled for the corresponding location. They can be
bumped by any user who has priority rights to the corresponding location. When

M
4
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bumped they are placed in first priority on the wait list. If the reservation which bumped
the regular reservation is cancelled, the regular reservation is pushed back to its original

booking space.

Priority Rights Reservation Workflow Diagram

The following diagram shows the priority rights reservation workflow:

Priority Rights Workflow for Conflicting Reservations
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Explanation:

1.

Regular User Books Reservation A

When a user without priority rights permissions creates a reservation in the grid, the
reservation is identified as a regular reservation. It can be overridden by users with
priority rights.

Regular User Books Reservation B that conflicts with Reservation A

When another user without priority rights desires the space (time and resource)
already taken, he is free to create a reservation on the wait list. Only if the space
becomes available will this user’s reservation get the desired space.

Priority User Books Reservation C that conflicts with Reservation A

A user with priority rights can take the space even though a regular user has already
booked it. The regular user’s reservation is bumped to the front of the wait list.

Priority User Cancels Reservation C

When the space becomes available, the first in line on the wait list is automatically
bumped into the desired space.

Regular User Cancels Reservation A

When the space becomes available again, the next in line on the wait list is
automatically bumped into the desired space.

For more information about the wait list, refer to the “Wait List” chapter.

Assign Priority Rights

To assign priority rights to security groups, simply adjust the security group’s permissions
accordingly. Refer to the “Security Groups” section of this chapter for more details.

Override a Regular Reservation

To override a regular reservation, hover over the regular reservation in the Day view of the
reservation grid and select the Override option. The Reservation form then opens for you
to enter your reservation’s details. When you save, a prompt displays the conflict with the
regular reservation and gives you the option to override the conflicting regular
reservation(s).

Q_al Meeting Room Manager
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However, if the time and resource settings you've chosen for your reservation conflict with
a priority reservation, none of the resources or recurrences involved in the reservation can
be saved. You are prompted of the conflict and brought back to the Reservation form to
make changes.

Reassign Meetings | Kate

Meetings can be reassigned to another user to grant this other user permissions to the
reservation. This can be done to meetings individually or to all of one user’s meetings.

When a reservation is created in MRM, the creator's username is assigned to the
reservation in the database. This is different from the Booked By field on the Reservation
form's General tab which can be changed. When a reservation is reassigned, the user who
created the reservation is replaced by the other user. Depending upon each user’s
permissions, this can grant the other user full permissions to a reservation he originally
didn't have permission to.

Meeting reassignment is permanent and does not allow a user’'s meetings to be
given to multiple users. You may wish to simply delegate other users to a username. This
can be done on a per-reservation, per time-frame, or permanent basis. Rather than
assigning the new user as owner of the reservation(s), he is simply given the organizer’s
permissions to work with the reservations this username created.

To add a delegate to your username, refer to the “Edit Your User Profile” section of the
“Security” chapter.

To add a delegate to a specific reservation, refer to the “Delegate a Reservation” section of
the “Reservation” chapter.

Administrators like Kate may add a delegate to a username. Refer to the “Usernames”
section of the “Security” chapter for details.

Reassign a User’s Meetings

In the event that a new employee whose Modify Others Meetings permission is set to
False takes a previous staff member's place, he is not able to modify the reservations
created by the previous staff member that he is replacing. However, by reassigning the
Created by field from the previous staff member to the new employee, administrators can
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keep the user's permissions minimal, and yet still allow him to edit the reservations that
he needs access to; in this case, those reservations that the previous staff member
created.

Before you reassign meetings, it is strongly recommended that you create a backup
copy of your reservation database. There is no undo operation for this function. Also ensure
that the new employee's username and permissions have been added to the reservation
database.

To reassign a user’s meetings:
1. Click the Admin icon.

Click the Reassign Meeting icon.

From the Meeting Created By menu, select the previous staff member's username.

Select the new employee's username from the Reassign to field's menu.

mos W N

Click OK to save changes.

Reassign One Meeting

In the event that a user needs to pass the administration of a reservation to another
person, she can do so using the Reassign Reservation feature. The ownership of the
reservation is moved to the new user who can now modify this meeting as his own, even
with the Modify Others Meetings permission disabled, as he is now considered to be the
meeting’s owner.

In order to reassign another user’s meeting, you must have the Change Others
Meetings permission. In order to reassign your own meeting, you must have the Add/Edit
Meetings permission.

To reassign a meeting:

1. Loginto MRM as the username who is the reservation’s owner.

2. Inthe day view of the reservation grid, hold the mouse over the reservation you wish
to reassign. From the menu, select Reassign Reservation.
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3. The Reservation Reassignment form opens. It shows the meeting title, the current
owner as indicated in the Created by field, and the start and end dates and times of
the meeting.

This detail is provided to allow you to confirm that the reservation you are reassigning
is the one you mean to reassign.

4. Inthe Reassign to field, select the user whom you wish to transfer ownership to.

5. Click OK to save the ownership change.

If a priority rights user passes his reservation’s ownership to a user who does not
have priority rights, the reservation is no longer a priority reservation and can be
overridden by a user with priority rights. Similarly, if a user who does not have priority
rights passes her reservation’s ownership to a user who has priority rights, the reservation
is now a priority rights reservation and cannot be overridden.
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Customizations Overview | Kate

Customization is the best way to ensure that you get the most out of MRM. The MRM
Architect provides the freedom to customize both the user interface and the forms used
for entering data.

Because customizations affect all users, they are typically made by the global
administrator. It is important that all other users are logged out of the database while you
are making form design changes. It is recommended that all customizations ideally be
done prior to giving your users access to your reservation database.

Some of the forms that can be customized are:

+ Resource Detail form

+ Reservation form

+ Address Book form

- Attendee Detail form,

+ Request Meeting form

+ Resource Search form

+ Reservation Search form.

For example, you can customize the Resource Detail form to ensure that your

specifications are met and customize the Reservation form to include all of the equipment
and services that you offer to your staff for their meetings.
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Some customers choose to customize MRM to meet their scheduling needs beyond
meeting rooms. You can customize your reservation database to meet your company’s
specific reservation needs, such as scheduling golf tournament tee times, company
vehicle bookings, meeting room reservations, and anything else that your organization
needs to schedule.

Customization also goes beyond form design. You have the freedom to customize the
images on the interface to incorporate your company colors and logo and the ability to
customize each label to allow for different languages to be used. The possibilities are
endless!

Form Design Overview

It is pertinent that any user making changes with the form designer read all information
pertaining to form designer before attempting the change.

Users must keep in mind that when making form design changes, permanent changes are
being made in the database. There is no undo function for form design changes.

Changes may affect the standard reports that come with MRM and make them unusable.
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Number. A number field can only contain numeric values. Totals can be generated for
number fields when they are included in reports.

Memo. A memo field can contain more text than a text field can contain.

Picture. A picture field stores a graphic image. JPEG, GIF, and BMP image formats are
supported. To add or remove a picture, click the Add or Remove button within the form
itself once you have completed using the form designer.

Date. A date field contains a date in the format which matches your workstation’s date
format. When clicked, a pop-up calendar displays.

Checkbox. A Checkbox field stores a true or false value.
Label. A label field only displays the label’s name.

Link. A link field allows you to display text which, when clicked, directs the user to the
underlying link.

Adding a Tab | Kate

Additional tabs can be added at any time. However, it is recommended that form design is
complete before resources are added to the reservation database and the database is
made accessible to users.

To add a new tab to the Reservation form or the Resource Detail form:

1. Click the Form Designer checkbox at the bottom left corner of the form.

2. A prompt warns that form design may affect reports. Click OK.

3. The Form Designer Toolbox opens beside the form, displaying the Fields tab.
You are now working in Form Design Mode.

4. Select the Tabs tab.
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5. Inthefield above Add Tab, enter the name of the new tab you wish to create.

Special characters cannot be used in the tab’s name. To add special characters to
a tab’s name, use the label translation feature. For more details, refer to the “Language
and Label Translations” section of this chapter.

6. Click Add Tab.

7. Adjust the tab’s properties using the Tab Properties section of this chapter as a
reference.

Tab Properties | kKate

Properties can be set for each tab on the Reservation form or the Resource Detail form.

Tab Name. This is the tab’s name. Once a tab has been created, the name cannot be
changed except through the label translation feature. Refer to the “Language and Label
Translations” section of this chapter for details on changing a label.

Order. This property defines what order the tabs in the form are displayed in.

Has Requirements. Requirements are those items listed in tabs such as Equipment or
Supplies, which are required for a reservation. This property may be set to either true or
false. If it is set to true, when an item from the tab is selected, the reservation is saved as
meeting with requirements.

Hidden. This property may be set to either true or false. If it is set to true, the tab is hidden
from view. Only users with the View Hidden Tabs permission can view a hidden tab.

Locked. This property may be set to either true or false. If it is set to true, users cannot
make modifications to the tab. The Modify Locked Tabs permission allows a user to
modify a locked tab. This permission should only be assigned to administrators.

Lock After Save. This property may be set to either true or false. If it is set to true, users
cannot make modifications to the tab once the reservation has been saved for the first
time. The Modify Locked Tabs permission allows a user to modify these tabs. This
permission should only be assigned to administrators.
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<Location> Email. This property sets the department email by location. It defines the
email address that receives the notification emails when a required item is selected on the
current tab.

Removing a Tab

The best resolution for removing a tab that you no longer wish to have is to hide the tab
from view. To do this, just set the tab’s Hidden property to True.

If you must delete a tab, be aware that removing a tab also deletes all fields that exist on
the tab. All data stored in a field that is deleted is permanently lost.

Never delete any of the tabs which come with MRM by default.

It is strongly recommended that no users are logged into or able to log into the
reservation database while form design customizations are being made. If the reservation
database is being accessed by anyone other than the person performing the form design
customizations, corruption to the reservation database may occur.

Adding a Field

Additional fields can be added to the Reservation form or the Resource Detail form at any
time. However, it is recommended that form design is complete before resources are
added to the reservation database and the database is made accessible to users.

It is strongly recommended that no users are logged into or able to log into the
reservation database while form design customizations are being made. If the reservation
database is being accessed by anyone other than the person performing the form design
customizations, corruption to the reservation database may occur.

To add a field to the Reservation form or the Resource Detail form:

1. Click the Form Designer checkbox at the bottom left corner of the form.
2. A prompt warns that form design may affect reports. Click OK.

3. Inthe Form Designer Toolbox, select the Field tab.

You are now working in Form Design Mode.
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4. Select the tab that you wish the new field to belong to.
5. Click the type of field that you wish to add.

6. The new field appears at the top left corner of the form. It can be moved into position
by using the mouse to drag it into place.

The position of the field’s name can be adjusted independently.

7. Editthe Name property to name the new field.

By default, the name of the field is the field type plus a number. E.g. TEXT1

Special characters cannot be used in the field’s name. To add special characters to
afield’s name, use the label translation feature. For more details, refer to the
“Language and Label Translations” section of this chapter.

8. Adjust the field’s remaining properties, using the “Field Properties” section of this
chapter as a reference.

Field Properties | Kate

Properties can be set for each field on a customizable form.

Name
This is the name of the field. If this property is grayed out, the name cannot be changed.

Tab

This is the name of the tab that the field is on. Change this to reassign the field to another
tab.

Type
This is the type of the field. This property is always read-only.

Mandatory

This property may be set as either true or false. If it is set as true, users must enter
information into this field in order to save the reservation.
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Default

This property displays information automatically within the field. The administrator can
enter the desired text or choose from the date, time, date and time, next invoice number
or the name of the user who is making the reservation.

Value List

This property can either be set as true or false. If true, the field displays with a pull-down
menu option. Value lists can only be assigned to text, memo and number fields. When the
Value List property is set to true, items in the value list can be selected by clicking on the
arrow to the right of the field. ltems can be added, edited, and deleted from the value list’s
pull-down menu when the corresponding button is selected. Value lists do not restrict
users from entering random data into a field.

Calculation
This property is used to calculate information such as a total of two other fields.

Enclose field names in {} brackets in order to refer to them for adding within the
Calculation property.

E.g. To calculate the fields valuel + value2 on the Totals tab, the calculation would be:
{Totals/value1} + {Totals/value2}

Price

This property allows a dollar value to be assigned to a field. This value appears on the
invoice tab when the item is selected if the field is on a tab whose Has Req value is set to
true.

Alignment
This property defines the alignment of the text in the field.

Legend: 0 = Left, 1 = Right, 2 = Center

Tab Index

This property defines the order in which the cursor moves from one field to the next when
the tab key is pressed.

Left
This property defines the position of the field based on its space from the left of the form.

71

.
a

-] Meeting Room Manager



Chapter 4 | Customizations

Top
This property defines the position of the field based on its space from the top of the form.

Width
This property defines the width of the field.

Height
This property defines the height of the field.

Label Left

This property defines the position of the field’s label based on its space from the left of the
form.

Label Top

This property defines the position of the field’s label based on its space from the top of
the form.

Qty: <Location>

This property determines how many of the resource are available for booking at each
location. Refer to the “Option 1: Inventory Tracking” subsection of the “Prepare
Requirements’ Availability” section of the “Resources & Requirements” chapter for more
details.

Removing a Field | Kate

The Form Designer utility allows you to delete fields in the Reservation form and Resource
Detail form as needed. However, it is recommended that form design is complete before
resources are added to the reservation database and the database is made accessible to
users.

Some fields cannot be removed, as they are necessary for the forms to function as
intended.

It is important to know that when deleting a field, all data stored in that field is

permanently lost. Therefore, it is best to avoid deleting fields, especially once your asset
database has been made accessible to your users.

72



MRM 7 | Admin Guide

It is strongly recommended that the administrator ensures that no users are logged
into or able to log into the asset database while form design customizations are being
made. If the asset database is being accessed by anyone other than the person
performing the form design customizations, corruption to the asset database may occur.

To delete a field:

1. Click the Form Designer checkbox at the bottom left corner of the form.
2. A prompt warns that form design may affect reports. Click OK.
3. Inthe Form Designer Toolbox, ensure that the Field tab is selected.

You are now working in Form Design Mode.

4. Scroll to the tab that holds the field you wish to delete.

5. Inthe Form Designer Toolbox, select the field you wish to delete from the pull-down
list.

6. Click Delete Field.
7. Click OK to permanently delete the field and it's data.

8. Other fields can now be repositioned by using the mouse to click and drag them into
place.

Designing Search Forms | Kate

Search forms can be customized to reflect your organization’s searching needs. These
forms simply require that you decide which of the fields from the two information bearing
forms you wish to have available for users to search by and how you want these search
fields arranged.

To design the Reservation Search form or the Resource Search form:
1. Click the icon for the search form you wish to design.
2. Check the Form Designer checkbox at the right of the form.

3. Thellist of available fields opens. Those fields which are already on the form have a
check in the box to their left.
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Check the box next to each of the fields you wish to have available for users to search
by.

When users click the TAB button on their keyboard, the cursor will move to the
next field in the order in which they were initially selected to be displayed on the form
by the person performing form design.

When you are ready to display your changes, click Apply Changes.

6. Allfields that you selected now display on the search form, while those that were

Adding Images to the Interface | Kate

unselected have been removed.

Use your mouse to drag the fields and their titles to the position you wish them to be
in on the form and to resize the fields as required.

Titles can be dragged separately from the field they belong to.

MRM'’s image translation feature is intended to allow organizations to customize the look
of the interface according to the organization’s corporate identity. The majority of MRM’s
images can be customized.

To customize images:

1.
2.

® N o w s W
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Select the Admin icon.
Click the Customizations icon.

The Customize Interface Summary form opens.

In the Form field, select the form that you want to customize.
Click on the name of the image that you wish to change.

In the default field, enter the path and file name of the new image.
The results can be viewed by selecting the Preview button.

Select OK to save changes, or Cancel to cancel the changes.

Repeat steps 3 to 6 until all the images are changed.
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Language and Label Translations | Kate

MRM'’s label translation feature can be used to customize the MRM user interface. Most
labels in the interface can be customized to modify existing English words and phrases.
The feature can also be used to add languages other than English for use in MRM.

”

If you simply wish to customize an existing English label, refer to the “Customizing Labels
section of this chapter.

If you prefer to use languages other than English, MRM allows you to add languages to
your MRM database and then translate the user interface into the desired languages.
Multiple languages can be used by users of the same database. Read through the
instructions in this section before you begin.

Adding a Language

Multiple languages can be used in MRM. To make a language other than English available
to your users, first add the language to your MRM database as described below. Then
translate labels for that language as described in the “Customizing Labels” subsection of
this section.

Once your language is set up, you can specify it as the default language for your users as
described in the “Specify Default Language” subsection. If not all of your users speak the
same language, you may provide users with the appropriate URL to access MRM in their
own languages as described in the “Specify User’s Preferred Language” subsection.

The following instructions describe how to add a new language column to the ResStrings
table in your MRM database.

Familiarity with the SQL Enterprise Manager is helpful for this process, and a full
version of SQL is required.

Customization changes are permanent and cannot be undone. It is recommended
that you make a backup of your database before proceeding with any customization
procedure.

To add a language to your MRM database:

1. In SQL Enterprise Manager, navigate to your database.
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2. Double-click on Open Tables to open it.
Right-click on ResStrings, then select Design Table.
In a blank row, under Column Name, enter your language as it is spelled in English.

Example, if you are adding Romanian, enter Romanian, not Romana.

5. Ensure that the data type is set to ntext, the length is 16, and the Allow Nulls
property is checked.

6. Save changes and close the table.
7. Close SQL Enterprise Manager.

You have added your language to your MRM database. You may now translate the
user interface into this language as described in the “Customize Labels” subsection
below.

Customizing Labels

You may customize labels in Meeting Room Manager for English or a language you have
added as described in the “Adding a Language” subsection above.

Since the form designer does not allow special characters in field and tab names, you may
use these instructions to add them.

Customization changes are permanent and cannot be undone. It is recommended
that you make a backup of your database before proceeding with any customization
procedure.

To customize labels:
1. Select the Admin icon.
2. Select the Translations icon.
The Language Translation form opens.
3. Inthe Language menu, select the language whose labels you wish to customize.
In the Form menu, select the form associated with the labels you wish to customize.

5. You may edit one label in its detail form or multiple labels directly in the list:
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« Edit One: Select the label you wish to customize by clicking its name in the
Resource String column. In the Language Detail form that opens, edit the label as
required. When finished, click OK to save your changes.

- Edit Multiple: Click inside the language column beside the label you wish to
customize and adjust the label as required. Continue for other labels associated
with the current form, and then click Update to save your changes.

6. To customize additional labels, repeat steps 4 and 5 as required.
7. Click Close.

Specifying the Default Language

You may specify the default language for your users. If users require multiple languages,
users requiring a different language than the default can specify it in their URL as
described in the “Specify User’s Preferred Language” subsection below.

The default language is English unless otherwise specified by an MRM administrator as
described below.

To specify the default language for your database:
1. Click the Admin icon.
2. Click the Translations icon.
The Language Translation form opens.
3. Inthe Language menu, select the default language.
Allow the screen to refresh.
4. Click Set Default.

The selected language is now the default language for all users.

Specifying the User’s Preferred Language

Users can specify their preferred language as a parameter in the URL they use to log in to
MRM. The language they specify must exist in the MRM database and have been
translated by an MRM administrator as described in the subsections above.
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Users preferring to use the default language do not need to specify the language in the
URL.

Specify the preferred language in the URL by adding the language parameter,
language=<language name>, at the end of the URL:

http://<web server>/<virtual directory>/default.aspx?language=<language name>

Replace <web server name> with the name of your web server, <virtual directory name>
with the name of your virtual directory, and replace <language name> with the name of
the preferred language as it is spelled, in English, in the MRM database.

Example: http://webserver1/MRM7/default.aspx?language=Romanian

Automated Email Reminders | Kate

Email reminders can be set up to remind various people in your organization about
upcoming meetings. You may wish to have the receptionist and group coordinator
receive daily emails listing the day’s meetings, or maybe you wish to remind each host of
his meeting an hour before it starts.

Who you choose to put in the recipients list and what frequency you select are all up to
you. Email reminders are controlled by triggers held in the MRM Window Service Admin.
Administrators who are familiar with SQL statements can customize existing reminders or
create their own.

Default Email Reminders
The following is the list of email reminders provided with the software:
» Remind 1 Hour in Advance
» Remind 2 Hours in Advance
+ Remind 4 Hours in Advance
« Remind 24 Hours in Advance
» Remind 48 Hours in Advance
+ Remind 1 Week in Advance
« Notice of Meetings for Today
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Create a New Email Reminder

Email reminders are triggers comprised of SQL statements. Therefore, knowledge of SQL
statements is required in order to create email reminders. You may with to contact your
system administrator if you would like additional email reminders created.

To create a new email reminder trigger:

1. Select Start>All Programs>Meeting Room Manager 7>MRM Window Service
Admin>Triggers tab.

2. Click Add New Trigger.

The frmTriggerDetail screen appears.

frmriggerDetail
Trigger Mame: ]
Statuz Schedule
 Active Daily frequency - Every * Once at: |D8 00:00 AM j
Cilae " Oceurs Eveny: ’7 mirte(s)

Trigger Statement

GetTodayE ventList

‘alidate Trigger Statement

Email Infarmation

Insert Field: | j Ingert [v HTML famat

To ]
Subiject: |Event List for [Today]
Body <H4»<center> Today Event list </centers</Hd»
<HE> <centers[Today] < /centers < /H5>
[SOLLIST: GetTodayEventlist @Typa='list]
Test

Save Trigger

Send Test Email to: Test Email
Cancel
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In the Trigger Name field, type a name for the trigger.

Do not use special characters such as apostrophes or quotation marks in the
trigger name.

Choose the schedule for the trigger to run from one of the following:
+ Once at <time>: This schedule forces the trigger to run every day at the specified
time.

« Occurs every <#> minute(s): This schedule forces the trigger to run at a specified
minute interval such as every one minute.

In the Trigger Statement field, enter the SQL statements that control the trigger.

6. Test your trigger statement by clicking Test Trigger.

« If the SQL statement is valid, a prompt indicates this.
- If the SQL statement is invalid, a prompt indicates this and lists the problems.

7. Click OK.

10.

11.

12,
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In the Email Information section, if you wish to send HTML formatted email, check the
HTM L Format check box. If you wish to send text only emails, leave this box
unchecked.

. TheInsert Field pull-down menu contains the field references which can be used to

compose the subject and body of the email reminder.

To use a field reference, place your cursor where you wish the field reference to be
added, then select the field reference from the pull-down menu, and then click Insert.

The available field references are based upon the tables which are pulled in the
trigger statement.

Compose the subject and body of the email reminder by clicking in the appropriate
field and entering field references and your own customized text.

Enter each recipient’s email address into the To field. Separate each email address with
a semicolon ().

Once you have finished setting up the email information and trigger statement, send

a test email by entering an email address you have access to in the Send Test Email To

field, then clicking the Test Email button.

« If the test email is sent successfully, a prompt indicates this. You can visit the inbox
of the email address you sent the test to in order to view the test email.
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- Ifthere is no data in the database which can be used to test this email reminder, the
prompt indicates this.

13.0nce you are satisfied with the email reminder trigger you have created, make it
active by selecting Active in the Status section of the form.

14.Save the email reminder trigger by clicking the Save Trigger button.

A prompt indicates that the email reminder trigger was saved successfully and the
form closes.

Edit an Email Reminder

Because email reminders are triggers comprised of SQL statements, knowledge of SQL
statements is required in order to edit email reminders.

Editing the default email reminder triggers which come with Meeting Room Manager is
not recommended.

To edit an email reminder trigger:

1. Open the service by selecting Start > All Programs > Meeting Room Manager 7 > MRM
Window Service Admin > Triggers tab.

2. Double-click the name of the email reminder trigger you wish to edit.
The corresponding Trigger Detail form opens.

3. Make the changes as required.

4. Click the Save Trigger button to save the changes.

A prompt indicates that the email reminder trigger was saved successfully and the
form closes.

Deactivate an Email Reminder

Email reminder triggers cannot be deleted. Instead, simply deactivate any email reminder
triggers that you do not wish to use.

1. Opentheservice by selecting Start > All Programs > Meeting Room Manager 7 > MRM
Window Service Admin > Triggers tab.
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2. Double-click the name of the email reminder trigger you wish to deactivate.
The corresponding Trigger Detail form opens.
3. Select Inactive in the Status section of the form.

4. Click the Save Trigger button to save the change.

A prompt indicates that the email reminder trigger was saved successfully and the form
closes.
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Locations Hierarchy | kate

When you create your locations, you have the ability to structure them in a hierarchy
based on continent, country, region, state, city, office, floor, or whatever works best for
your organization. This is all done by creating the upper levels first, then adding lower
levels as children to the previously created locations. Up to five levels of locations can be
created in the hierarchy, but resources can only belong to the lowest level of each
hierarchical pyramid.

Time Zones | Kate

Time Zone Overview

Each location in MRM is assigned to a time zone. These time zones consist of the default
time zones pulled from Microsoft Windows as well as any custom time zones that the
MRM administrator creates.

Time zones must be based on Coordinated Universal Time (UTC). This means the
difference between Universal Time, also known as Greenwich Mean Time, or 0, and the
time zone’s time. For example, while London is 0, Boston is -5 and Tokyo is +9.

If one of your office’s locations is located in a time zone that is not included in the set
provided with Microsoft Windows, the time zone can be added by the MRM administrator.
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If daylight savings time affects any of your locations, this adjustment is set in the
location’s details.

Each current user’s time is based on her My Location setting. If her MyLocation setting is
Boston, she will see all reservations at the time they occur for her, at -5 UTC (Eastern). If
that same user changes her My Location setting to the Los Angeles office, set to -8, she
now sees all reservations in the grid according to Los Angeles (Pacific) time. Therefore, it is
extremely important that all users correctly set their MyLocation setting and that each
location’s time zone setting is correct.

Custom Time Zones

If a location’s time zone is not listed in the given time zones, a custom time zone can be
created. Unlike standard time zones which remain unchanged, custom time zones can be
edited and deleted.

Creating a Custom Time Zone

1. Select Admin icon > Locations > Manage Time Zones.

2. Inthe time zone summary, click New.

3. Inthe time zone detail, enter the name for the new time zone.

4

In the UTC offset hours field, enter the number of hours and minutes that this time
zone is offset from UTC.

5. Click OK.

UTC was previously known as GMT.

Daylight savings time settings for custom time zones are set by location in each
location’s respective detail form.

Editing a Custom Time Zone

1. Select Admin icon > Locations > Manage Time Zones.

2. Inthe time zone summary, click on the custom time zone’s name.

3. The detail form opens in which changes can be made.

4. Click OK.
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Deleting a Custom Time Zone

1. Select Admin icon > Locations > Manage Time Zones.
2. Inthe time zone summary, click its checkbox. Click Delete.
3. Click OK.

Adding a Location | Kate

A location can represent a continent, country, region, state, city, office, floor, or whatever
works best for your organization. You can create locations at any time.

1. Click the Admin icon.
2. Click the Locations icon.

Existing locations are shown in their hierarchical positions.
3. Click New.

Enter the new location’s name which will be what users see.

Each location must have its own unique name.

5. From the Child Of list, select the location that you want to be just above this new
location in the hierarchy. If this new location is to be a top level location, select Root.

Because resources can only belong to the bottom level location, sublocations
cannot be assigned to a location which contains resources.

6. Inthe Start Time and End Time fields, select when that the office opens and closes.

Reservations outside these hours are not shown in the grid.

This setting overrides the default setting for business hours for this location only.
To set the business hours default information, refer to the “Schedule Tab” section of the
“Reservation Database Configuration” chapter.
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7. If resources have already been added to your database, you may select those which
are assigned to this location. Filter the resources based on their current location
assignment by selecting a location from the value list.

Rooms which have not yet been added to the reservation database can be
assigned to this location individually upon their creation.

8. Inthe Time Zone list, select the applicable time zone.

9. If this location resides in an area which observes daylight savings time, check the
Observe DST checkbox. Then adjust the daylight savings time (DST) details as
follows:

« DST Bias:
Enter the number of minutes that are affected during daylight savings time.
For example, most areas in the US and Canada observe daylight savings time as -60
minutes.
« DST Start:
Enter the start date and time of daylight savings time observation.
For example, in areas of the USA which observe daylight savings time, the start date
is April 2nd at 2:00 am in 2006.
« DST End:
Enter the end date and time of daylight savings time observation.

For example, in areas of the USA which observe daylight savings time, the end date
is October 29th at 2:00 am in 2006.

If the time zone you have selected is a default Windows time zone, there is no
need to adjust the DST settings as they are automatically gathered from Windows. If
you wish to use the DST settings, just check the DST checkbox.

10.Click Save and Close .

When a new location is created, it automatically has full permissions assigned to it for
users in the Administrators security group. All other security groups have no permissions
assigned for the new location, not even visibility. To add permissions to new locations for
security groups, follow the instructions in the “Security Groups” section of the “Security”
chapter.
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Editing a Location | Kate

Location details can be edited at any time, including which resources are assigned to the
location.

To edit location information:
1. Click the Admin icon.
2. Click the Locations icon.
Existing locations are shown in their hierarchical positions.
3. Click the name of the location you wish to edit.

4. The location’s detail form opens displaying its existing details. Make changes as
necessary.

Moving a location with sublocations to a different level or parent location brings
its sublocations and resources with it.

5. Click Save and Close.

Deleting a Location | Kate

Locations which do not contain child locations can be deleted at any time.

Be sure to reassign any resources assigned to the location unless you wish to delete
them and all of their reservations as well.

Deleting a location is a permanent change which cannot be undone.

Locations which contain child locations cannot be deleted. The last remaining
location also cannot be deleted.

To delete a location:

1. Click the Admin icon.

2. Click the Locations icon.

3. Click the checkbox to the left of the location(s) that you wish to delete.
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4. Click Delete.

Adjusting Location Hierarchy Order | Kate

By default, locations are displayed in the location hierarchy in the order which they and
their parent locations are created. This order can be adjusted in the locations list.

To adjust the order of locations:
1. Click the Admin icon.
2. Click the Locations icon.

3. Inthelist of locations, click the up arrow next to the location you wish to move
upward in the list.

« Child locations can be moved to the top of the list of other child locations for the
parent location.

« When parent locations are moved up, their child locations are moved with them.

4. Your changes are displayed when the main screen refreshes.

Setting Reservation Form Tabs by Location | Kate

When you open the Reservation form to create a reservation, you'll notice that different
tabs are available depending upon the rooms and resources you have selected. This is
because Meeting Room Manager allows the global administrator to choose which tabs on
the Reservation form apply to resources at each location.

By default, only the General tab is available to resources at every location. If you wish to
allow reservation information to be entered into fields on additional tabs, you must
enable these tabs by location.

The default tabs that exist when a reservation database is first created are the General,
Attendees, Setup, Equipment, and Invoice tabs. These can be modified and additional
tabs added using the form designer.

To enable and disable the tabs that are shown by location:

1. Click the Admin icon.
2. Click the Visible Tabs by Location icon.
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3. On the form, locations are listed down the left and tabs are listed across the top.
+ Check each box where you wish to enable the corresponding tab for the
corresponding location

+ Uncheck each box where you wish to make the corresponding tab unavailable for
resources belonging to the corresponding location.

4. C(lick Save.

My Location | ALL

The My Location setting allows you to set the location and therefore the time zone which
you are currently in. All time references for meeting start and end times are based on your
time zone. Make sure to set your My Location setting accurately so that reservations
display their times in your time zone.

Your My Location setting is overridden by the default location set in your user profile each
time your log in. If you wish to update your the location you regularly work in, update
your user profile information. See the “Edit User Profile” section of the “Security” chapter for
details.

You may choose to change your My Location setting if you are travelling to a different
office location, for example. This allows you to see reservations at the time they will take
place where you will be.

To change your current My Location setting:

1. Onthe main screen, select Set Current Location.
2. Onthe My Location menu, select the location you are now at.
3. Click OK.

Your MyLocation setting will be overridden by the default location in your user
profile the next time you log into MRM. To change your default location, refer to the
“Edit Your User Profile” section of the “Security” chapter.

M
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CHAPTER 6 Resources and
Requirements

Resources and Requirements | ALL

Both resources and requirements can be scheduled in MRM. But what is the difference
between them?

Resource: An item displayed in the grid that users schedule reservations for. The
most common example is a meeting room.

Requirement: An item reserved for use from a departmental tab within the
Reservation form. Some examples are televisions, DVD players, and projector screens.

While resource bookings are controlled based on a user’s security settings, requirements
are just booked based on availability. However, requirements can be subject to
confirmation from the head of the department that the requirements belongs to, but only
if the confirmation feature is turned on in project options. For example, with the
confirmation feature turned on, the head of AV services must confirm requirements from
the AV Services tab.

Preparing Requirements’ Availability | Kate

There are two methods to choose from when preparing the availability of requirements.
The method you choose depends upon whether your requirements are mobile or affixed
to aroom.
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Option 1: Inventory Tracking

The inventory tracking method is best to choose if your organization’s equipment can be
moved from one meeting room to another. It is the most commonly used method as it
allows you to precisely determine how many of each piece of equipment is available at
each location.

This method uses the form designer to prepare the quantity of each type of requirement
that is available to be used at each location. First tabs are created by department, then
requirements are added, and finally the number available at each location is entered.

For example, if there are two televisions in the Chicago office, then a user scheduling a
meeting in Chicago will be limited to two televisions, as long as neither have already been
booked by another user for the time slot of the reservation.

If both televisions have been reserved for the time she wishes to use them, she is
prompted by MRM upon saving her reservation that there are no televisions available.
Upon clicking the OK button in the prompt, she is returned to the Reservation form in
which she can change the time or date of her reservation in order to have a television for
her meeting.

Option 2: Room-Equipment Availability

The alternate method, called room-equipment availability, uses the Match Tab Fields save
rule to determine which requirements are available in which resources.

It is set up primarily in the Resource Detail form which contains an Equipment tab by
default. Each piece of equipment in this tab has a checkbox that can either be checked or
unchecked. Which checkboxes you select or leave blank depends upon which pieces of
equipment are available in the resource whose details you are modifying.

For example, if the Pacific Boardroom does not have a Speakerphone in it, leave the
Speakerphone’s checkbox blank. If the Pacific Boardroom has a whiteboard affixed to the
wall, then check the whiteboard checkbox.

When the Match Tab Fields save rule is active, a user is not able to select a requirement for
her reservation which is not selected on the room’s Resource Detail form. This is because
the save rule checks the tabs of the same name between the Resource Detail form and the
Reservation Detail form. Therefore, if form design changes are made and you wish to use
this save rule, ensure that you name each corresponding requirement exactly the same
on the tab of the same name on both forms.
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For example, if you add a piece of equipment called laser pointer, ensure that you keep
the space between the words laser and pointer on both forms, and list it on the tab with
the same name on both forms, for example, a Miscellaneous tab that you have added.

Implementing Inventory Tracking | Kate

Preparing for Inventory Tracking

Before you can apply inventory tracking to your database, set the Has Requirements
property to True for each of the tabs in the Reservation form which contain requirements.

To set Has Requirements:

1.
2.
3.

Click the Form Designer checkbox.
A prompt warns that form design may affect reports. Click OK.
The Form Designer Toolbox opens, displaying the Fields tab.

You are now working in Form Design Mode.

4. Select the Tab tab.

If you wish to create a new tab for requirements, click Add . In the New Tab form, enter
the new tab name.

The new tab appears in the open Reservation form.

6. Click on the tab to reveal its properties in the Form Designer Toolbox.

7. Set the Has Req property to True.

8. Add the email address to the <Location> email property. This property defines the

9.

email address that receives the notification emails when a required item is selected on
the current tab.

Emails can be sent automatically from the server. To implement this, refer to the
“Send Email from the Server” section of the “Reservation Database Configuration”
chapter.

Adjust the remaining properties as required. Refer to the “Form Design: Tab Properties”
section of the “Customizations” chapter for details.

10. Click Apply Changes.

Q_al Meeting Room Manager
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11. Repeat steps 5 through 11 for each tab that you wish to add inventory tracking to.

Applying Inventory Tracking

To apply inventory tracking to your database, follow the instructions below for every
piece of equipment that can be booked within a tab of the Reservation form:

1. With the Form Designer Toolbox Fields tab open, highlight the field you wish to set
quantities for.

2, Scroll to the bottom of the properties list in the toolbox. Adjust the quantity setting
for the <Location> quantity property.

3. When finished, select Apply Changes.
4. Continue applying quantities to the remaining equipment in the various tabs to
implement your secure inventory tracking system.

When you are finished adding quantities, activate the inventory tracking save rule.
1. Close the form designer toolbox, and on the main screen, click the Admin icon.
2. Click the Save Rules icon. The list of save rules opens.

3. Click Inventory Check save rule. The save rule’s detail form opens.

4. Check the Active checkbox, then click OK.

Inventory tracking is now in effect.

Applying Prices to Equipment | Kate

To calcuate invoice charges, prices can be assigned to requirements, like equipment, on
the Reservation form.

To assign a price to an equipment field:

1. Click the Reserve icon to display the Reservation form.

2, Click the Form Designer checkbox .

3. Click OK.

4. The Form Designer Toolbox opens beside the form, displaying the Fields tab.
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5.
6.
7.

Resource Types | Kate

Highlight the field to which the price should be assigned.
Enter the price in the Price property.

Close the Form Designer..

The Resource Type selected for a resource determines the tabs that are available to
contain detailed information about the resource.

Because tabs can be added and deleted using the form designer, resource types are
typically created by the global administrator because she knows which tabs were
designed to correspond with which types of resources.

Adding a Resource Type

1. Click the Admin icon.

ok W N

6.

Click the Resource Type icon.
Click Add.
Enter the name and description of your new resource type.

Check the box beside each tab that you wish to make available for resources in this
group.

Click Save.

Editing a Resource Type

1. Clickthe Admin icon.

> W N
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Click the Resource Type icon.
Click the name of the resource type that you wish to edit.

In the detail form, change the name and description, select the tabs that you wish to
make available and unselect the tabs you wish to make unavailable to resources in
this group.

Click Save.
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Deleting a Resource Type
A resource type can only be deleted if no resources are associated with it.

1. Click the Admin icon.

Click the Resource Type icon.

Check the box beside the resource type(s) that you wish to delete.
Click Delete.
Click Yes.

om s W N

If the resource type you are attempting to delete is still assigned to resources, you are
prompted with the name of the resources and informed that their reservation type
needs to be changed before this reservation type can be deleted.

Adding a Resource | Kate

An unlimited number of resources such as meeting rooms may be added to a reservation
database. There must be at least one resource in your reservation database before a
reservation can be created.

If you wish to customize the fields and tabs on the Resource Details Form, it is
recommended that you do this before adding resources. To use the form designer, follow
the instructions in the “Customization” chapter.

Resources themselves are usually created in the reservation database by a local
administrator who has an intimate knowledge of the resources in the facility that he
administrates. However, your global administrator may choose to add all resources herself
for consistency, especially if the Match Tab Fields save rule is in use.

To add a meeting room/resource:

1. Click the Admin icon.

2. Click the Add Resource icon.

3. Type the name of the new resource.

Though it is recommended that each resource be given a unique name, two resources
may have the same name as long as they do not belong to the same location.
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In the Resource Type list, select the resource type. This determines which tabs are
available for you to insert information about the resource.

To add and remove resource types, follow the instructions in the “Resource Types”
section of this chapter.

In the Location Name list, select the location that the resource belongs to.

To add and remove locations, follow the instructions in the “Locations” chapter.

Specify the column width for the resource and its display order. If nothing is entered,
the defaults will apply.

It is recommended that a different set of numbers is used for resources at each
different location for the display order field.

7. Add information to the remaining fields in each available tab as appropriate.

8. You may add a picture to represent the resource according to the “Adding a Picture to a

9.

Adding a Picture to a Resource | Kate

Resource” section of this chapter.

Click Save and Close.

You may add images to a resource’s Resource Detail form enabling users to view a photo
of the resource. Alternatively, you could add an image of the meeting room’s floorplan.

To add an image to the Picture field:

1.

.
a

Hover your mouse over the Picture field and then click the Plus icon.
The Upload File window opens.

Click Browse to locate the image that you wish to associate with the resource.

. Click Upload.

The picture is now visible in the Resource Detail form.
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Viewing and Editing a Resource | Kate

To view or edit resource details, click the resource name on the grid. This opens the
Resource Detail form, allowing you to view all of the resource’s details and edit them if
necessary. Click the Save and Close button to save your changes.

Removing a Resource | Kate

Deleting a resource is permanent and also results in the deletion of all reservations
for the resource.

Once you have read that warning above and are certain that you wish to delete the
resource, follow the instructions below:

1. Click the resource name on the grid. The Resource Detail form opens.
2. Select Delete.
3. Click Yes.

Changing Grid Order | Kate

MRM administrators can set the order in which resources are displayed in the grid. It is
recommended that a different number be assigned to each resource across all locations,
as oppose to re-starting at number one for resources in a new location. This aids in
controlling the display order when all resources are displayed in the grid.

To open the resource’s detail form, click on the resource in the Day or Timeline view of the
grid. Then adjust the Grid Order setting numerically relative to other resources.
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Services Management Overview | Kate Juliette

The Services Management module provides you with the tools you need to effectively
manage service requests for your meetings. When checkboxes and value lists on the
Reservation form aren’t enough, you can use this module to manage services that require
more; details like cost, description, and availability are all managed by this module.

Services are catalogued to make them easier to manage. Each service's catalogue
contains categories and subcategories under which service items can be grouped.

Service items are anything your organization offers with room reservations. They can:

+ Be available at select or all locations and/or rooms.
+ Be limited in quantity by location for tracking inventory.
+ Have a cost by location.

Services are the groupings in which service items are clustered. They may each be
separate departments within your organization. Each service has its own:
- Security setting that controls which users can order the service’s items.

« Security setting that controls which administrators can manage the service and its
items.

« Administrative form in which administrators manage the service.

« Named tab on the Reservation form in which users view service items and place
orders.
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» Customizable lead time requirement which restricts users from placing an order too
close to delivery time.

+ Customizable future booking time limit which restricts users from placing an order
too far in advance of the delivery time.

« Catalogue of service items which are grouped into categories and subcategories for
convenience.

The Services Management module is enabled with the MRM Enterprise edition activation
key.

Service Examples

Nearly any services you provide to your guests and staff can be integrated with your
reservation process. Here are some examples of uses for the Services Management
module:

100

A corporation provides Audio Visual equipment to its staff for their meetings. The
corporation has made an Equipment tab available for staff to choose the equipment
they require for each meeting.

The equipment shown on the tab is specific to the resource that the staff member has
selected for his reservation. In one location, there are 15 teleconference units
available. But since they can only be used in rooms which have an active phone jack,
the administrator made the units unavailable in resources without phone jacks.

A staff member who chooses the Training Hall, which does not have a phone jack,
does not see the units in the list of items, but a staff member who selects the Ebenezer
Conference Room sees the teleconference unit as a piece of equipment he/she can
schedule because the conference room has a phone jack.

A university rents out their classrooms to local non-profit organizations and
businesses for catered meetings. The University provides a Catering Services tab with
menus unique to each campus building based on the catering available there. Some
rooms have catering available while other rooms, such as computer labs, cannot be
reserved with a catering request.

The university also provides an Equipment tab with a list of the various Audio Visual
equipment available with each room. Some classrooms can be rented with a projector
and screen, others with just a TV and DVD player. Some rooms have white boards and
others can accommodate flip charts.
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M

When a guest reserves a room for his own use, he is presented with the list of items,
both catering and equipment, that are available in the resource he has selected. The
university requires that all service requests be approved by the administrator, so when
reservations are created, service orders sit in the Pending status until confirmed.

A community center rents out their soccer fields and tennis courts to local children’s
and youth groups. Along with the field or court rental, guest groups can rent balls,
nets, racquets, and even referees.

The community center provides an Equipment tab which contains all available
equipment for rent, and a Referee tab which provides a brief description of each
Referee’s qualifications. The reservation process takes care of equipment and Referee’s
availability.

A warehouse has 75 loading docks. When a loading dock is booked to receive a
delivery, the receiving department also needs to book a forklift and driver.

The organization provides a Forklift tab which contains the various kinds of forklifts
available for rent, and a Driver tab which lists each driver’s skill set.

An equestrian center holds International horse shows, sometimes caring for 300
horses at a time. Each horse stall can be booked by the owners of incoming horses,
along with the various equestrian services required.

In the Reservation form, the center has made the following tabs available: Feed,
Farrier, Vet, and Paddocks. Each horse’s daily feed requirements can be ordered and
feed times specified in the Feed tab.

If a horse arrives needing new shoes, the owner can simply update the booking and
request Farrier services. If the owner requires that his/her horse has daily exercise in a
paddock, a suitable one can be booked along with the stall.

The rates for each service are supplied to the owner as he/she picks the services in his
request and totalled at the bottom of each service tab.

The national head office of a corporation often hosts the International President of the
company. When he visits, he requires the Executive Boardroom full-time for all of his
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These are just a few examples of the many ways in which the Services Management
module can be utilized to manage the services that your organization provides.

Now it's time to examine your own organization and decide how you wish to apply the
Services Management module for your use. Once you have decided, you can set up your
services and then make them available to users.

Setting Up the Services Management Module

1. Create Services
The global administrator creates the services used in Meeting Room Manager.
e.g. Catering, Equipment, etc.

See the “Managing Services” section of this chapter.

2. Grant Permissions to Service Administrators

The global administrator grants manage rights for each service to appropriate service
administrators responsible for each location.

See the “Security Settings for Services” section of this chapter.

3. Create Service Catalogues

Each location’s service administrator creates the list of items that is available with each
service. This can involve:

- Creating a hierarchy of categories and subcategories in which service items will be
grouped.
e.g. Beverages may be a category, while juice and tea may be subcategories.
See the “Service Item Categories” section of this chapter.
« Adding service items to the above categories
e.g. The Screens category may contain TVs and projector screens.
See the “Service Items” section of this chapter.
- Specifying service item availability according to room
e.g. Projector screens may not fit in some rooms, while they can be used in others.

102



MRM 7 | Admin Guide

See the “Service Items” section of this chapter.
« Specifying pricing according to location
e.g. Imported food dishes may be more expensive than local items, so while a

shrimp dinner is inexpensive in the southern states, it may be pricier in the central
states.

See the “Service Items” section of this chapter.

4. Modify Email Templates

Based on insight from local service administrators, the global administrator modifies
the default email templates associated with Services Management.

See the “Service Order Email Messages” section of this chapter.

5. Grant Permissions to Users

Once setup is complete, the global administrator grants management and ordering
rights to appropriate users.

See the “Security Settings for Services” section of this chapter.

Service Orders in the Reservation Form

Once the Services Management module has been set up by the global administrator and
the local service administrators, users create reservations which contain service requests.
Each service can be viewed as a tab in the reservation detail portion of the Reservation
form. Instructions for placing a service request can be found in the “Request Services”
section of the “Reservations” chapter.

Service Orders in Microsoft Outlook

If you choose to use the MRM plug-in for Outlook, you can schedule service requests
along with your reservation, just as in Meeting Room Manager. Instructions can be found
in “The MRM Plug-In for Microsoft Outlook” chapter of this manual.

M
4
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Ongoing Management of Service Orders

It is important that global administrators and local service administrators understand the
order process before granting users with rights to place orders.

For an overview of the order process, refer to the “Order Process” section of this chapter.
The “Service Order Use Case Diagram” subsection shows service administrators what their
role is in the order process.

Before service orders begin to roll in, service administrators can find instructions on how
to perform their tasks in the following sections of this chapter: “Pending Orders: View,
Confirm, or Reject’; “Processing Orders: View or Cancel’, and “Viewing Archived Orders’”.

Managing Services | Kate

Manage Services Overview

Within MRM, you can create any services you wish to provide to users who reserve your
resources. To see a range of examples, refer to the “Service Examples” subsection of the
“Services Management Overview” section of this chapter.

If at a later date a service is no longer available in any of your organization’s locations, you
can delete it. At any time in between, you can modify the services you offer.

Creating a New Service

Services can be created at any time. However, it is recommended that you read this entire
chapter before creating your services.

1. Click the Admin icon.

2. Click the Services Management icon.
3. Click Add.
4

. The Service Details form opens. Enter the following:
« Name: Enter service’s name.

- Tab Name: Enter a brief, intuitive name for the tab that will be displayed in the
Reservation form.
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This is the only name of the service that users will see when they are
scheduling a reservation.

- Description: Enter a brief description of the service.

« Min. Lead Time: Enter the minimum amount of notice, in hours, required for users
to schedule this service's items. Up to three digits can be entered.

» Max. Future Booking Window: Enter the maximum number of months in advance
that this service’s items can be scheduled. The number must be between one and
twelve. For unlimited, leave the field blank.

5. If you do not want to track inventory for this service, check the Inventory Is Not
Applicable checkbox. MRM will not check to see if quantities of an item belonging to
this service are available when ordered.

Catering likely does not require inventory tracking since food is consumable.
However, equipment likely requires inventory tracking since only a certain number of
each item have been purchased and are available for circulation.

6. Click Save to return to the list of services.

Permissions to the new service are automatically granted to the Administrators
security group. Users in other user groups have no permissions to the new service.
This gives the global administrator and local service administrators time to set up the
service before making it available to users.

For more information, see the “Security Settings for Services” section of this chapter.

Editing a Service
To edit an existing service:

1. Click the Admin icon.
2. Click the Services Management icon.
3. Click the name of the service you wish to edit.

4. The Service Details form opens. Edit the service's details as required:
- Name: Enter the name of the service.

« Description: Enter a brief description of the service.
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» Tab Name: Enter a brief, intuitive name of the tab which will be displayed in the
Reservation form.

This is the only name of the service that users will see when they are
scheduling a reservation.

« Min. Lead Time: Enter the amount of notice, in hours, required for users to schedule
this service's items. Up to three digits can be entered.

+ Max. Future Booking Window: Select the amount of months in advance that this
service’s items can be scheduled. One, two, threeg, six, twelve, or unlimited can be
selected.

5. If you prefer not to track inventory for this service, check the Inventory Is Not
Applicable checkbox. MRM will not check to see if quantities of an item belonging to
this service are available when ordered.

Catering likely does not require inventory tracking since food is a consumable
item. However, equipment likely requires inventory tracking since only a certain
number of each item have been purchased and are available for circulation.

6. Click Save to return to the list of services.

Deleting a Service
If a service is no longer available in any of your organization’s locations, you may delete
the service from MRM.

]
[E All orders, service categories, service subcategories, and service items associated
with a service that is deleted are immediately deleted along with the service.

To delete services:

1. Click the Admin icon.

Click the Services Management icon.
Check the box(es) next to the name(s) of the service(s) that you wish to delete.
Click Delete.

woswN

Click OK. You are returned to the list of services.
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Security Settings for Services | Kate

Overview of Security Settings for Services

There are two security permissions associated with services for every location. The
Manage <ServiceName> permission controls the ability to manage services, and the
Order <ServiceName> permission controls the ability to order service items. Both of these
permissions are created automatically when the global administrator creates a service.

Granting Service Admin Security Rights

Before the service administrator, such as Juliette, can manage her location’s service orders,
she must have the appropriate permissions granted to her security group. The global
administrator can either create new security groups or edit existing ones.

Once you grant permissions to a security group, users who belong to that group now
become service administrators. You should only grant this permission to a security group
that has other permissions appropriate to a service administrator, such as Visible and View
Others Meetings, for the location they will be managing services for.

To grant permissions for a service at a specific location:

1. Click the Admin icon.
2. Click the Security Groups icon. The list of security groups displays.

3. Click on the name of the security group to which you wish to grant services
management rights. The Security Settings form opens.

4. C(lick the Advanced Service tab.

5. Grant the right to view and use a service's ordering tab on the Reservation form by
clicking the corresponding checkbox next to each appropriate location.

The name of the permission is Order <Service Name>. Replace <Service Name> with
the name of the service.

e.g. If your service’s name is Equipment, the permission is named Order Equipment.
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6. Grant users with permission to manage a service by clicking the corresponding
checkbox next to each appropriate location.

The name of the permission is Manage <Service Name>. Replace <Service Name>
with the name of the service.

e.g. If your service’s name is Equipment, the permission is named Manage Equipment.
7. Set other permissions as needed.
8. Click Save. You are returned to the list of security groups.

To assign users to groups, refer to the “Usernames” section of the “Security”
chapter.

Enabling Users to Request Services

Before users like Charlie can request service orders in their reservations, they must have
the correct permissions granted to their security groups. The global administrator can
either create new security groups or edit existing ones.

Users should not have service permissions assigned until local service administrators have
set up the service items. For more information on the setup procedure, refer to the
“Setting Up the Services Management Module” subsection of the “Services Management
Overview” section of this chapter.

To grant users with permission to order services:
1. Click the Admin icon.
2. Click the Security Groups icon.

The list of security groups displays.

3. Either:
« Click on the security group you wish to grant service order permissions to.

« To create a new security group click Add User Group.

4. The Security Settings Groups form opens. Click the Advanced Service tab.
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5. Grant the right to view and use a service's ordering tab on the Reservation form by
clicking the corresponding checkbox next to each appropriate location.

The name of the permission is Order <Service Name>. Replace <Service Name> with
the name of the service.

e.g. If your service’s name is Equipment, the permission is named Order Equipment.

6. Set other permissions as required.

7. Click Save. You are returned to the list of security groups.

To assign users to groups, refer to the “Usernames” section of the “Security”
chapter.

Services Catalogues | Juliette

Service catalogues are made up of a hierarchical structure of categories within which
service items are organized. This allows users and administrators to find service items
quickly and easily.

How you choose to arrange categories and subcategories is completely up to you, based
on the services you are providing to users.

For simplicity, the instructions below only reference categories but apply to subcategories
as well. In areas where categories and subcategories operate differently, this information
is stated.

Only categories or subcategories which do not contain their own subcategories can
contain service items.

Catalogue Navigation
The catalogues you create will be accessed by your users in the Reservation form.

When a user first clicks on a service tab, the catalogue displays only the top level
categories, each with plus symbols next to them. When a user clicks on the plus symbol or
the category name, the items or subcategories that are one level beneath the clicked
category are displayed. The same applies to subcategories.

M

S Meeting Room Manager
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If you have set up the catalogues with multiple levels of subcategories, this means that
your users will have to click several times before accessing the items they wish to order. If
you have the option to limit the levels of subcategories you include in your catalogues,
this may be beneficial to your users. However, if this is not practical, you can enable the
custom tree view which modifies MRM’s behavior.

When the custom tree view is enabled, users can click a category’s name to reveal all
subcategories and service items beneath it. The same behavior applies to subcategories.

The custom tree view has been designed to allow users to use the default behavior by
clicking the plus symbol next to a category or subcategory.

To enable the custom tree view:

1. In Microsoft SQL Server Enterprise Manager, open your MRM database.

2. Open the Options table.

3. Add a blank row to the table.

4. Inthe new row, under the Setting column, enter the following text:
CUSTOM_TREE_VIEW

5. Inthe new row, under the Value column, enter the following text:

True

6. Exit Microsoft SQL Server Enterprise Manager.

Adding Service Item Categories
To add a service item category:

1. Click the Admin icon.
2. Click the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Categories tab.
4. Click New.
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5.

6.

Enter the new category’s details:
- Category Name: Enter the category’s name.
« Child of: If the category you are creating is a subcategory, select the parent

category from the pull-down list. To create a top level category, select Main
Category (root).

Click Save.

Editing Service Item Categories

1.
2.

Click the Admin icon.
Click the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

Click the Categories tab.

4. Click the name of category you wish to edit.

Q_al Meeting Room Manager

Categories and subcategories are displayed in a hierarchy format. To expand or
minimize your view of subcategories, click the parent Plus or Minus button.

. Adjust the details as required.

« Category Name: Adjust the category’s name as required.

« Child of: If the category you are creating or editing is a subcategory, select the
parent category from the pull-down list. To create a top level category, select Main
Category (root).

Reassign Service items:

- Service items can be reassigned to this category. In the Reassign section, select the
category (and subcategory if applicable) of the service item you wish to reassign.
Check the box beside each service item you wish to reassign to this category.

- Service items can be removed from this category. In the Reassign section, uncheck
the box beside each service item you wish to remove from this category.

. Click Save.
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Deleting a Service Item Category

Subcategories with service items assigned to them and categories with subcategories
below them cannot be deleted. They must be reassigned or deleted before the parent
category or subcategory can be deleted.

To delete a service item category:
1. Click the Admin icon.
2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.
3. Click the Categories tab.

4. Click the checkbox beside each category that you wish to delete.
5. Click Delete.

Only subcategories with no service items assigned to them and categories with
no subcategories below them can be deleted.

6. Click OK.

Service Items | Juliette

Service Items Overview

Service items can be anything that you allow users to reserve along with your resources.
They can be grouped into categories to make them easier to locate for booking and
administration.

MRM allows service administrators to determine which items are available for which
locations and rooms. For example, caterers may not wish to provide dinners for a meeting
held in an auditorium while they can easily cater dinners to a group in a conference room.
When a service item is created, it is unavailable in all locations and rooms by default.
While adding or editing an item, service administrators must make the item available in
the rooms to which it can be delivered.
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Hierarchies can be used to make items available for some rooms and not for others. If the
quantity field in a lower level is left blank and there are items available for use in the level
above it, then the lower level can order it. If the lower level’s quality field is filled with a
zero (0), it cannot order that item and it will not appear in the user’s list of available
resources for that room.

Hierarchies can be used to share items between rooms. If the total number of a particular
item is placed into the quantity field of the highest level, and the quantity fields of the
lower levels are left blank, then that item can be ordered by the rooms on the lower levels.
Users cannot order more items than are available or they will get a warning message.

You can set the maximum number of items a room can order by putting that number into
the quantity field for that room. By doing that, and leaving the quantity field for other
rooms blank, the other rooms have no limits on the amount that they can order. Rooms
with the quantity fields filled out can only order up to that number of items.

Prices can be set for each service item. These prices are location-based to allow for price
variation across your organization’s locations. To use catering again as an example,
seafood, may cost less on the coast in Seattle than it does to prepare inland in Denver,
Colorado.

The price of each item is $0.00 by default and must be set according to location by service
administrators when the item is added or edited.

Adding a Service Item
1. Click the Admin icon.
2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service's name is Equipment, the icon is named Manage Equipment.

Select the Items tab.
4, Click New.

5. The information form opens. Enter:
« Item Name: Enter the name for the item in the Item Name field.
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- Description: Enter a description for the item in the Description field. Users can view
this information before adding the item to an order.

- Category: Select a category or subcategory for the item to be classified under.

6. Assign availability by location. To make this item available to all rooms at a location,
check the box beside the location.

You can make this item available for all locations or no locations by clicking the
All and None buttons at the bottom of the form.

With hierarchies, you can specify the items that can be shared between locations,
block items from being used by certain locations, or set the maximum number of
items a location can use. See “Service Items Overview” on page 112 for details.

7. If you are tracking inventory for this service, enter the available quantity in the Qty
column for each location you have selected.

8. Availability can be assigned by resource. To view the resources belonging to a
location, select the location and click View Rooms.

Set availability by checking and unchecking the boxes beside each resource.
Rooms for each selected location will be displayed until the Hide Rooms button is
clicked.

9. Anitem’s price is set by location. Enter the item’s price next to the corresponding
location. To copy this price to all other locations, click Set Price for All.

10.Click Save.

Editing a Service Item

1. Click the Admin icon.
2. Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Items tab.
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8.

9.

Click the name of the item you wish to edit.

If you prefer to narrow the list of items first, select the item'’s category or
subcategory from the Category pull-down list.

. The information form that opens. Alter the item’s information:

+ Adjust the name for the item in the Item Name field.

«+ Adjust a description for the item in the Description field. This displays when a user
hovers his mouse over the item before selecting it for his reservation.

- Adjust the subcategory for the item to be classified under.

Availability can be assigned by location. To make this item available to all rooms at a
location, check the box beside the location.

You can make this item available for all locations or no locations by clicking All
and None.

. Availability can also be assigned by resource. To view the resources belonging to a

location, select the location and click View Rooms.

Set availability by checking and unchecking the boxes beside each resource.
Rooms for each selected location will be displayed until the Hide Rooms button is
clicked.

An item’s price is set by location. Enter the item’s price next to the corresponding
location. To copy this price to all other locations, click the Set Price for All button.

Click Save.

Deleting a Service Item

1.
2.

Q_al Meeting Room Manager

Click the Admin icon.
Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

Click the Items tab.
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4. The full list of service items displays. To narrow the list of items, select the category or
subcategory of the item you wish to edit.

5. Check the box beside each service item that you wish to delete.
6. Click Delete.
7. Click OK.

Order Process | ALL

The order workflow process is as follows:

Place Order

When a user with Order <Service Name> permissions for a specific location saves an
order, the Order Notification Email is sent, and the order’s status is set to pending.

Refer to the “Request Services” section of the “Reservations” chapter for details on placing

an order.

Confirm or Reject a Pending Order
Once an order’s status is pending, a service administrator may confirm or reject the order.

When an order is confirmed, an Order Confirmation Email is sent, and the order’s status is
changed to processing.

When an order is rejected, an Order Rejection Email is sent, and the order is moved to the
archived list.
Modify an Order

An order is modified when any change is made to the order or the reservation’s start and
end time.

When a pending order is changed, an Order Change Email is sent, and the order status
remains the same.

When a processing order is changed, the order is cancelled and a new order is created.
The Order Cancellation Email is sent, followed by the Order Notification Email, and the
new order’s status is now pending.
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Cancel an Order

An order of pending or processing status can be cancelled three ways: the reservation
containing the order can be deleted, the order can be cancelled directly in the
Reservation form, or the selected resource can be changed. In all three circumstances, the
order is cancelled completely. It is therefore moved to the archived list.

Archived Orders

Orders which have been rejected by a service administrator, cancelled by a user, or have
passed their delivery date and time are displayed in the archived orders list. This list can
be viewed in the Manage Orders form.

M
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Service Order Workflow Matrix

The following is a graphical description of the service order workflow:
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Service Order Use Cases Diagram

The following are the use cases for service orders:
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Pending Orders: View, Confirm, or Reject | Juliette

Service administrators are responsible to confirm or reject service orders in a timely
manner.

To view all pending orders and confirm or reject an order:

1. Click the Admin icon.

2. Select the corresponding service icon.
The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Manage Orders tab.
4. From the List Orders menu, select Pending.

The list of orders whose status is pending displays. To narrow the search, enter the
order number, room name, item name, and/or the delivery date range and then click
the Search button.

5. Once you have located the order you wish to confirm or reject, do the following:

«» To view the details of the order, click the View Detail button to the right.
The order displays in a new window. You can print the details by clicking Print
Order. When you are finished, click Close Window.

+ To confirm the order, changing its status to processing, click Confirm.
The server sends the Order Confirmation Email to the user who created the order.
The order is removed from the pending list and added to the processing list.

+ Toreject the order, changing its status to archived, click Cancel.

The server sends the Order Rejected Email to the user who created the order. The
order is removed from the pending list and added to the archived list.

Only orders taking place in the future are displayed in the Pending list. Historical

orders are displayed in the Archived list showing their status as it was at the time the
order was due to be delivered.

120



MRM 7 | Admin Guide

Processing Orders: View or Cancel | Juliette

Orders which have been confirmed by a service administrator can be viewed in the
Processing list. In the processing stage order details can be viewed and orders can be
cancelled.

To view the list of processing orders:

1.
2.

Click the Admin icon.
Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Manage Orders tab.

4. From the List Orders menu, select Processing.

The list of orders whose status is processing displays. To narrow the search, enter the
order number, room name, item name, and/or the delivery date range and click
Search.

. Once you have located the order you wish to view the details of or cancel, do the

following:

+ To view the details of the order, click View Detail.
The order displays in a new window. You can print the details by clicking Print
Order. When you are finished, click Close Window.

«+ To cancel the order, changing its status to archived, click Cancel.

The server sends the Order Rejected Email to the user who created the order. The
order is removed from the processing list and added to the archived list.

Only orders taking place in the future are displayed in the Processing list. Historical
orders are displayed in the Archived list showing their status as it was at the time the
order was due to be delivered.

Q_al Meeting Room Manager
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Viewing Archived Orders | Juliette

Service administrators like Juliette can find orders which have been rejected, cancelled, or
have passed their delivery time in the Archived list. This list shows each historical order’s
status as it was at the time the order was due to be delivered.

To view the list of archived orders:

1.
2.

Click the Admin icon.
Select the corresponding service icon.

The name of the icon is Manage <Service Name>. Replace <Service Name> with the
name of the service.

e.g. If your service’s name is Equipment, the icon is named Manage Equipment.

3. Click the Manage Orders tab.

4. Inthe List Orders menu, select Archived.

Service Order Email Messages | Juliette

The list of orders whose status is archived displays. You can narrow the search by
entering the order number, room name, item name, and/or date range and then
clicking Search.

Once you have located the order you wish to view the details of, click View Detail. The
order displays in a new window. You can print the details by clicking Print Order.
When you are finished, click Close Window.

Service Order Email Message Types

Five types of email notifications can be sent through MRM for reservations which contain
a service order booked with the Services Management module. These are in addition to
the email notifications that are sent by MRM for regular reservations.
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Each service has its own set of templates for the five service order email messages. These
templates are accessed in each service’s Manage <Service Name> form, on the Email
Messages tab.

The following is the list of service order emails:

« Order Notification Email
+ Order Change Email

+ Order Cancellation Email
+ Order Confirmed Email
+ Order Rejected Email

Each of the service order emails is listed below along with the scenario in which the email
is sent automatically and some tips on setup:

Service Order Notification Email
This email is sent when a user creates a new service order and saves the reservation.

The intended recipient is the service administrator at the order’s location. To set up the
recipient as intended:

« In this email’s setup, select <Departments of Selected Items> as your value in the To
field.

+ Use of the form designer to add email addresses by location to each service tab in
the Reservation form. This directs MRM to the correct email address based on the
location that the selected room is in.

See the “Adding a Tab” and the “Tab Properties” sections of the “Customizations”
chapter for more information.

Service Order Cancellation Email
This email is sent when an order has been cancelled.

The intended recipient is the service administrator at the order’s location. To set up the
recipient as intended, follow the same instructions as given above for the Service Order
Notification Email.

.
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Service Order Change Email
This email is sent when a user makes a change to the items selected, the quantity of the
items selected, or a change in the time or date when an order’s status is pending.

The intended recipient is the service administrator at the order’s location. To set up the
recipient as intended, follow the same instructions as given above for the Service Order
Notification Email.

Service Order Confirmed Email
This email is sent when a service administrator confirms an order, and therefore the
order’s status changes to processing.

The intended recipient is the organizer of the meeting and catering request. To set up this
recipient as intended:

«+ Use the form designer to add a mandatory field to the Reservation form in which
the user creating the order must enter his email address.

« In this email’s setup, select the field that you just created as your value in the ‘To’
field.

See the “Adding a Field” and “Field Properties” sections of the “Customizations”
chapter for more information.
Service Order Rejected Email

This email is sent when a service administrator rejects an order.

The intended recipient is the organizer of the meeting and service request. To set up the
recipient as intended, follow the same instructions as given above for the Service Order
Confirmed Email.

Services Management Email Messages Tab

The specifications for each email can be adjusted in the Email Messages tab of each
service's Manage <Service Name> form.

Adjustments to other email messages not specific to the Services Management module
are made in the Options form. See the “Email Messages Tab” section of the “Reservation
Database Configuration” chapter for details.
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The following descriptions are for the fields used on the Email Messages tab to edit details
of each of the five email message types.

Email Pull-Down Menu

The Email pull-down menu allows you to select which email notification or invitation that
you are editing such as Service Order Notification or Service Order Change.

The Field Reference Field

The Field Reference field allows you to insert automatic data that is specific to each
meeting. For example, selecting <General/Meeting Title> displays the meeting title for
whichever meeting the email is about. These references can be used in any of the
customizable fields within the Email Messages tab by clicking Insert.

The To Field
The To field allows you enter the email address that will receive this email each time it is
sent by the server. To use multiple addresses, enter a semi-colon (;) between each address.
The CC Field

The CC field allows you enter a second or more email addresses that will receive this email
each time it is sent by the server. To use multiple addresses, enter a semi-colon (;) between
each address.

The Subject Field
The Subject field displays the notification’s subject. It is recommended to use the
<General/Meeting Title> reference field somewhere in the subject.

The Body Field

The Body field represents the body of the message that is sent out. It should be generic
for all types of meetings. Anything specific to a particular meeting should be represented
by a Field Reference such as <Location>. Keep in mind that the service order emails
cannot be adjusted by users at the time they are sent because they are sent automatically
by the server.

Sending Service Order Emails from the Server

All Services Management module notification emails are automatically sent by the server,
and are unseen by MRM users. In order for MRM to send these emails, you must first
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provide Meeting Room Manager with your SMTP server information. To do this, follow the
instructions in the “Configure the Mail Server” section of the “Reservation Database
Configuration” chapter.

Once your mail server is configured correctly, the Services Management module
notification emails originate from the SMTP server and appear to come from whatever
reply-to address you have selected, regardless of the user who actually entered/edited
the reservation.

If the SMTP service is not correctly configured, automatically sent emails appear to
be sent by Meeting Room Manager but remain on the email queue of the SMTP server.

In order for emails to be sent correctly, attendee and user email addresses must be
SMTP addresses, not X.400 addresses.
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Reservation Grid | ALL

The reservation grid displays your organization’s business hours vertically with resources
listed across the top. The purpose of the reservation grid is to display previous and
upcoming meetings. There are four viewing options: Day, Timeline, Week, and Month.

Time and date formats in the reservation grid are based on your browser settings.

Reservation Grid Views

Day View

The day view displays the reservations of resources for a single day with resources across
the top and time blocks down the left side. A heading over the resources indicates which
sublocation each clump of resources belongs to. This heading is based on the
sublocations below the currently selected location in the Location Hierarchy filter.

Only business hours are displayed in this view, though reservations can be made outside
business hours. Reservations can be created, copied, cut, pasted, and opened in this view.

Timeline View

The timeline view displays the reservations of resources for a single day with time blocks
across the top and resources down the left side, opposite of the day view. Only business
hours are displayed, though reservations can be made outside business hours.
Reservations can be created, copied, cut, pasted, and opened in this view. This view is not
visible by default. To make it visible, see the “Grid View Tab” section of the “Reservation
Database Configuration” chapter.
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Setting viewing permission for private meetings

The right to view private meetings is given to all users which have “Change Other’s
Meeting” permission enabled. See “Location Permissions” on page 48 for more details.

1. Select Admin>Security Groups.

The Security Settings-Groups screen appears.

2. Click on the user group you want to give permissions to open private meetings to.
3. Click the Location Permission tab.

4. Inthe Change Others Meetings column, check each security group you want to give
permission to and click Save.

Creating a private meeting

Private meetings do not support the delegate function.

1. Open the MRM reservation form.

2. Check the Private checkbox to make a meeting private or uncheck it to make it
public.

3. Fill out out the rest of the form as needed and click Save.

On the grid view, other users will see the word “Private” and when the resource is
booked. They cannot open it.

When searching, private meetings you do not have rights to see are not displayed.

Creating a Reservation | Charlie

Reservations in MRM range from the simplest single resource booking to reservations that
involve multiple resources spanning various locations and recurring at regular or random
intervals.
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While this section gives you an overview of creating reservations in Meeting Room
Manager, it is recommended that you also read the following sections in this chapter
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4. Enter the details into the available fields. Click on a tab to reveal the fields on it.

By default, only the Meeting Title field must be filled in. Other fields may be
required as well, depending upon the customizations made using the form designer.

Different tabs may be available depending upon the resource you select.
Because tab availability is based on the resource’s location. Administrators can
change which tabs are available for each location by following the instructions in the
“Set Reservation Form Tabs by Location” section of the “Locations” chapter.

5. Click Save and Close.

If your reservation conflicts with an existing reservation, it can either be saved as
a wait list entry or adjusted and saved. See the “Meeting Conflict Resolution” section of
this chapter for more details.

6. Click Yes to send a notification email.

You may adjust the email and click Send unless emails are sent from the server. For
details, see “Send Email from the Server” section of the “Reservation Database
Configuration” chapter.

To adjust email templates, see the “Options: Email Messages Tab” section of the
“Reservation Database Configuration” chapter.

Setting Recurrences | Charlie

You may set reservations to recur at any interval. Check the recurrence box in the
meeting’s Reservation form to do this. In the Set Recurrence form that opens, make your
selection:

You cannot add new bookings into an already existing series without loosing any
exceptions in the series. For example if all meetings are 2pm but one is at 3pm, adding a
new booking causes the 3pm meeting to be lost.

You can modify individual bookings in a series at any time, but you cannot make
changes to the series on a global basis. For example you can move a meeting from 2pm to
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3pm, but you cannot move all of the meetings at once. Each booking must be changed
one at a time.

Daily

Every [1] Day(s)

Change the number to specify the frequency of the occurrence. Select or unselect the
Include Weekends checkbox.

Weekly

Every [1] Week(s) on [Sunday]

Change the number to specify the frequency. Select the day(s) of the week for the
recurrence.

Monthly
Day [1] of every [1] Month(s) OR The [first] [Sunday] of every [1] Month(s)

Two examples are the seventeenth day of every one month or the first Monday of every
two months. Change the fields as appropriate.

Yearly
Every [October 17]

To select a new date, either enter it in manually or select one from the pop-up calendar by
selecting the pull-down menu.

Daily / Weekly / Monthly / Yearly Details
At the bottom of the Meeting Recurrence form are two fields. Either enter the number of
occurrences or the date at which the occurrences are to end.

Next button

On the Daily, Weekly, Monthly, and Yearly tabs, there is a Next button. Clicking this button
selects the choices you have set in the tab are in and opens the Random tab where your
chosen dates are displayed. You are then able to specify further exactly which dates you
would like the course to occur on.
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Random

Select any dates from the calendar on the left. Selected dates are displayed in the box to
the right. Clicking a displayed date removes it from the list.

Resolving booking conflicts

If someone else has already booked a resource you requested for your series, a screen
appears showing the conflict(s).

Conflict resolution does not support the wait list or priority reservations.
To resolve a conflict:

+ To book a different resource at the same time, click on the original resource name or
the Xicon. A list of resources available at that date and time appears. Click on an
item to book it and click OK.

If you click OK without resolving the conflict(s), the conflicted meetings are
skipped, are not saved in the database and will not appear in the calendar.

« To book the same resource at a different time, first save the booking to a different
resource. After saving, re-open it and re-book the meeting into the original
resource, but at a different time and any other changes as needed.

Finding Available Resources | Charlie

It is often helpful to be able to search for meetings rooms that are not only available for
your meeting and its recurrences, but that also match your requirements.

To find available resources:

1. Ensure that the date and time fields for your reservation have been filled in. If you
intend to create recurrences for the meeting, enter recurrence information as well.

2. Click the Find Available Resources icon in the Reservation form.

3. The Find Resources form opens. Enter your requirements and click Find.

The default location displayed in the Find Resources form is the location selected
in the Locations Hierarchy on left side of the main screen.
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4. If unsatisfied with the results, adjust your criteria and click Find to perform a new
search. If you are creating a single reservation with no recurrences, you may also
adjust the meeting start and meeting end information.

Adjusting the meeting start and meeting end information should not be done in
the search form for recurring meetings.

5. Check the checkbox to the left of the resource(s) that you wish to reserve and click
Select.

6. The resource(s) you selected in the search form are now selected in the Reservation
form.

Multiple Resource Reservations | Charlie

A multiple resource reservation is a reservation for which more than one resource or room
is booked. Any grouping of resources can be selected for a single reservation, regardless
of the resource’s location or resource type. To make your reservation a multiple resource
reservation, simply check the box next to the various resources you wish to book in the
Reservation form.

While each resource’s occurrence is part of the original reservation, each resources’
occurrence can be opened and modified separately from the others or the original
reservation as a whole can be opened and modified at one time.

Each resource’s occurrence of the reservation always displays separately in the
Meeting Confirmation form.

Each time a reservation is saved, even when resources spanning multiple time zones are
selected, the time of the meeting is based on the time that the meeting will occur for the
user booking the reservation. This information is taken from the user’s current
MyLocation setting. Therefore, it is extremely important that each user always has a
location in his time zone selected for his MyLocation setting.

Tabs by Resource

When you choose to reserve multiple resources in one booking, MRM allows you to keep
reservations the same or unique for each resource. To allow for this, the Reservation form
has been designed with two rows of tabs across the middle of the form, above the
reservation details.
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The upper row of tabs contains each resource selected in the current booking. The lower
row contains the reservation details and requirements tabs. When a resource name on
one of the upper tabs is clicked, the lower portion of the form refreshes to show the
reservation details tabs that are available for this resource.

This design allows you to make reservation details unique for each selected resource. If
you prefer that the details be the same for all resources, you can use the Update One and
Update All buttons:

« Update One: click this button to copy the selected tab's details from the current
resource to all other selected resources.

« Update All: click this button to copy the current resource's details from all tabs onto
the corresponding tabs of the other selected resources.

The list of attendees is the exception. Its information is always the same for all
resources involved in a multiple resource reservation.

Because the services and service items available may vary by location, service tabs’
details cannot be copied. If you require a service order for each resource involved in your
reservation, a separate order must be placed for each resource.

The reservation’s basic details located above the tabs on the form, such as date and
time of the meeting, remain the same.

Editing a Multiple Resource Reservation

1. Click on the title of the reservation you wish to edit.
This can be done either from the reservation grid or the meeting search form.
2. When prompted, select which option you wish to perform:

- Open Single Reservation: Selecting this option limits the changes you make to
affect this resource only.

- Open Multiple Resource: Selecting this option allows you to make changes to the
details belonging to any of the resources involved in this booking

w

In the Reservation form, make changes as required.

s

If the Open Multiple Resource option was selected, the Update One and Update All
buttons are available.
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- Update One: Click this button to copy the details on this tab onto the
corresponding tabs for all other selected resources.

- Update All: Click this button to make all reservation details on all tabs the same,
matching the currently selected resource.

5. Once you are satisfied with the changes, click Save and Close to save the reservation
and return to the reservation grid.

Preparation and Cleanup Time | Charlie

Time may be scheduled outside of the reservation to allow for preparation of the meeting
room as well as cleanup after the meeting is finished. This time is shown on the grid as a
dark green bar above and/or below your meeting.

You may wish to use prep and cleanup time if you need fifteen minutes to set up a
presentation or ten minutes to allow catering staff time to clean up after a lunch.

The default time is set in the reservation database options. To change these settings, see
to the “Schedule Tab” section of the “Reservation Database Configuration” chapter.

Locked Tabs | Charlie

There are two different types of locking tabs: Locked, and Lock After Save. These settings
affect everyone who does not have the Modify Locked Tabs permissions enabled.

Locked

A locked tab can be viewed but not modified. Some organizations lock the Invoice tab, for
example.

Lock After Save

A lock after save tab locks once the reservation has been created and Save and Close has
been selected in the Reservation form. At that time, users can no longer edit the details on
the tab.

@ The only tab that is locked by default is the Invoice tab.
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Administrators with the Modify Locked Tabs permission enabled can modify any tab,
even if it is locked.

Invoice Tab | Kate Charlie

Invoice Tab Overview

The invoice tab allows organizations to keep track of billings for meetings based on the
cost of selected requirements. It is auto-populated with selected requirements and their
quantities. Only items selected from a tab whose Has Req property is True are pulled as
invoiced items on the Invoice tab.

In order for the invoice tab to become available to any users, it must be enabled by a
global administrator like Kate. To do this, follow the instructions in the “Set Tabs by
Location” section of the “Locations” chapter.

The invoice tab is a locked tab by default, which means that only users who have the
Modify Locked Tabs permission enabled may modify the dollar value for any items listed.
This allows administrators to assign set dollar amounts for the rental of equipment and
the provision of services. When dollar amounts are adjusted, the invoice tab does not
display adjusted totals until it is refreshed. To refresh the tab, move to another tab, then
back to the invoice tab.

The Bill To and Ship To fields can also be modified by users with Modify Locked Tabs
permissions.

No user can modify item quantities in the invoice tab, because they are controlled by the
quantity specified in the corresponding number field. In the case where a checkbox
indicates selection of an item, only the quantity 1 can be used.

Auto-Populate Invoice Number

The invoice tab can be set up in such a way that the Invoice # field is auto-populated in
numeric sequence.

1. Open the Reservation form.
2. Click the Form Designer checkbox.
3. Click OK.

ol -
a
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4. In the Form Designer Toolbox, select the Field tab.

You are now working in Form Design Mode.

Select the Invoice tab.

In the Form Designer Toolbox, select the Invoice # field.

In the Default property, enter the value <Next invoice #>.

© N o uw

Click Apply Changes.

Assigning Cell & Font Colors | Charlie

In addition to the standard confirmed and unconfirmed colors, additional cell and font
colors can be assigned. Color codes can be created for different types of meetings. For
example, management meetings could be green and new hire orientation could be
orange. These colors are defined in options. For more details about customization, see the
“Colors Tab” section of the “Reservation Database Configuration” chapter.

If color customization has been implemented, a color is automatically assigned to a
meeting based on the meeting’s reservation type. When a meeting has a reservation type
assigned to it, the reservation type’s corresponding color overrides any changes made to
the Assign Color setting within the meeting’s Reservation form.

To change the cell and font colors of a meeting without a reservation type assigned:
1. Click on the meeting’s title to open the corresponding Reservation form.
2. The Reservation form opens. Select Assign Color.

3. The Assign Color form opens. Click on the desired cell or font color and click OK.

Request Services | Charlie

The Services Management module in MRM enables administrators to integrate services
into the reservation process. These services can be anything that your organization offers
in conjunction with reservations, such as catering and presentation equipment.

For an in-depth summary of the capabilities of the Services Management module, set-up
instructions, and a description of the order process, see the “Services Management
Module” chapter of this manual. It is recommended that administrators read the chapter
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and fully understand the module before enabling users with the permissions to create
service requests.

Once your organization’s services have been set up in MRM, service items can be
requested within the resource reservation.

To request services:

1. Create your reservation and enter basic information, such as meeting title, start and
end time, and prep and cleanup time.

2. Select the Services tab of your choice.

For example, you may choose the Catering tab if it is available.

3. Click the name of the category and then the subcategory that the service item you
wish to request is located in.

The list of service items in the selected subcategory displays.

4. Hover your mouse over the service item you are considering ordering. A brief
description and dollar amount display.

To select this item, click on it. The tab refreshes and adds the item to your order on the
right side of the tab and displays your order’s new total cost.

5. To adjust the quantity of the item you have selected, highlight the current quantity,
type in the number you wish to order, and then click Refresh Grid.

6. The delivery time for each item defaults to the meeting’s start time but can be
adjusted. Click the Time field and alter the delivery time for each item as necessary.

7. Repeat steps 3 through 6 for each item you wish to select.
8. Click Save and Close to save your reservation and place your service order.
If your reservation is recurring, the order is duplicated for each recurrence. If the

entire reservation series is altered, each catering order is altered accordingly. If one
occurrence in the series is altered, only its catering order is altered accordingly.

Priority Reservations | Charlie

If a reservation is created by a user with priority rights, that reservation is considered a
priority reservation. It cannot be overridden, or bumped to the wait list, by anyone.
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Users with priority rights can create reservations in spaces already reserved by regular
users. When a priority user sees an existing reservation on the Day view in a space he
would like, he can hover over the reservation and select the Override button.

This opens a blank Reservation form in which his reservation’s details can be entered.
When he clicks save, the option to override the conflicting reservation is given.

Once a regular reservation has been overridden by a priority reservation it is moved to the
front of the wait list.

Before users with priority rights can override existing regular reservations, the
priority rights feature set must be enabled in project options. The wait list feature set is
automatically enabled along with it.

Meeting Conflict Resolution | charlie

If the reservation you are trying to save conflicts with an existing reservation, you receive
a conflict message to indicate that your reservation cannot be saved. This conflict
message is different for single reservations and recurring reservations.

Single Reservations

If you are trying to schedule a single reservation and you encounter a conflict, Meeting
Room Manager will prompt you with a message that reads similarly to this one:

“Cannot Save. This meeting overlaps with meeting:
Executive Meeting 12/5/2005 9:00:00 AM ~ 12/5/2005 10:00:00 AM”

Three options become available:

Override. Click this button to create a priority reservation and bump the conflicting
reservation to the wait list. This option is only available to users with priority rights if
the conflicting reservation was created by a user without priority rights.

Wait List Request. Click this button to create a wait list entry. All of the details you
have entered in the Reservation form are held in the wait list. If the space becomes
available, your wait list entry is automatically moved to fill the reservation space you
desire.
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Cancel. Click this button to cancel the saving process and return to the Reservation
form. From there you can make the appropriate changes to avoid the conflict. You
may wish to change the resource, time, or date of your meeting. The Find Available
Resource icon can be used to find an available room if the date and time of your
meeting must remain the same.

Recurring Reservations

If you are trying to schedule a recurring reservation and you encounter one or more
conflicts, MRM prompts you with a report of exactly which recurrences conflict with
existing meetings. The message reads similarly to this one:

“Conflicts Found.

The following meetings are conflicting with occurrences of the recurring meeting you are
attempting to create:

Resource Meeting Title Start Time End Time
Executive Boardroom Executive Meeting 12/5/2005 9:00:00 AM~12/5/2005 9:30:00 AM
Pacific Room Client Meeting 12/5/2005 9:00:00 AM~12/5/2005 9:30:00 AM

Do you wish to skip the occurrences that are conflicting?”

You can now make note of the conflicting reservations and click the Skip button to skip
the occurrences that conflict with the listed meetings or click the Cancel button to return
to the Reservation form and make the appropriate changes. The following are some
recommendations as to which scenarios work best for each of these two options:

Skip

« If you wish to keep the reservation at the same time and date but wish to change the
room in which the meeting is held. Ensure that you take note of the conflicting
occurrences, skip them, and then create new meetings for these times in an available
room.

« If you do not wish to hold the meetings at all if they conflict with another meeting.

Cancel
+ If you wish to change the time of all recurrences in order to avoid the conflicts.

« If you wish to change the dates of some recurrences in order to avoid conflicts.
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Create a Wait List Entry | Charlie

Wait list entries can be created two ways:

« When a user tries to save a reservation that conflicts with one or more reservations,
a prompt provides the option to save the reservation as a wait list request.

« If a user sees an existing reservation on the Day view in a space he would like, he can
hover over the reservation and select the Wait List Entry button.

Before users can create wait list entries, the Wait List feature set must be enabled in
project options.

Time Period Blocking | Charlie

In order to block off days for which your resources are not available, such as holidays,
simply create a recurring all day meeting for all of your resources.

To block off time periods:

1.
2.
3.
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Click the Reservation icon.
Click the All Day Event checkbox.
Click the Recurrence checkbox.

Select recurrences as indicated in the “Recurring Reservations” section of this chapter.

Click Find Available Resources.

Perform a search according to the required criterion. Click Find, then select the
checkbox beside each resource you wish to block off, and click Select.

To ensure that no resources are booked for the holidays you are blocking off, do
your search based on ‘%’ in one field while all other fields, including auto-filled fields
such as Meeting Start and Meeting End, are blank. This allows you to select all
resources, and upon saving, see which resources are already scheduled for the
holiday.

Give your reservation a meeting title, such as Closed for Holiday.
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7. Click Save and Close.

Opening a Reservation Form | cCharlie

If conflicts are present, you are prompted with details of the existing reservations
which conflict with the reservation you are currently scheduling.

To open a reservation’s detail form, click on the reservation either from the grid or from a
search results list.

If the reservation you wish to open is part of a recurring series or a multiple-resource
reservation, select the appropriate option from the list when prompted:

Editing Reservation Details | Charlie

Open Single Reservations

Open Series

Open Multiple Resource

Open Multiple Resource and Series

Reservations can be edited at any time.

1.

T

Click on the reservation you wish to edit either from the grid or the results of a
reservation search.

If the reservation you wish to edit is part of a recurring series or a multiple-resource
reservation, select the appropriate option from the list when prompted:

|

Open Single Reservation

This opens the single instance that you have clicked on. Even if this reservation
belongs to a series or a multiple resource reservation, only the selected instance is
opened.

Open Series

This opens all instances of this recurring reservation. Even if the reservation is also a
multiple resource reservation, only the recurrences that apply to the selected
instance’s resource are opened.

Open Multiple Resource
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This opens the selected instance for all resources involved in the multiple resource
reservation. Even if the reservation is also a recurring reservation, only the selected
instance is opened for the multiple resources involved.

« Open Multiple Resource and Series
This opens all instances for all resources involved in this reservation.

Edit the details on the form as required.

4. When you are satisfied with your specifications, click Save and Close to save your
changes and schedule the reservation.

5. Depending upon your database’s options settings and the details you have added or
edited, you may be prompted to send a notification email to attendees or the head of
a requirements department.

Click Yes when prompted, and send the email to the address that MRM automatically
entered.

@ If emails are sent from the server, your email client will not open and allow you to
customize the notification. For information on sending emails from the server, refer to
the “Send Email from the Server” section of the “Reservation Database Configuration”
chapter.

Editing Scenarios Which Affect Service Orders

While reservations which contain service orders can be edited in the same ways as
reservations without service orders, some edits affect service orders. The following is a list
of the editing scenarios which affect service orders and their results:

Edit a Service Order: If the service order has already been confirmed by a service
administrator like Juliette, its status is Processing. When it is modified, its status is
changed to Pending and it requires a service administrator's confirmation once again. If
the service order is still Pending when it is modified, the order is simply updated in the
system.

Add a Resource: When you add a resource to a reservation which contains one other
resource with service order(s), you are prompted to copy the service order(s) or cancel. If
you cancel, the service order(s) are not copied.
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When you add a resource to a reservation which contains multiple other resources, you
are prompted to copy the current resource's service order(s) or cancel. The current
resource is the one who's tab is currently selected.

Copy / Cut / Paste to a New Resource: When you cut / copy / paste a reservation from
one resource to another in the reservation grid, you are prompted to copy the original
resource's order(s) or cancel.

All Scenarios: When an order is copied to a new resource, not all items may be available
or priced the same. Items which fall into either category are not included in the copied
order. If these cases occur, a prompt displays recommending that you check the copied
order.

Copying a Reservation | Charlie

1. Hold the mouse over the reservation you wish to copy. Select Copy.

2. Move your mouse to the time, date, and room title on the grid where the copied
reservation should be placed. Click on this space.

Recurring reservations are copied / pasted as a single non-recurring reservation.

Multiple resource reservations are copy / pasted as single, not multiple-resource
reservations. For more information about multiple resource reservations, refer to the
“Multiple Resource Reservations” section of this chapter.

If the pasted reservation contains service orders, you are prompted to click OK to
copy them to the new resource or click Cancel to ignore them. If items in the order(s)
are not available in the new resource or their price is different, you are prompted that
the order(s) were not entirely copied. You are given the choice to review the order
(open the Reservation form) by clicking OK or to ignore the difference by clicking
Cancel.

3. To make changes to the pasted reservation and send notifications, simply click on the
newly pasted meeting to open the corresponding Reservation form.

4. When you are satisfied with your specifications, click Save and Close to save your
changes and schedule the reservation.
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5.

Cutting and Pasting a Reservation | charlie

1.
2.
3.
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Depending upon your database’s options settings and the details you have added or
edited, you may be prompted to send a notification email to attendees or the head of
arequirements department.

Click Yes and send the email to the address that MRM automatically enters for you.

Your email client will not open to allow you to customize the notification if emails
are sent from the server. For information on sending emails from the server, see the
“Send Email from the Server” section of the “Reservation Database Configuration”
chapter.

Hold the mouse over the reservation you wish to cut and paste.
A menu appears. Select Cut.

Move your mouse to the time, date, and room title on the grid where the cut
reservation should be placed. Click on the space to paste the reservation.

Recurring reservations are cut / pasted as a single non-recurring reservation; only
the occurrence selected is changed.

Multiple resource reservations are cut / pasted as single reservations. Only the
selected reservation is updated. If you wish to update all reservations involved in a
multi-resource reservation, do not use the cut / paste feature. Instead, follow the
instructions provided in the “Multiple Resource Reservations” section of this chapter.
For more information about multiple resource reservations, also see the “Multiple
Resource Reservations” section of this chapter

If the pasted reservation contains service orders, you are prompted to click OK to
copy them to the new resource or click Cancel to ignore them. If items in the order(s)
are not available in the new resource or their price is different, you are prompted that
the order(s) were not entirely copied. You are given the choice to review the order
(open the Reservation form) by clicking OK or to ignore the difference by clicking
Cancel.

To make changes to the pasted reservation and send notifications, simply click on the
newly pasted meeting to open the corresponding Reservation form.
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5. When you are satisfied with your specifications, click Save and Close to save your
changes and schedule the reservation.

6. Depending upon your database’s options settings and the details you have added or
edited, you may be prompted to send a notification email to attendees or the head of
arequirements department.

Click Yes when prompted, and send the email to the address that MRM automatically
enters for you.

If emails are sent from the server, your email client will not open and allow you to
customize the notification. For information on sending emails from the server, see
“Send Email from the Server” section of the “Reservation Database Configuration”
chapter.

Delegating a Reservation | Charlie

In MRM, reservations can be delegated to a user who may act on the behalf of the
reservation’s organizer. When acting as a delegate, this user is granted the permissions of
the meeting’s organizer.

In the Reservation form, you can assign a delegate for the specific reservation. If many
reservations are involved, delegates can be assigned directly to a username. This
automatically makes the user a delegate for the organizer’s reservations during the
designated time period. Because delegate settings in the Reservation form supersede all
other settings, it is possible to remove the delegate from a specific reservation as
required.

To add a delegate to your username, see the “Edit Your User Profile” section of the
“Security” chapter.

Administrators like Kate may add a delegate to a username. See the “Usernames” section
of the “Security” chapter for details.

To delegate a specific reservation to another user:

1. Open the reservation.
2. Select the Delegates tab and click Add New Delegate.
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5.

Deleting a Reservation | Charlie

. The Delegate User List opens. Navigate to the user you are selecting as your

delegate.

By default, the Delegate User List displays entries whose first names begin with
the letter A. To display entries beginning with other letters of the alphabet, use the
letters across the top of the form. To display all entries, click the All Users tab.

Click the box next to the user you wish to delegate this meeting to. and click Add
User. The selected user is added to the reservation’s list of delegates.

If you wish to remove the delegate, click Remove next to the delegate’s username.

Click Save and Close to save your changes.

Deleting a reservation is permanent.

1.

2,
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Click on the reservation you wish to delete either from the grid or the results of a
reservation search.

If the reservation you wish to delete is part of a recurring series or a multiple-resource

reservation, select the appropriate option from the list when prompted:

« Open Single Reservation
This opens the single instance that you have clicked on. Even if this reservation
belongs to a series or a multiple resource reservation, only the selected instance is
opened.

« Open Series

This opens all instances of this recurring reservation. Even if the reservation is also a
multiple resource reservation, only the recurrences that apply to the selected
instance’s resource are opened.

Open Multiple Resource

This opens the selected instance for all resources involved in the multiple resource
reservation. Even if the reservation is also a recurring reservation, only the selected
instance is opened for the multiple resources involved.

Open Multiple Resource and Series
This opens all instances for all resources involved in this reservation.
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3. The Reservation form opens. Click Delete.
4. |If the reservation you wish to delete is part of a recurring series or a multiple-resource
reservation, select the appropriate option from the list again when prompted:
+ Delete Reservation (same as ‘Single Reservation’)
This applies to the single instance that you have open at the moment. It applies to
this instance of the recurrences if there are any, and this resource only, even if the
reservation is for multiple resources.
+ Delete Series
This applies to all instances of the recurring reservation. If the reservation is a
multiple resource recurring reservation, it does not apply to instances of this
recurring reservation which belong to another resource.

Delete All (related reservations)

This applies to all instances of this recurring multiple resource reservation. It applies
to all recurrences that belong to all resources for this reservation.

5. Click OK.

6. Depending upon your database’s options settings and the details that were included
in the reservation you deleted, you may be prompted to send a notification email to
attendees or the head of a requirements department.

Click Yes and send the email to the address that MRM automatically enters for you.

If emails are sent from the server, your email client will not open and allow you to
customize the natification.
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CHAPTER 9 Attendees

Attendees Overview | Kate

The Attendees tab of the Reservation form in MRM allows users to add attendees to their
meetings. Attendees can be added manually or from the MRM Address Book, Outlook
Address Book, or Lotus Notes Address Book. In addition to adding attendees to your
reservations, you can also send emails containing reservation details and Outlook
Invitations from this tab.

Integration with Outlook

MRM lets users to utilize some of the features in Microsoft Outlook to communicate with
attendees.
« The Outlook Address Book can be utilized to select attendees for meetings.
See the “Outlook Address Book” section of this chapter.
« Outlook Invitations can be sent to notify attendees of a meeting.
See the “Outlook Invitations” section of this chapter.

- Attendee Availability can be checked for those attendees sharing your exchange
server.

See the “Outlook Invitations” section of this chapter.

+ The Meeting Change Email and Cancellation Email each contain a link which, when
clicked by the recipient, automatically updates the recipient’s Outlook calendar.
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When users modify or cancel a reservation, they are automatically prompted to
send these notification emails. The links which update the recipient’s Outlook
calendar can be removed by modifying the email templates. See the “Email
Messages Tab” section of the “Reservation Database” chapter for details.

Reservations can be created, edited, and deleted using Microsoft Outlook. Refer to
“The MRM Plug-In for Microsoft Outlook” chapter for details.

MRM Address Book | Kate Charlie

The MRM Address Book is the address book feature that can be used if a MAPI compliant
email program other than Outlook or Lotus Notes is installed, or if no address book
currently exists. It is hosted by the MRM server, so this book can be accessed by any user
even if they do not have an email system installed on the workstation they are using.

Modifying the MRM Address Book

It is recommended that when you are editing the MRM Address Book that you do so
from a blank Reservation form.

To add or edit entries manually in the MRM Address book:

1. Inthe Reservation form on the Attendees tab, click the MRM Addr icon.
The MRM Address Book opens.

By default, the MRM Address Book displays entries whose first names begin with
the letter A. Use the letters across the top of the form to display entries beginning with
other letters of the alphabet.

2. To:
+ Add a new contact, click New Entry.

- To edit an existing contact, click Edit.

3. The Address Detail form opens. Enter or change contact details on the General,
Personal, and Notes tabs as required.

4. Click Save and Close.
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Deleting an MRM Address Book Contact

1.

In the Reservation form on the Attendees tab, click the MRM Addr icon.
The MRM Address Book opens.

By default, the MRM Address Book displays entries whose first names begin with
the letter A. Use the letters across the top of the form to display entries beginning with
other letters of the alphabet.

2. Click Delete beside the information of the contact you wish to delete.
3. Click OK.

Selecting Attendees from the MRM Address Book

1.

In the Reservation form on the Attendees tab, click the MRM Addr icon.
The MRM Address Book form opens.
By default, the MRM Address Book displays entries whose first names begin with the

letter A. Use the letters across the top of the form to display entries beginning with
other letters of the alphabet.

Enter a name or partial name into the search field and click Search to find all matching
entries.

3. Click on a contact's name to add the individual to the attendee list.

4. Click Close in the MRM Address Book when complete.

Outlook Address Book | Charlie

MRM enables you to add attendees to your reservation directly from your local and global
Outlook address book lists.

The instructions in this section are based on Microsoft Outlook 2003. If you are using
other versions of Outlook, your steps may vary.

To select attendees from your Outlook Address Book:

1.

Q_yl Meeting Room Manager

In the Reservation form on the Attendees tab, click the Addr Book icon.
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When prompted to allow an ActiveX control to run, select Yes. If a Microsoft Outlook
security prompt appears, ensure 'Allow access for..."is checked, and click Yes.

If you receive the prompt that states “ActiveX component can't create object,” you
must adjust your ActiveX settings before proceeding. Refer to the “ActiveX Control
Setup for Outlook” section of this chapter for details.

In the Outlook Distribution List, click Select Members.

4. Select the contact list you wish to invite from, highlight the individual you wish to

invite, and then click Members.

5. Repeat for each individual you wish to invite, then click OK.

6. Click Save and Close.

Outlook Invitations | Charlie

Back in MRM, the individuals you selected are displayed in the list of attendees.

MRM can send an Outlook Invitation to attendees. This invitation, when accepted by the
recipient, is automatically booked into the recipient's Outlook calendar. In addition, if the
computer you are using is connected to a network running Microsoft Exchange Server,
you can view attendee availability in the Scheduling tab of the Outlook Invitation.

Preparing MRM to Send Outlook Invitations

The save rule which controls Outlook Invitations must be turned on in MRM before users
can send invitations through MRM.

To turn on the invitations save rule:

1. Loginto your MRM database as a user with administrative permissions

v d W N
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Click the Admin icon.
Select the Save Rules icon.
The save rules summary opens. Click the Invitation Check save rule.

The Invitation Check save rule’s detail form opens, displaying the rule’s properties.
Check the Active checkbox.

Click OK.
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7. Close the list of save rules. The rule is now active.

Now that you have completed this setup process, whenever a user saves a meeting with
attendees, he will be prompted to send an Outlook Invitation.

Check Attendee Availability and Send an Outlook Invitation

1. Once you have selected attendees and saved your reservation, you are prompted to
send an Outlook Invitation. Click Yes.

2. When prompted to allow an ActiveX control to run, select Yes. If a Microsoft Outlook
security prompt appears, ensure 'Allow access for..."is checked, and click Yes.
If you receive the prompt that states “ActiveX component can't create object,” you
must adjust your ActiveX settings before proceeding. See the “ActiveX Control Setup for
Outlook” section of this chapter for details.

3. The Outlook Invitation opens.

Information for the meeting is included where appropriate, along with a summary of
the meeting details in the body of the invitation.

The specifications for the Outlook Invitation including the subject and content
are all setin the Options Email Messages tab.

Additional attendees can be added to the meeting by adding their email
addresses to the Outlook Invitation. MRM automatically adds any added email
addresses to the list of attendees on the Attendees Tab of your reservation.

4. Attendee availability can be viewed by selecting the Scheduling tab.

This information is only available through Microsoft Exchange Server, and is not a
function of MRM.

5. Turn the Outlook iCalendar feature off by clicking Tools > Options, and then
unchecking the Send as iCalendar checkbox.

Turning off the iCalendar default is necessary specifically for Outlook versions
2002 (XP) and 2003 where use of the iCalendar is set to On by default.

To turn off the default setting which sends invitations as iCalendars, select Tools >
Options in Outlook. On the Preferences tab, click Calendar Options. A dialog box

o
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ActiveX Control Setup for Outlook | Charlie

opens. In the Advanced Options section, uncheck the When sending meeting
requests over the Internet, use iCalendar format option.

The Outlook Invitation is sent by clicking Send.

If a Microsoft Outlook security prompt appears, ensure ‘Allow access for... is checked,
and click Yes.

While attempting to access your Outlook Address Book from MRM, if your workstation's
ActiveX security control setting called “Initialize and Script ActiveX controls not marked as
safe” is set to Disable, you receive the VB Script error as follows:

“ActiveX component can't create object.”

To open your Outlook Address Book from intranet sites that you deem safe on a per-
use base:

1.
2.
3.

Notes Address Book | Charlie

Select Tools > Internet Options.
On the Security tab, with Local Intranet selected, click Custom Level.

Scroll down to the ActiveX controls and plug-ins heading, and underneath the
security control setting called Initialize Script ActiveX controls not marked as safe,
select Prompt.

The Lotus Notes Address book can be used to enter attendees into a reservation.

To select attendees from the Lotus Notes Address Book:

1.

In the Reservation form on the Attendee tab, select the Lotus Notes icon.

The Lotus Notes Address Book opens.

2. Click on a contact's name to add the individual to the attendee list.

3. Click Close in the Lotus Notes Address Book when complete.
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Overview of the MRM Plug-In for Microsoft Outlook | ALL

The Meeting Room Manager Enterprise Edition comes with a plug-in that enables you to
schedule the resources and services that are managed by MRM directly in Outlook.

Creating reservations through Outlook combines the strengths of MRM and Microsoft
Outlook:

+ MRM provides location and resource information, service item catalogues, and the
ability to check room availability and enforce inventory checking and security.

+ Microsoft Outlook provides the ability to create and send Outlook Invitations and
examine attendee availability for those who share an Exchange server.

Before you can create, modify, and delete MRM reservations through Microsoft Outlook,
the MRM Plug-In for Microsoft Outlook (the MRM plug-in) must be installed and
configured. While the MRM plug-in can be installed manually on each workstation or
automated with Group Policy, it must be configured individually on each workstation.

The MRM plug-in adds the MRM Reservation form to Outlook. This form contains the
standard Outlook Appointment and Scheduling tabs along with a new tab called Meeting
Room Manager. It is on the Meeting Room Manager tab that resources and services that
are managed by MRM can be scheduled in Outlook.

If you wish to create an appointment that does not reserve resources and services
managed by MRM, the MRM Reservation form will work exactly as the standard Outlook
Appointment form.

‘1 Meeting Room Manager ”
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Only the MRM reservations you have created using Microsoft Outlook can be edited and
deleted using Outlook.

Install the MRM Plug-in | Kate Charlie

The MRM plug-in needs to be installed on each workstation where Outlook will be used to
schedule resources and services that are managed by Meeting Room Manager.

There are two methods which can be used to install the MRM plug-in:

+ Automated Distribution: Administrators distribute the plug-in using Group Policy.

+ Manual Distribution: Administrators or users with administrative rights on their
workstations run the MRM plug-in setup file manually on each client machine.

You may use whichever method works best for you. In some cases, administrators may
use the automated method for machines on the domain but manually install the MRM
plug-in on machines that are not on to the domain.

Once the MRM plug-in is installed on a machine, it can be used by any user logged in to
the machine, not just the user who installed it.

Install the plug-in on all machines if the users will share calendars between
themselves (such as a delegate situation). If someone without the plug-in edits the
bookings of someone who used the plug-in, data can be unsynchronized between the
users and the database.

When opening Outlook for the first time after installing the MRM plug-in, this pop up
appears:

Meeting Room Manager

A new customized appointment Form, MRM Reseryvation, is now available in your Outlook calendar,
Do you wank ko set this new Form as the default appointment Form?

Select "Mo" if you are already using a third-party Form as the default appointment Form, and do not want it changed. You may
modify this setting anytime via the Calendar properties,
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« Click Yes to use the MRM form

+ Click No if you are using a third-party from (such as Cisco) and you do not want to
use the MRM form as the default form.To switch between forms:

Right-click on Calendar.
Click on Calendar Properties.

In the Calendar Properties dialog box, click on the General tab.

> W N R

In the When Posting to this Folder, use: field, click MRM Reservation to use the
MRM form or IPM Appointment to use other forms and click Save.

Automated Distribution: Install the MRM Plug-in Using Group Policy

Using Group Policy to install the MRM plug-in saves you time. It automatically distributes
the MRM plug-in to all computers on your domain, saving you the task of manual
installations. Once you set up Group Policy, the MRM plug-in installs silently on client
machines when users restart them.

Group Policy distribution can only be used with servers running Windows 2000 /
2003 Server with Active Directory in place.

The first step in setting up Group Policy distribution of the MRM plug-in creates the
distribution point. This involves copying the MRM plug-in setup file to the server for
sharing. The second step creates the Group Policy Object which assigns the distribution to
users in specific user groups. The third step assigns the distribution to computers on your
domain.

Once Group Policy is set up, the next time a selected user logs in to a computer or any
user logs in to a computer on your selected domain, the MRM plug-in is installed. The
installation is finalized the next time a user runs Microsoft Outlook.

Each of the three Group Policy setup steps is described in detail below.

Create the Distribution Point

Before you can assign the MRM plug-in to users and computers, you must first create its
distribution point on your server.

Step 1: Creating the MRM plug-in’s distribution point:

1. Login to the server with a user name which has administrative rights.

Q_)l Meeting Room Manager v
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2. Create the folder in which will hold your MRM plug-in installation file.

This folder must be located on your shared network.

3. Set permissions on your shared network to allow all users to access the folder you just
created.

Log into MRM.

Click Edit User Profile.

The User Details form appears. Click the Download MRM plug-in for Outlook icon.
Click Save.

The Save As dialog box opens. Save the file, named MRMOutlook.msi, to the folder
you created in step 2.

® N o w &

This file path is now called the distribution point. An example of the distribution point
is: \\my server name\share folder name\MRMOutlook.msi.
Step 2: Create the Group Policy Object

Now that you have created the distribution point, you can assign the distribution to users
in specific user groups. To do this, you will create a Group Policy object.

1. Login to the server with a user name which has administrative rights.

2. Select Start > All Programs > Administrative Tools > Active Directory Users and
Computers.

The Active Directory Users and Computers window appears.

3. Inthe hierarchy on the left side of the screen, navigate to your domain. Right-click on
it and click Properties.

4. The Properties form opens. Click the Group Policy tab, highlight Microsoft Outlook,
and click New.

5. Enter MRMOutlook as the name for this new policy, and click Enter.
6. Select Microsoft Outlook, click Properties, and click the Security tab.

By default, the Group Policy applies to all authenticated users, as is indicated in this
tab. You can exclude a group or user from Group Policy by adding it to the list on this
tab and specifying Apply Group Policy Deny permissions for it.

7. Click OK.
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Step 3: Assign the Package

Now that you have created the distribution point and the Group Policy object, you can
assign the distribution to computers on your domain.

1. Login to the server with a user name which has administrative rights.

2, Select Start > All Programs > Administrative Tools > Active Directory Users and
Computers.

The Active Directory Users and Computers window appears.

3. Inthe hierarchy on the left side of the screen, navigate to your domain. Right-click on
it and click Properties.

4. In domain’s Properties form opens. Click the Group Policy tab, highlight Microsoft
Outlook, and click Edit.

5. Under Computer Configuration, expand Software settings.
6. Right-click on Software Installation, and select New > Package.
7. Inthe form that opens, type in the full path and file name of the distribution point.

The Universal Naming Convention (UNC) path must be used. For example:

\\my server name\share folder name\MRMOutlook.msi

Do not browse to the file path. The full UNC file path must be used.
8. Click Open.
9. Select the Assigned deployment method and click OK.

The package is now listed on the right side of the Group Policy form.

You have now completed the Group Policy setup process. The MRM plug-in will be
automatically distributed to users and workstations as you specified.

Before your users can use the MRM plug-in, they must configure it to communicate with
the MRM server. Provide the configuration instructions, found in the “Configure the MRM
Plug-In" section of this chapter, to your users.

If your workstations which are running Microsoft Windows XP have the Fast Logon
Optimization feature turned on, two restarts are necessary to install the MRM plug-in. This
feature is turned on by default.

Q_)l Meeting Room Manager "
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Manual Distribution: Install MRM Plug-in Manually

If you do not wish to use Group Policy to distribute the MRM plug-in, or if some users or
computers were not included in the Group Policy distribution, you may install the MRM
plug-in manually.

To manually install the MRM plug-in:

1.

vk W N

Close Microsoft Outlook

Log in to MRM.

Click the Edit User Profile icon at the top right of the main screen.

The User Details form opens. Click the Download MRM plug-in for Outlook icon.
Select Run.

You may be prompted a second time to run the software in a security warning. If so,
select Run a second time.

6. The Welcome and Confirm Installation screen appears.

7. Inthe following screen, select the location where you wish to install the plug-in, and

9.

10.

click Next.

The default location is C:\Program Files\NetSimplicity\MRMOutlook.
In the screen that follows, click Next to start the installation.

A status bar indicates the progress of the installation.

In the screen that follows, click Next.

The wizard indicates that the installation is complete. Click Close.

Before your users can use the MRM plug-in, they must configure it to communicate with
the MRM server. Provide the configuration instructions, found in the “Configure the MRM
Plug-In" section of this chapter, to your users.
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Setting the Default Location | Kate Charlie

A user’s default location setting indicates his time zone. In order to accurately schedule
reservations and view room availability, each user’s time zone must be accurate. The
default location setting should therefore be set to the location at which the user is
situated.

Because this setting is set in the MRM web client, administrators should set it on the
behalf of users who will only be using Microsoft Outlook to schedule MRM reservations.
Administrators may also choose to give Outlook® users access to the MRM web client to
set up their own default location.

Users who use both Outlook and the MRM web client to schedule reservations can adjust
this setting for themselves.

This setting also determines which resources are first displayed on the reservation
grid in the MRM Reservation form in Outlook.

The following instructions describe only how to adjust the default location setting.
Further information about user settings can be found in the “Usernames” section of the
“Security” chapter.

Adjusting Another User’s Default Location

Log into the MRM web client with a username which has administrative rights.
Click the Admin icon, then the Users icon.

Click the name of the user whose default setting you wish to adjust.

Uncheck the User Must Edit Profile At Next Logon Instance checkbox.

In the Set User Default Location field, select the user’s default location.
Check the User Must Edit Profile At Next Logon Instance checkbox.

Click OK.

N oo »s»WNRE
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Adjust ing Your Default Location

1. Log into the MRM web client.

2. Click the Edit User Profile icon at the top right of the main screen.

3. Inthe Set User Default Location field, select your new default location.
4, Click OK.
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Configuring the MRM Plug-In | Charlie

Configuring the MRM Plug-In for a Secure HTTP Connection

If you use a secure HTTP connection (https) with MRM, the MRM plug-in must be
configured to use the secure connection as well. Each user who uses Microsoft Outlook to
schedule MRM reservations must configure the MRM plug-in on his desktop so that the
secure HTTP connection can be used.

To configure the MRM plug-in for a secure HTTP connection:

1.

ok W

o

In your web browser, run the MRM web client. The URL is comprised of your web
server name and virtual directory name.

For example: https://webserver1/MRM7/

The Security Alert screen appears. Click View Certificate.
The certificate information form appears. Click Install Certificate.
The welcome screen appears, Read it and click Next.

The Certificate Store screen appears. Choose the Automatically select the certificate
store based on the type of certificate radio button and click Next.

The settings you have chosen are displayed. Click Finish.

If the security certificate was successfully imported, a prompt indicates that the
import was successful.

8. The original certificate information form displays. Click OK.

9. The original Security Alert form appear. Click Yes.

10.

Follow the instructions in the “Connect the MRM Plug-In to the MRM Database” section
of this chapter to finish configuring the MRM plug-in.

Connecting the MRM Plug-In to the MRM Database

Each user must configure the MRM plug-in to connect to the MRM server once it has been
installed on his workstation. This connection is unique to the user. If another user works
on the same workstation, she must set up her own connection to the MRM server.
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If your MRM server is configured to use the https protocol, follow the instructions in
the “Configure the MRM Plug-In for HTTPS” section of this chapter before proceeding with
the instructions provided in this section.

To configure the MRM plug-in to connect to your MRM server:

1. Open Microsoft Outlook.

2. A prompt opens and indicates that a new customized appointment form is now
available in your Outlook calendar. It asks if you wish to make this the default
appointment form. Click Yes.

3. The new MRM toolbar displays at the top of the screen with the standard Outlook
toolbars. Click on it, and then click the Settings option.

4. Inthe MRM Login Information screen that opens, enter the URL for your MRM server in
the following format:

http://<server name>/<virtual directory name>/

Example: http://acmeserver/mrm7/

If you are uncertain what the name of the server hosting MRM is, ask your MRM
administrator.

If you have configured your MRM plug-in for a secure HTTP connection, replace
http with https in this step.

5. Click Test.
« If the MRM server information is valid, a prompt confirms this.

« If you are prompted that it is invalid, correct the URL and test it again until it is
successful.

6. The validation test you just performed connected to your MRM server and checked
authentication settings.

« If your MRM server is using Windows authentication, the username and password
fields are now greyed out. Your username and permissions are determined by your
Windows username. Your full name and email address are gathered from the first
listed email account in your installation of Microsoft Outlook.
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« If your MRM server is using MRM authentication, the username and password fields
remain editable. Enter the username and password that you use to log into the
MRM database.

7. Check the Remember Username and Password checkbox.
If you leave the box unchecked, you will be prompted to enter this information
again each time the MRM plug-in attempts to connect to the MRM server.
8. Click OK.
If you wish to edit your user profile, which includes your email address, log in to MRM
and click the Edit User Profile icon. Refer to the “Run Meeting Room Manager” and “Edit
Your User Profile” sections for details.
Refreshing field data

Everytime you start Outlook, it checks mapped fields and their data, updates them and
adds any new fields created since the last time it was started. If you want to be sure the
fields are up to date, in Outlook’s Meeting Room Manager tab, click Refresh Fields.

|| Calendar - Microsoft Outlook
I Fle Edit View Go Tools Actions  Help

i EHNew - | 4 i g4 | Today | [T]Day | 5]Wwork week | (7] week

‘| Meeting Rgom Manager * | =

ﬁ; Appaintment
Refresh fields

Settings

Monday, July 14

Help
About MRM Plug-In
02122232435 47

Refreshing can take up to 20 seconds depending on the network connection or the
number of mapped fields and the size of their associated data.
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Preventing automatic refreshing of mapped field data

By default, when the client’s Outlook plug-in starts, it automatically connects to the
server. If the mapped field data has changed since it was last started, the plug-in’s
mapped fields are refreshed. If there are many fields and they are associated with large
databases, this refreshing can take a long time and tie up the network.

To turn off this automatic refreshing, add a new setting field to the MRM project options.
After this is done, clients who need refreshed fields can refresh them as shown in
“Refreshing field data” on page 167.

While the refreshing is taking place, this status bar appears:

P =

- MRM-Outlock Connection Status [= [ & |3

LConneching to Meeting Hoom Manager server.
Authonizing....

To turn Outlook’s automatic field refreshing on or off:

1. Open your reservation database with either Microsoft SQL Server Enterprise Manager
or Management Studio.

2. Inthe Options table, add a new record:
+ In the Setting field, enter: OutlookPreventRefreshOnStartUp.

+ In the Value field:
« To turn off automatic refreshing, enter 1=True.
- To turn on automatic refreshing, enter 0=False (default value).
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Creating an MRM Reservation in Outlook | Charlie

In order to use Microsoft Outlook to book resources and services that are managed by
MRM, the MRM plug-in must first be installed and configured as described in the previous
sections of this chapter.

MRM security constraints are maintained in Outlook. If you do not have permission
to schedule resources in a specific location in MRM, the resources at that location are not
available to be selected in Outlook. If you have permission to book specific services, such
as catering or equipment, these can be booked along with your MRM reservation in
Outlook.

To create an MRM reservation in Microsoft Outlook:

1.

In the Microsoft Outlook calendar view, click on the MRM toolbar and then click
Appointment. The MRM Reservation form opens.

If you chose to use the MRM Reservation form as the default form when you first ran
the MRM plug-in, you can also open the MRM Reservation form by:

+ In Outlook, select New>Appointment.
« In your Outlook calendar, click on a time slot.

2. Onthe Appointment tab, enter the reservation’s title in the Subject field.

3. Select the start and end time for your reservation.

Q_al Meeting Room Manager

Leave the Location field blank as MRM will auto-fill it once you have selected the
resource(s) you wish to schedule.

Click the Meeting Room Manager tab.

The status box briefly displays while connecting to your MRM server, and then the list
of resources displays.

All of the locations you have permissions to view are available in the location tree.
Your default location is selected and the resources at your location display in the
reservation grid below.

If you wish to add preparation and cleanup time to your reservation, enter the time in
minutes into the Prep Time and Cleanup Time fields.
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6. Check the reservation grid for the availability of the resource(s) you wish to book.
The time range of your reservation is highlighted in the reservation grid for easy
visibility into each resource’s availability.

The checkboxes next to available resources are blank, while the checkboxes next to
unavailable resources are marked with an X.
+ To add or remove resources from view in the reservation grid:

+ Check and uncheck the boxes next to locations in the location tree. Only
resources belonging to checked locations are shown in the reservation grid.

+ Narrow the list by showing only resources with specific attributes. To do this,
select a filter from the Select Room Attributes field and click Find Rooms. You
can remove the filter by clearing the field and clicking the Find Rooms again.

Filters can be added, modified, and deleted by MRM administrators. For
details, refer to the “Add a Filter" section of the “Filters” chapter.

« To view a resource’s details before selecting it for your reservation, right-click on the
resource’s name in the grid.

The resource’s details open in a new window. Exit from the resource’s details and
return to the reservation by clicking Close.

« To adjust the time of your reservation to accommodate resource availability, do so
in the Start Time and End Time fields above the list of resources.

7. Check the box next to the resource(s) you wish to book.

Selected resources are shown as a tab in the lower frame.

8. If you wish to add service requests, follow the steps provided in the following section,
“Request Services in Outlook”.

9. If you wish to invite attendees, click the Scheduling tab and enter attendees’ email
addresses to the list. If the attendees are connected to your Microsoft Exchange
server, their availability is visible.

10. To make comments about this meeting or add details about the service required,
enter it into the Notes field.

11.Click Save and Close to save the reservation, or if attendees were selected, click Send
to save the reservation and send the Outlook Invitation to attendees.
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If you see a striped box around your meeting when viewed in outlook, it shows your

meeting is on the wait list (see “Wait List” for details). You can either move the meeting to
a new location or time or wait to see if the room or resource you want becomes available.

Creating a private meeting

The MRM plug-in supports Outlook’s private meeting feature. A private meeting on the
MRM grid is labeled as private. It can only be opened by the person making the booking
or those with permission to see them.

The delegate function is not supported for private meetings.

1. Open the MRM reservation form.

2. Check the Private checkbox to make a meeting private or uncheck it to make it
public.

3. Fillout out the rest of the form as needed and click Save.

When searching, private meetings you do not have rights to see are not displayed.
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Delegating meetings with the MRM Plug-In

You can schedule meetings in other people’s calendar with the MRM plug-in. Its delegate
function supports Outlook 2003 or 2007 shared calendars function.

Installation

Before creating, modifying or deleting meetings in shared calendars:

1. We recommend everyone using shared calendars and their delegates have the plug-
in installed on their machine.

If this is not done, data can become unsynchronized between the Outlook
calendars and the database.

Delegates without the plug-in should have their permission level set to Author or
lower. They can see meetings and the attendees but they cannot create, edit or delete
bookings. The MRM tab will not appear in their Outlook window.

2. Allshared calendars which use the same exchange server must use the same
database.

Adding delegates
Before someone can book meetings in your calendar, you have to make them a delegate.

1. Open your calendar.
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2. Select Tools>Options.

The Options dialog box appears.

Options

Preferences | Mail Setup | Mail Format || Spelling || Security | Other | Delegates [__

Delegates

0 Delegates can send items on your behalf, To grant permission to

vy others to access your Folders without also giving them
send-on-behalf-of privileges, go to the Properties dialog box for each
folder and change the options on the Permissions tab,

Add...

Ok Cancel

3. Click the Delegates tab and click Add.
The Add Users dialog box appears.

4. Select the user(s) you want to be delegates for your bookings, set their permission
levels, and click OK.

Booking as a delegate

To book a meeting in someone else’s calendar, open and book it as you would with your
own calendar. All the MRM functions are the same.
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You can only book the MRM resouces and services you have permissions for. These

permissions are not delegated.

« You cannot open an appointment in your own or someone else’s calendar.
+ You cannot book a meeting in your own or someone else’s calendar.

+ The prompt: The reservation is being opened on another computer. The form
will be closed. appears.

That calendar is being used by someone else. Wait and try again.

If you have invited yourself to a meeting you booked as a delegate, and want the meeting
details in your calendar, when the Would you like to update your calendar now?
prompt appears, click No.

Working offline

The plug-in stops you from creating a new booking or changing an existing booking if
you are offline or not connected to the MRM server.

Bookings made or changed when you are offline can result in database mis-
synchronization. This appears as bookings visible on the screen not being stored in the
database, the opposite, or other problems.

To learn if you are working offline:

« In the browser’s status bar, Offline is displayed.
« Clickontheplug-in'sMRMtab.IfOutlookis offline,Outlookis Offline appears.

You can use Outlook to book new appointments or change existing ones, but if you try to
use MRM to make, change or see bookings, the MRM meetings cannot be modified
while Outlook is offline prompt appears.
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Requesting Services in Outlook | Charlie

The Services Management module in MRM enables administrators to integrate services
into the reservation process. These services can be anything that your organization offers
in conjunction with reservations, such as catering and presentation equipment.

For an in-depth summary of the capabilities of the Services Management module, setup
instructions, and a description of the order process, refer to the “Services Management
Module” chapter. It is recommended that administrators read the chapter and fully
understand the module before granting users with rights to create service requests.

Once your organization’s services have been set up in MRM, orders for service items can
be placed within MRM reservations in Outlook.

To request service items in an MRM reservation in Outlook:

1. Prepare your MRM reservation in Outlook by following steps 1 through 7 of the
previous section of this chapter, “Create an MRM Reservation Using Outlook.”

2, Click the Add Requirements for Selected Rooms icon at the bottom of the Meeting
Room Manager tab.

The Add Room frame minimizes to the top of the form and the Add Requirements for
Selected Rooms frame below opens to display available services.

Each resource has its own set of buttons for services that are available to be ordered
with the resource.

3. Select the tab of the resource you wish to add a service order to, and then click the
Services button of your choice.

The catalogue of service items displays on the left and the order details area displays
on the right.
4. Browse the catalogue to locate an item to add to your order.

« Click the categories and subcategories to display their service items.

« Right-click on the service item you are considering ordering. A brief description and
dollar amount display.

« To select the item, left-click on it. The item is added to the order details on the right
side of the tab. Your order’s total cost refreshes.
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5. To adjust the quantity of the item you selected, click in the Qty column beside the
item and edit the value.

The order total refreshes automatically.

6. To adjust the delivery time of the item you selected, click in the Time column next to
the item and adjust the time.

If you wish to have several items arrive at the same time, adjust the Time field
above the order details before selecting the items. The delivery time of each
successive item defaults to this value.

7. Repeat steps 4 through 6 for each item you wish to order.

8. Repeat steps 3 through 7 for each additional service and resource you wish to order
for this meeting.

9. Click Save and Close to save your reservation and place your service order.

If you are using Internet Explorer and you want to print MRM’s background colors
and images:

1. InIE select Tools>Options>Advanced.
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2. Check Print background colors and images.

Internet Options @@

General || Security || Privacy | Content || Connections | Programs Advanced

Settings

Flay animations in webpages* ~
Flay sounds in webpages

] show image download placehalders

Show pictures

Smart image dithering

Editing an MRM Reservation in Outlook | Charlie

MRM reservations created in Outlook can be fully edited in Outlook. MRM can be used to
modify resource selection and service orders for these meetings, but changes to the
meeting’s date, time, and title should be made using Outlook.
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Quick Changes in the Outlook Calendar

The date, time, and title of a reservation can be adjusted quickly in the Outlook calendar,
while further details can be adjusted once the reservation is opened.

+ To adjust the date and time of a reservation in the Outlook calendar, drag and drop
the reservation to its new date and time.

« To adjust a reservation’s title in the Outlook calendar, single-click on the reservation,
update the title, and then hit Enter on your keyboard or click outside the reservation
to save the new title.

If you are making these quick changes to a single occurrence of a recurring reservation,
the quick changes only apply to the single occurrence.

These quick changes do not generate a prompt to send an email update to attendees.
Instead, the update can be sent manually if necessary, by opening the reservation and
clicking Send Update.

Detailed Changes in the MRM Reservation Form
To edit reservation details using the MRM Reservation form in Outlook:

1. Inthe Outlook calendar, double-click on the reservation you wish to edit.

2. If the reservation you wish to edit is part of a recurring reservation, select the
appropriate option from the list when prompted:

- Open this occurrence: This opens the single occurrence you have clicked on.

« Open the series: This opens the recurring reservation series. The reservation details
saved will apply to all occurrences, overwriting any prior changes to single
occurrences belonging to this series.

3. The MRM Reservation form opens. Edit the reservation as needed.

4. Click Save and Close to save your changes. To send an email update to attendees,
click Send Updates to save your changes and send the email update.

The changes you have made are updated both in Outlook and in the MRM database.

If the changes present a conflict with existing reservations for the selected resource(s),
you are notified and given the opportunity to resolve the conflict before the reservation is
saved and attendees are notified of your changes.
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Meeting Request Overview | Kate

Some organizations prefer to have staff or guests request a meeting room instead of
select their own for their meeting. Meeting Room Manager allows your organization to do
this using the Request Meeting form. Staff or guests simply go to this HTML page and
enter information which is sent to the Meeting Confirmation form. At this time, an MRM
administrator may assign an appropriate room to the meeting and notify the person who
sent the request of where their meeting will be held.

Customize the Request Meeting Form | Kate

Before the global administrator customizes the Meeting Request form, two factors should
be taken into consideration.

Firstly, only fields that exist in the Reservation form are available to be placed on the
Meeting Request form. The properties that the fields on the Reservation form have also
apply to the Meeting Request form. Therefore, if there are fields that you wish to set as
mandatory, this property must be set in the Reservation form using the Form Designer.
Refer to the “Customizations” chapter for information on how to do this.

Secondly, remember that individuals using the Meeting Request form are strictly limited
to the fields that you give them. If you do not include a mandatory email or booked by
field, you cannot know who requested the meeting at all.
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To customize the Meeting Request form, follow the instructions below:
1. Click the Adminicon.
2. Click the Request Meeting icon.
The Request Meeting Form opens.
3. Click the Form Designer checkbox at the bottom left corner of the form.

4. The list of available fields opens. Those fields which are already on the form have a
check in the box to their left.

5. Check the box next to each of the fields you wish to have available for users to enter
information into.

When users click the TAB button on their keyboard, the cursor will move to the next
field in the order in which they were initially selected to be displayed on the form by
the person performing form design.

6. When you are ready to display your changes, click the Apply Changes button.

7. Allfields that you selected now display on the form, while those that were unselected
have been removed.

8. Use your mouse to drag the fields and their titles to the position you wish them to be
in on the form.

Field labels are moved separately from the field they belong to.

Post the Request Meeting Form | Kate

The Request Meeting form can be posted on your company intranet or your web site. You
simply need to place a link on an HTML page to the Request Meeting form. You may
choose give the URL to your staff members, who may add it as a shortcut to their desktop,
or as a favorite in Microsoft Internet Explorer.

The Request Meeting form URL is based on the following format:
http://<webserver>/<vdir>/MeetingRequest.aspx
<WebServer>Web server name / IP address

<vdir>Virtual Directory name, e.g. MRM7
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Request a Meeting | Bob

To request a meeting, follow the instructions below:

1.
2.

Confirm a Meeting Request

Click the link you have been provided to open the Request Meeting form.

Depending upon the settings your system administrator has arranged, you may be
required to log in to continue. For username and password information, consult your
system administrator.

In the Request Meeting form, enter the information for the meeting you wish to hold.

Some fields may be mandatory. If you do not fill in mandatory fields and click Send,
you receive a prompt telling you which field you have left blank that is required. Fill in
the field, and select Send.

As the meeting confirmation administrator, it is recommended that you check for
meeting requests fairly frequently and assign them to corresponding available resources.

Meeting requests can also be opened by an administrator and altered without being
assigned to a resource. This allows for service orders such as catering and equipment to
be added by an administrator before a resource is assigned.

To locate a meeting request, add meeting details, and assign it to a resource:

1.

o e
1

Click the Confirm icon.

The Confirmation form opens.

Select the location for which you wish to view requests.
Select the List requested meetings option.

The list of meeting requests displays. In the Status column, there are indicators that
mark each meeting request based on its status. See the icons and their corresponding
meanings below:

& Assigned: The corresponding meeting request has been assigned to a room by
an administrator. The assigned room is visible in the Resource Assigned column.
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@ Not Assigned: The corresponding meeting request has not yet been assigned to
aroom.

@ Processing: The corresponding meeting request is currently being assigned to a
room by an administrator.

Click on the name of the requested meeting to begin processing the meeting request.

If the requested meeting is being processed by another administrator, you are
prompted with a message which reads similarly to the following:

“This reservation request is already being processed by Luke since 7/7/2006 11:03 AM.
Do you wish to continue?”

It is recommended that you click Cancel and allow the other administrator to continue
processing the meeting request. However, a user’s session can time out while he has a
meeting request in process if his session remains idle for the allotted IIS time out
period which is 20 minutes by default. If by looking at the date and time that
processing began you believe that the user’s session timed out, you may wish to click
Open and process the meeting request yourself.

. The corresponding Reservation form opens. Information that was supplied by the

person who requested the meeting is already in the Reservation form.
Enter any further details for the reservation such as a catering or equipment order.

If you do not wish to assign this meeting request to a resource yet, click Save and
Close. The meeting request remains in the list of requests awaiting resource
assignment.

If you wish to assign this meeting request to a resource, check the box next to the
resource you wish to select. Only rooms at the location the requester selected are
listed in the Resources box.

Alternatively, click the Find Available Resources icon to list all rooms that are available
for this reservation, then select the room you wish to assign this meeting to.

Select Save and Close.

In the Confirmation form, click the Email icon to email the requester. You may need to
reference a contact email field on the corresponding Reservation form for this
person’s email address. Edit the email as necessary, and then click Send.
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Confirmation Overview

Confirmations are required by default for any reservation with requirements selected,
such as food or equipment requirements. Each requirements tab is treated as a different
department.

When a reservation with requirements is saved, the user is prompted to send out a
notification email to each department for which requirements have been selected. The
email is prepared by Meeting Room Manager according to the database’s options
settings. In addition to this email being sent, Meeting Room Manager lists the meeting in
the Confirmation form. It waits there to be confirmed. Each reservation’s status can be
quickly viewed in the grid because reservation color settings are based on confirmation
status.

Confirm Reservations

Confirmation is the act of marking a reservation as being confirmed. By default, any
reservation that has food or equipment requirements needs to be confirmed. Standard
setup includes a designated contact for each department who is responsible for
confirming reservations with requirements selected in the corresponding tab. The
responsibility involves checking to ensure that the requirements can be delivered, and
then confirming the reservation. To change the designated contact responsible for
confirmations, refer to “Form Design: Tab Properties” in the “Customizations” Chapter.
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To confirm one or more meetings:

1.
2.
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Click the Confirm icon.

The Meeting Confirmation form opens. Select your filter settings according to your
needs:

Location: Specify the location whose reservations you wish to view. To view all
locations, leave this field blank.

Department: From the pull-down menu, select the requirements department you
wish to view reservations for. To view all, select All Departments.

Meeting Title: To view reservations based on meeting title or a portion of it, enter the
title here. To view all, leave this field blank.

List All Meetings With Requirements: Select this option to view all meetings with
requirements, whether confirmed or not yet confirmed. This option cannot be
selected at the same time as the List Unconfirmed Meetings nor the List Requested
Meetings options.

List Unconfirmed Meetings: Select this option to view all meetings with
requirements that have not yet been confirmed. This option cannot be selected at the
same time as the List All Meetings With Requirements nor the List Requested
Meetings options.

List Requested Meetings: Select this option to view all requested meetings which
have not yet been assigned to a resource. This option cannot be selected at the same
time as the List All Meetings With Requirements nor the List Unconfirmed Meetings
options.

Group Recurring Meetings: Select this option to display the series as a whole instead
of one item for each occurrence. This means that when the one item is confirmed, all
occurrences of this meeting are considered confirmed.

Confirm by Department: Select this option to display one item for each department
for which requirements have been selected for a single reservation. This means that
until all of a reservation’s requirements have been confirmed by their respective
department, the reservation as a whole is not considered confirmed.
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Show Past Meeting: Select this option to show all unconfirmed reservations
including those that were scheduled to take place in the past and therefore have
already taken place.

3. Click the Email icon to the right of the reservation you wish to confirm to send a
notification of the reservation’s confirmation to the person who scheduled the
reservation.

4. The confirmation email opens in your workstation’s MAPI compliant mail client unless
emails are sent from the server. For details on sending emails from the server, refer to
the “Send Email From the Server” section of the “Reservation Database Configuration”
chapter.

Adjust the confirmation email as required, then click Send.

5. Back in Meeting Room Manager, check the confirmed box beside the reservation you
just sent the email confirmation for. Click the Confirm Selected button.

6. The reservation is now confirmed, the meeting’s color has changed in the grid to
represent the reservation type’s confirmed color, and the user who booked it has been
notified by email.
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CHAPTER 13 Wait List

Wait List Overview

A wait list entry is essentially a place in line for a resource and time that are already
booked. The wait list displays all wait list entries from the current time forward. Wait list
entries for a time that has passed are not listed.

Local administrators are responsible to manage wait list entries on an as-needed basis.
Because Meeting Room Manager automatically handles the regular workflow, the only
time a local administrator must manage the wait list is if he receives a special request from
a user. Users cannot view or edit wait list entries once they are first saved, so they require
the local administrator to make changes for them. Typically it is when a user gets an email
notification of their wait list entry’s status change that they contact their local
administrator for changes.

Enable the Wait List | Kate

In order to use the wait list features in Meeting Room Manager, you must enable them
with the following steps:

+ Turn on the wait list option
« Activate the wait list trigger
« Customize wait list email templates

Follow the instructions that follow for each of these three steps. Once you have
completed them, the wait list features will be ready for use.
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Turn On the Wait List Option
Follow the instructions below to turn on the wait list option:

1. Loginto Meeting Room Manager with a username which has administrative rights.

2. Click the Admin icon, and then the Options icon.

3. Inthe Options form that opens, click the Others tab.

4. Check the box beside Wait List.
Because the priority rights feature set requires the wait list to be used, the wait
list option is automatically enabled along with the priority rights option. To learn more

about priority rights, refer to the “Implement Priority Rights” section of the “Security”
chapter.

5. Click OK to save your options settings.

To learn about the other options that are available in the Options form, refer to the
“Options” section of the “Reservation Database Configuration” chapter.

Activate the Wait List Trigger

The wait list trigger checks resource availability and promotes wait list entries to
appropriate spaces that have become available.

It goes through each wait list entry in order based on the created date and time. This
ensures that wait list entries are pushed into an available space on a first come, first served
basis.

A reservation which was pushed to the wait list by a priority user maintains its
original created date.

Each time the trigger promotes a wait list entry, it sends the wait list assigned notification
email, based on the email’s template. Instructions on adjusting this template to suit your
needs are provided in the following section, “Customize Wait List Email Templates”.

Follow the instructions below to activate the wait list trigger:

1. Open the MRM Window Service Admin by selecting Start > All Programs > Meeting
Room Manager 7 > MRM Window Service Admin > Triggers tab.

2. Double-click the trigger called WaitList_Service.
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Click the Admin icon. The Admin console opens.
Click the Options icon.
In the Options form that opens, click the Email Messages tab.

From the email pull-down menu, select the template you wish to modify. The two that
are used by the wait list feature set are the Wait List Assigned Notification and the Wait
List Status.

The form refreshes to display the selected email template.

Modify the selected email template with the following fields:

« Field Reference: This reference field allows you to insert data that is specific to each
meeting or wait list entry. These references can be used in any of the customizable
fields within the Email Messages tab by clicking Insert.

For example, selecting <General/Meeting Title> displays the meeting title for
whichever meeting the email is about.

+ To: This field allows you to select whom the notification is sent to.

It is recommended that you use the default, <User Email Address>, as this sends the
email to the user who created the wait list entry.

« CC:This field allows you to type in an email address that all notifications of this kind
are to be sent to. For example, if one person is in charge of administrating wait list
entries, his or her email address can be entered in this area.

+ Subject: This field displays the email’s subject. It is recommended that you use the
<General/Meeting Title> reference field in the subject.

- Body: This field represents the body of the message that is sent out. It should be
generic for all types of meetings. Anything specific to a particular meeting should
be represented by a field reference. Keep in mind that all notifications can be
customized at the time they are sent.

. Once you are satisfied with the adjustments you have made to the email template,

click the OK button.

You are returned to the Admin console. To change the second wait list email template,
return to step three and repeat each step for the second template.
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View the Wait List _

You must belong to a user group whose Confirm Meetings permission is enabled in order
to view the wait list. This permission is set by location, so you can only see the wait list
entries for the location you have permissions to.

To view the wait list:
1. Click the Confirm icon.
2. From the Confirm Type pull-down menu, select Wait List.

The wait list entries are displayed in priority sequence according to the meeting start
time. All wait list entries from the current time forward are displayed. Entries for a time
that has passed are not listed.

Manage an Overridden Reservation

When a reservation is overridden, or bumped to the wait list, by a priority reservation, it is
up to the user to decide what she would like to do. If she wants action taken, and she is
using MRM Web, she must send a request to the local administrator who has permissions
to adjust her wait list entry. If she is using the MRM plug-in for Microsoft Outlook, then
she can make the changes herself.

The user has four choices:

+ No Action: Leave the wait list entry in line as it is.

This is typically done if the resource selected for the reservation is more important
than the time chosen.

+ Reassign: Contact the local administrator and ask him to reassign her wait list entry
to an available resource. The wait list entry then becomes a reservation.

This is typically done if the time selected for the reservation is more important than
the resource that was selected.

Though this allows the local administrator to choose the resource for the
reservation, all of the reservation’s details are kept.

- Reserve & Delete: Create a new reservation for an available resource and ask the
local administrator to delete her wait list entry.
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This is another way to handle the situation where the time selected for the
reservation is more important than the resource that was selected.
Though the user must enter all of the reservation’s details over again, this option
allows her to choose her own resource instead passing the choice to the local
administrator.

- Reserve & Keep: Create a new reservation for an available resource but leave her
wait list entry in line for the original resource.
This is typically done if the resource and time selected are equally important.
Then if the original resource becomes available, the user can choose to keep either
the original or the secondary choice and delete the other.

Reassigning an Entry
Wait list entries can be reassigned to a resource and therefore taken off the wait list. This
can only be done by users with the Confirm Meetings permission.

Once a wait list entry is reassigned to an available resource, it becomes a regular
reservation and is no longer in line for the original resource if it becomes available.

To reassign an entry:
1. Click the Confirm icon.
2. From the Confirm Type pull-down menu, select Wait List.

The list of wait list entries displays.

3. Click the meeting title of the wait list entry you wish to reassign.
The corresponding Reservation form opens.
Uncheck the box next to the wait list entry’s currently selected resource.

5. Select an available resource for the reservation.

You may wish to use the Find Available Resources button to search for an
available resource which matches your required criterion.

6. Click the Save and Close button.
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Delete an Entry

The only time a local administrator should reassign a wait list entry is if a user sends a
request for her wait list entry to be deleted.

Deletions are permanent. If the user changes her mind and wishes to be placed on the
wait list again, she loses her place in line for the time and resource.

Wait list entries can be deleted in two ways: from the wait list itself, or from the
corresponding Reservation form.
Delete Entry from Wait List
To delete a wait list entry directly from the wait list:
1. Click the Confirm icon.
2. From the Confirm Type pull-down menu, select Wait List.
The list of wait list entries displays.
3. Select the checkbox to the left of the wait list entry you wish to delete.
4. Click the Delete Wait List Entry button.
5. When prompted to confirm that you wish to delete the entry, click OK.
Delete Entry from Reservation Form
To delete a wait list entry from its corresponding Reservation form:
1. Click the Confirm icon.
2. From the Confirm Type pull-down menu, select Wait List.
The list of wait list entries displays.
3. Click the meeting title of the wait list entry you wish to reassign.

The corresponding Reservation form opens.

s

Click the Delete button.

"l

. When prompted to confirm that you wish to delete the reservation, click OK.
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Send Status Notice

Current status of a wait list entry can be emailed to the entry’s owner by an administrator.
To send a status notice:
1. Click the Confirmicon.
2. From the Confirm Type pull-down menu, select Wait List.
The list of wait list entries displays.

3. Select the Email icon to the right of the wait list entry you wish to send the status
notice for.

The email opens with the To address and body populated based on the email’s
template.

Email templates can be modified in project options. Refer to the “Options: Email
Messages Tab” section of the “Reservation Database Configuration” chapter.

4. Modify the email if you wish, then click the Send button.
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LCD Panel Overview | ALL

In order to run Meeting Room Manager on LCD panels, follow these steps:

« Step One: Install the LCD service pack on the MRM server.

+ Step Two: Set up the LCD panel hardware and log into your organization’s internal
network.

« Step Three: Connect each LCD panel to the MRM server and download the LCD
client components.

« Step Four: Configure each LCD panel through the MRM Administration Console.

Once all four steps have been completed, your organization’s LCD panels can be used to
view and book meetings through MRM.

Step One: MRM Server Service Pack Installation | ALL

The term MRM server refers to the web server which hosts Meeting Room Manager and
contains both the MRM installation files and your MRM database.

If MRM 6.3 or an earlier version of MRM 6 is already installed on your MRM server, you now
need to install the LCD installation files contained in the MRM service pack.

If you have installed MRM 6.5 or later, you already have the LCD installation files on your
MRM server.
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To install the LCD installation files on your MRM server, simply run the MRM service pack
from the NetSimplicity Support Site.

To install MRM from scratch, run the MRM full installation from the NetSimplicity Support
Site. The file is named ‘mrminstall.msi".

In order to access either of these files, log into the NetSimplicity Support Site. Log in at:

http://www.netsimplicity.com/support

Step Two: LCD Hardware Setup and Network Login | ALL

What You Need

The following is the list of the hardware you need to set up an LCD panel:
+  Your LCD computer panel unit

+ LCD panel stand or wall mount kit

+  Network cable to connect to your internal network

+ ACpower source

If you are mounting the LCD panel on a wall next to a meeting room, you may require
the assistance of your facilities team to provide the AC power source to the LCD panel.

Begin
1. Connect the LCD panel to an AC power source.

2. Connect the LCD panel to your internal network using a CAT9-5E network cable.

3. Boot up the LCD panel and log into Microsoft® Windows® with a username and
password which has administrative permissions to the panel and your internal
network.

4. In Microsoft® Windows?®, select Start > All Programs > Accessories > Accessibility > On-
screen Keyboard. The on-screen keyboard displays.

You are now ready to install the MRM LCD panel client components.
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Step Three: LCD Panel Client Components Installation | ALL

To connect to the MRM server from each LCD panel and install the LCD client
components:

1.
2.

On the LCD panel, run Microsoft Internet Explorer.

Using the touchscreen keyboard, connect to your MRM server using the following URL
format:

http://<server>/<virdir>/LCD/LCDPanelSetup/LCD Install Files.exe

Replace <server> with your web server’s name and <virdir> with the name of your
virtual directory.

This URL is also available within the Meeting Room Manager interface. To access
it there, sign into MRM as an administrator and then select Admin icon > LCD Panel
Displays icon > Setup tab. Click the label that reads “Download the LCD Panel Setup
EXE"

3. When prompted, run the LCD client components installer.

4. On theinstallation dialog that opens, click the Next button to begin the installation.

5. Inthe screen that follows, select your installation path for the LCD client components.

By default, this location is:
C:\Program Files\LCD
Enter the server URL in the following format:

http://<server>/<virdir>/LCD/LCD/meetingrooms.aspx

7. Click the Finished button. Installation is now complete.

8. Now that installation is complete, the MRM LCD client screen displays. The panel is

ol -
a

) Meeting Room Manager

ready for configuration.

If it does not display, reboot the LCD panel. When the LCD panel restarts, the
MRM LCD client screen displays by default.

@ Once the MRM LCD client components are installed on an LCD panel and no
hardware keyboard is in place, the panel’s use is limited to Meeting Room Manager.
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This ensures that the panel will only be used for its intended purpose: to display room
availability, not for surfing the web or checking email for example.

9. Repeat steps one through eight for each LCD panel you wish to use with MRM.
Step Four: Configure the LCD Panel

Once you have installed the LCD client components on your LCD panel, you are ready to
configure the panel.

To complete the LCD Panel Configuration Process:

1. Onan MRM workstation, signed in as an MRM administrator, click the Admin icon.
2. Inthe Administration console that opens, click the LCD Panel Displays icon.

3. Inthe Summary tab that opens by default, click the Add a Panel button to configure a
new panel or click on an existing panel’s name then the Edit button to edit an existing
panel.

4. The Setup tab opens. Enter the LCD panel’s details by following the instructions in the
Setup Tab section of this chapter.

5. Click on the Rooms tab and specify which rooms’ schedules you wish to display on the
LCD panel by following the instructions in the Rooms Tab section of this chapter.

6. Click on the Room Details tab and set up what details you wish to display on the LCD
panel by following the instructions in the Room Details Tab section of this chapter.

7. Click on the Schedule tab and configure the miscellaneous settings by following the
instructions in the Schedule Tab section of this chapter.

8. Now that all of the configurations settings have been configured, your LCD panel is
ready for use.

Summary Tab

The information contained in this section pertains to step three of the configuration
process outlined in the Configure the LCD Panel section of this chapter.

In step three of the panel configuration process, you arrive at the Summary tab. This tab
displays the names of each of the panels that have already been configured and displays a
summary of their details. Click on a panel’s name to reveal its summary.
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» To modify an existing panel, reveal its summary, then click the Edit button. Continue
on to step four of the panel configuration process.

« To add a new panel, first ensure that you have already installed the LCD client
components as described in the LCD Panel Client Components Installation section
of this chapter, then click the Add New Panel button. Continue on to step four of the
panel configuration process.

Setup Tab | ALL

The information contained in this section pertains to step four of the configuration
process outlined in the Configure the LCD Panel section of this chapter.

Fill in each of the fields with the information suited to the LCD panel you are configuring,
then click the Apply button to save the information.

The following is the list of fields which require your LCD panel’s information:
« MAC Address (In the format: XX-XX-XX-XX-XX-XX)
+ Panel Name
+ Host Name
« IP Address
+ Subnet Mask
« Default Gateway
« DNS

« Domain Name

If you aren't sure what to enter for any of these fields, contact your IT manager.

Rooms Tab | ALL

The information contained in this section pertains to step five of the configuration
process outlined in the Configure the LCD Panel section of this chapter.

The Rooms tab allows you to select which rooms’ schedules are displayed on the panel. It
contains two boxes, one called Available Rooms which lists all of the rooms which are
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available to display, and the other called Display Rooms which lists each of the rooms
which are displayed on the panel.

Only rooms within the same time zone can be displayed on one LCD panel. Time zones
are controlled by locations.

« To display a room, highlight it in the room in the Available Rooms box and click the
right pointing arrow to move it to the Display Rooms box.

» To remove a room from display, highlight it in the Display Rooms box and click the
left pointing arrow to move it back to the Available Rooms box.

When you are finished modifying the lists, click the Apply button to save your changes.

Room Details Tab | ALL

The information contained in this section pertains to step six of the configuration process
outlined in the Configure the LCD Panel section of this chapter.

The Room Details tab allows you to select the details you wish users of the LCD panel to
see when they select a room to view its details.

The Details box displays the information that is currently displayed for each room when
an LCD user selects a room to view its details. These room details elements are based on
the fields available on the Room Details form. These fields on the Room Details form can
be added, deleted, and modified by an MRM administrator using the form designer
feature in the Meeting Room Manager user interface.

+ To remove information from view on this LCD panel, simply delete the
corresponding text in the Details box.

+ To add information for LCD users to view, click the room data elements pull-down
menu and select the appropriate field. Then click the Insert button to insert this
field reference into the Details box.

Once the Details box has been configured to your satisfaction, click the Apply button.
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Schedule Tab | ALL

The information contained in this section pertains to step seven of the configuration
process outlined in the Configure the LCD Panel section of this chapter.

The Schedule tab contains several miscellaneous settings for your LCD panel. They are as
follows:

LCD Heading

Enter the heading you wish to display on the top right corner of the LCD panel. You may
wish to use the resource or department name that the panel is assigned to or a title that
indicates the location of the LCD panel, such as First Floor Reception, or Blue Room.

Booking Type

The Enable Anonymous Access checkbox allows you to grant or deny anonymous
reservations from being scheduled using an LCD panel.

Selected: When this checkbox is selected, LCD panel users are never asked for a
username and password, but are automatically granted full permissions to all
reservations regardless of whether or not Windows® authentication is in use.

Unselected: When this checkbox is unselected, each LCD panel user must enter an MRM
username and password before she can create or modify reservations regardless of
whether or not Windows® authentication is in use

When Windows® authentication is in use and a user connected to the network runs
Meeting Room Manager for the first time, her Windows username is added to the
MRM database as an MRM user and is assigned to the Default user group. Her
password, however, is not added to the MRM database. So if Windows® authentication
is in use but the Enable Anonymous Access checkbox is unselected, when the user
enters her username and password she will be denied access because no password
exists in the MRM database. Therefore, it is recommended that MRM administrators
add passwords to the MRM usernames which have been added automatically by the
Windows® authentication integration feature. The MRM administrator must then
provide each affected individual with his password and explain to him that the only

M
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time he will need to use his password is when he wishes to schedule a reservation in
MRM using an LCD panel.

It is recommended that if the Enable Anonymous Access checkbox is unselected
that the MRM administrator create a user group which does not have the Change
Others permission enabled. MRM users who need to schedule reservations using the
LCD panels can then be assigned to this user group.

Once you have made your selections on the Schedule tab, choose from the following:

« To save your changes for this panel, click the Apply button.

« To save your changes for all existing panels, click the Apply to All Panels button. This
applies all settings on this tab to each of the panels that you have already added
through the MRM Admin console. It does not apply to panels which have only
received the LCD client components.

«+ To cancel your changes, either select the Cancel button or move to a different tab
without clicking the Apply button.
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SunGard Banner Data Import Overview | Kate

Meeting Room Manager is equipped with the ability to import data from SunGard Banner
Unified Digital Campus, the world’s most widely used collegiate administrative software.

Course scheduling information can be imported from Sungard Banner directly into your
Meeting Room Manager database as uneditable data. The SunGard Banner system
remains the system of record for course schedules while the import into the MRM system
allows faculty and staff to reserve classrooms around daily course schedules.

The import of course data from SunGard Banner is typically performed once per semester,
but may be performed more frequently to reflect last-minute changes to the course
schedule.

Workflow

1. Inthe Resource form, create a new text field the end user will use to map the MRM
resource to the Banner classroom

2. Run the utility which prepares the MRM database for the import.

3. Map the MRM resources to the SunGard Banner resources, choose the import settings,
and run the import.
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Conflict Handling

When the import is run, any existing MRM reservations which conflict with the courses
imported from SunGard Banner are moved to the wait list and the meeting organizers are
notified. This maintains the priority of courses over other events.

When an SunGard Banner event which is already in the MRM database from a previous
import conflicts with a new SunGard Banner event, the old event is overwritten,
maintaining Sungard data integrity in MRM.

A log is created during the import which lists the conflicts and the action taken to resolve
them.

Display

Meeting Room Manager can be set to display data in the reservation grid at various time
increments. SunGard Banner events are displayed on the reservation grid in blocks that
most closely match the current MRM time increment, while the actual start and end times
shown on the reservation block are displayed exactly as defined in SunGard Banner.

The MRM reservation grid displays reservations in the colors which correspond with their
reservation types. Likewise, SunGard Banner events can be assigned a unique color to
distinguish them from MRM reservations.

Data Integrity Protection

If any errors occur while importing the data from SunGard Banner, the import is aborted
and the MRM database is returned to its previous state. Errors are recorded in the error log
for reference.

Creating a New Field | Kate

1. Onthe Resource form, create a new text field for the General tab with Form Designer.
2. Name this field Banner_MaplID.

3. Using the translation feature, give this field a name useful to the end users such as
“Assign Course to Classroom” or “Book Room for Course.”’
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4. Write instructions for the end users on how to correctly fill in this field so that the MRM
resource listings are properly mapped to Banner Classroom.

Import Process | Kate

The individual who imports SunGard Banner data must be a database administrator with
experience making database changes and running scripts.

Before importing, we strongly recommend you create a backup copy of your MRM
database. There is no undo operation for the importing process.

The two scripts you run during the import process are located in your MRM installation
folder. By default, this file path is:

C:\Program Files\Meeting Room Manager\setup\MRMImportFromSCTBanner\Scripts
To import SunGard Banner data into your MRM database:

1. Open your importing environment. This is the application you wish to use to run the
import scripts against your MRM database.

2. Run the script file “CreateTableAndView.sql” against your MRM database.

The script creates four tables in your MRM database. These tables act as a holding tank
for SCT Banner data during the mapping process.

3. Import your SunGard Banner data into the four tables created by the script you ran in
step two. These tables are:

RC_schedule_offering
RC_MEETING_TIME
RC_CourselmportParams

RC_classroom_xwalk
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4.

208

Now that your SunGard Banner data is held in your MRM database, map your SCT
Banner room IDs to your MRM room IDs.

Sungard Banner room IDs are now held in the RC_classroom_xwalk table. The
MRM_Code column in this table is equivelant to the Room_ID column which already
exists in the MRM database.

Use the following query to find an MRM resource’s room ID:

Select Room_id, [Meeting Room], Location_ID from rooms order by [Meeting Room]

. Once the SunGard Banner and MRM rooms are mapped to one another, you may

configure the parameters in the import script.

Open the ImportScripts.sqgl file and modify settings as required. Details are provided
below:

Preview or Import:

Here you may choose to preview your import or perform the import when you run
this script.

--Y: Preview all imported data but not import yet;

--N: Not preview all imported data but import all data to Reservation table with log
information

Set @lIsPreviewlmportData = 'N;

Error Log:

Here you may set the file path and name for the error log.
--@Error Log file path and name

Set @LogFilePath ='C:\"Program Files"\"Meeting Room Manager
7"\setup\MRMImportFromSCTBanner\Log\;

--Log file name
Set @ErrrorLogFileName ='BannerErrorFile’;

Set @LogFileName ='BannerLogFile’;
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Cell & Font Color:

Here you may set the chosen cell and font color to represent imported SCT Banner
events.

-- Cell color FontColor
Set @CellColor_ID =0;
Set @FontColor_ID =0;

Created and Modified User:

Here you may choose which user will be listed as the user who created and modified
SunGard Banner events. By default, this value is 1 for Administrator.

-- Created User and Modified User
Set @CreatedUser =1;
Set @ModifiedUser =1;

6. Once the import script parameters are adjusted as desired, run the script in preview
mode against your MRM database.

7. Once you are satisfied with your import preview, run the script in import mode
against your MRM database.

Your SunGard Banner events are now displayed in the reservation grid as you have
specified. View the error log to see which, if any, reservations were moved to the wait
list to give preference to SunGard Banner events.
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Find Reservations | ALL

The Find Reservations Search form is designed to allow users to quickly and easily find a
specific reservation or set of recurring reservations based on specific criterion. The fields
displayed for users to search by can be customized using the Form Designer.

To perform a search for a reservation or a set of recurring reservations:

1. Click the Meetings icon.

2. The Find Reservation Search form opens.

3. Enter your criterion into each respective search field.

C;j Meeting Room Manager

Wildcards such as % and ? can be used on their own in the search fields.

In Date fields, you can search for values after or before a certain date by placing < or
> before the date (i.e.: >DD/MM/YY).

The pop-up calendar can also be used for date fields by clicking on the calendar
icon to the right of the field.

In Number fields, you can search for values greater than or less than a certain
number by placing < or > before the number (i.e.: >4).

Click on a pull-down menu to the right of a field to select from default values.

The Meeting Start and Meeting End fields do not operate as a range naturally. To
search based on a date range, use the greater than or less than signs along with
dates in the Meeting Start and Meeting End fields.

For example, to search for reservations starting December 1st, 2006 or later, enter
>12/1/2006 into the Start Time field.
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Note that he manner by which the date is entered varies depending upon your
browser settings. In the US, MM/DD/YYYY is commonly used, while in Canada, DD/
MM/YYYY is commonly used.

4. Click Find to list all matching reservations.

Find Rooms and Resources | ALL

The Find Resources Search form is designed to allow users to quickly and easily find a
particular room or group of rooms based on specific criterion. The fields displayed for
users to search by can be customized using the Form Designer.

To find a meeting room or resource based on your criterion:

1. Click the Resources icon.
2. The Find Resources Search form opens.

3. Enter your criterion into each respective search field.
« Wildcards such as % and ? can be used on their own in the search fields.

« In Number fields, you can search for values greater than or less than a certain
number by placing < or > before the number (i.e.: >4).

+ Click on a pull-down menu to the right of a field to select from default values.
+ The Meeting Start and Meeting End fields do not operate as a range.

4. Click Find to list all matching rooms and resources.
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Filters Overview | ALL

Filters allow users to view only the specific information they want to see in the reservation
grid. Users without permissions to manage filters can apply existing filters or create their
own temporary filter called a Custom Filter.

Apply a Location Filter | ALL

When you select a location from the Available Locations Hierarchy, only the resources
assigned to the selected location are displayed in the grid. By default, each user views all
locations. This filter does not affect your My Location or time zone settings.

Apply a Resource or Reservation Filter | ALL

Resource and reservation filters can be created by administrators with the Manage filter
permissions. Any user can utilize the filters for narrowing the information displayed in the
reservation grid.

The resource filters can also be used with the MRM plug-in for Microsoft Outlook. Refer to
the “Create an MRM Reservation in Outlook” section of “The MRM Plug-In for Microsoft
Outlook” chapter for details.

To apply an existing filter to the reservation grid:

1. Select Filters to the left of the main screen.
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Access the appropriate Filter pull-down by clicking its maximize arrow. Choose from
the Resource Filter list or the Reservation Filter list.

Select the predefined filter you wish to apply.

4. Only the resources or reservations that match the selected filter’s criterion display in

Add a Filter | Kate

the reservation grid.

Resource and reservation filters allow users to view only the specific information they
want to see in the reservation grid. They can be used by all users.

The resource filters can also be used with the MRM plug-in for Microsoft Outlook. Refer to
the “Create an MRM Reservation in Outlook” section of “The MRM Plug-In for Microsoft
Outlook” chapter for details.

To add a new filter for all users to utilize:

1.
2.
3.

Click the Admin icon.
Click the Filters icon.

In the filter list that opens, from the Filter Type field pull-down menu select the filter
type that you wish to create: Resource Filter or Reservation Filter.

Your selection determines which of the two lists of existing filters is displayed.

4. Click the Add button.

214

. Thefilter creating version of the appropriate search form opens.

«+ Enter yourfilter’s criterion into the available fields, then click the Find button.
« Wildcards such as % and ? can be used on their own in the search fields.

- In Date fields, you can search for values after or before a certain date by placing < or
> before the date (i.e.: >DD/MM/YY).

+ The pop-up calendar can also be used for date fields by clicking on the calendar
icon to the right of the field.

+ In Number fields, you can search for values greater than or less than a certain
number by placing < or > before the number (i.e.: >4).

+ Click on a pull-down menu to the right of a field to select from default values.

Click the Apply Filter button.
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7. The filter’s detail form opens. In the Filter Name field, enter the name you wish to use
for this filter.

8. Click OK. Your new filter now displays in the list of filters.

Delete a Filter | Kate

To permanently delete an existing filter:
1. Click the Admin icon.
2. Click the Filters icon.

3. Inthefilter list that opens, from the Filter Type field pull-down menu select the filter
type that you wish to create: Resource Filter or Reservation Filter.

Your selection determines which of the two lists of existing filters is displayed.
4. Check the box beside the filter you wish to delete.
5. Click the Delete button.

6. A confirmation prompt asks you to confirm that you wish to delete the filter. When
you are ready, click Yes.

Apply a Custom Filter | ALL

The Custom filter allows users to perform a customized search for resources or
reservations and then temporarily apply the results of the search to the reservation grid.
Only the matching resources or reservations are displayed.

The intent of this filter is to limit the vast number of filters that could accumulate if all
users could save their specific filters, and to allow those users without Manage Filters
permissions to see their own customized view of the reservation grid.

To apply a custom filter:

1. Select Filters to the left of the main screen.

2. From the Resource Filters or Reservation Filters pull-down menu, whichever best
applies to the custom filter you are creating, select Custom Filter.

w

In the Search form that opens, enter your filter’s criterion.
4. Click the Find button.
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5. When you are satisfied with the results, click Apply Filter.

6. The grid refreshes, now displaying only the data that qualifies based on the custom
filter you just created.

7. The custom filter will remain intact until you select another filter or log out.
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Generate a Grid View Report Juliette

Meeting Room Manager allows users to create a semi-customized report for the day,
week, and month views of the grid.

To generate a grid view report:

1. Click the Printer icon at the right of the main screen.

N

In the Report Options form, enter the heading and subheading for your report.

w

Select which report you wish to create, either daily, weekly, or monthly.

s

The Report Options form refreshes and displays the criterion fields for the report you
have chosen. Enter the criterion for your report.

w

When you are ready to generate the report, click the Print button.

6. The report prints to screen. To print to your printer, choose File > Print.

Generate a Report Juliette

Once you generate a Crystal-based report, you can preview it, print it, export it, or send it
by email through your workstation’s MAPI compliant email program.

Permissions apply to reports. Just as in the Meeting Room Manager user interface,
users can only see data for locations which they have permissions to view. Reservation
details are also limited by the location-specific View Others Meetings permission. For
more details about permissions, refer to the “Security” chapter.
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To generate a report:

1. Click the Reports icon.

2. Select the report you with to generate from the list. Then click the Print/Preview
button.

3. The parameters for the report you selected load. Enter your criterion, then click the
Display Report button.

4. The report is generated and displays.
«+ To preview through the various pages of the generated report, click the forward and
back arrows. The zoom can be adjusted by selecting a zoom percentage from the
zoom pull-down menu.

« To print the generated report, click the printer icon.
« To export the generated report, click the export icon.
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Provide Product Feedback | ALL

At NetSimplicity we take pride in our customer-centric approach to product
enhancement and development. As such, we place tremendous importance on the
feedback from our customers. The ideas behind many of the powerful features in Meeting
Room Manager as well as our other products have come directly from customers like you.

Let us know how we can improve our products. If at any time you have a suggestion to
make the software better, please give us your feedback so that it can be considered for
future service packs and versions of Meeting Room Manager.

To provide your feedback:

1. Click on the Online Help icon on the main screen of the Meeting Room Manager
interface.

2. Select Product Feedback from the Contents list.
3. Click the link provided.

The online feedback form opens allowing you to express your product enhancement
suggestions. You have the option of filling in your information on the feedback form if
you don't mind having us potentially contact you for more information.

Thank you in advance for your input!

C;j Meeting Room Manager P



Chapter 19 | Product Feedback

220



	MRM 7.9 Enterprise Admin Guide
	Table of Contents
	Chapter 1: Introduction
	Product Overview
	Documentation Overview
	Meeting Room Manager Editions Overview
	Understanding Users
	System Requirements
	Installation and Activation
	SQL Server 2005 Configuration
	Setup Wizard
	Run Meeting Room Manager
	Prepare Database for Users
	User Licenses
	Release Concurrent Licenses
	Locked Out Users Report
	Adjust Session Timeout

	Chapter 2: Reservation Database Configuration
	Understanding Your Reservation Database
	Options
	Schedule Tab
	Colors Tab
	Email Messages Tab
	Confirmation Tab
	Schedule Limit Tab
	Grid View Tab
	Others Tab
	Configure the Mail Server
	Send Email from the Server
	Set Email to use Outlook API
	Audit Log
	Save Rules
	MRM Window Service Admin
	Automating the Text Data Extraction Script
	Automating the XML Data Extraction Script
	Text and XML data export formatting

	Chapter 3: Security
	Security Overview
	Implementing Active Directory in MRM
	Windows Authentication
	General Permissions
	Location Permissions
	Security Groups
	Usernames
	Log In
	Edit Your User Profile
	Log Out
	Implement Priority Rights
	Reassign Meetings

	Chapter 4: Customizations
	Customizations Overview
	Form Design Overview
	Form Design Toolbox
	Adding a Tab
	Tab Properties
	Removing a Tab
	Adding a Field
	Field Properties
	Removing a Field
	Designing a Search Form
	Adding Images to the Interface
	Language and Label Translations
	Automated Email Reminders

	Chapter 5: Locations
	Locations Hierarchy
	Time Zones
	Adding a Location
	Editing a Locations
	Deleting a Location
	Adjusting Location Hiearchy Order
	Setting Reservation Form Tabs by Location
	My Location

	Chapter 6: Resources and Requirements
	Resources and Requirements
	Preparing Requirements Availability
	Implementing Inventory Tracking
	Applying Prices to Equipment
	Resource Types
	Adding a Resource
	Adding a Picture to a Resource
	Viewing and Editing a Resource
	Removing a Resource
	Changing Grid Order

	Chapter 7: Services Management Module
	Services Management Overview
	Managing Services
	Security Settings for Services
	Services Catalogues
	Service Items
	Order Process
	Pending Orders: View, Confirm or Reject
	Processing Orders: View or Cancel
	Viewing Archived Orders
	Service Order Email Messages

	Chapter 8: Reservations
	Reservation Grid
	Private Meeting Support
	Creating a Reservation
	Setting Recurrences
	Finding Available Resources
	Multiple Resource Reservations
	Preparation and Cleanup Time
	Locked Tabs
	Invoice Tab
	Assigning Cell and Font Colors
	Request Services
	Priority Reservations
	Meeting Conflict Resolution
	Create a Wait List Entry
	Time Period Blocking
	Opening a Reservation Form
	Editing Reservation Details
	Editing Scenarios Which Affect Service Orders
	Copying a Reservation
	Cutting and Pasting a Reservation
	Delegating a Reservation
	Deleting a Reservation

	Chapter 9: Attendees
	Attendees Overview
	Integration with Outlook
	MRM Address Book
	Outlook Address Book
	Outlook Invitations
	ActiveX Control Setup for Outlook
	Notes Address Book

	Chapter 10: The MRM Plug-In for Microsoft Outlook
	Overview of the MRM Plug-In for Microsoft Outlook
	Install the MRM Plug-In
	Setting the Default Location
	Configuring the MRM Plug-In
	Refreshing Field Data
	Preventing automatic refreshing of mapped field data
	Creating an MRM Reservation in Outlook
	Creating a private meeting
	Delegating meetings with the MRM Plug-In
	Working offline
	Requesting Services in Outlook
	Editing an MRM Reservation in Outlook
	Deleting an MRM Reservation in Outlook
	Recurring MRM Reservations in Outlook
	Adding fields to the MRM form

	Chapter 11: Meeting Requests
	Meeting Request Overview
	Customize the Request Meeting Form
	Post the Request Meeting Form
	Request a Meeting
	Confirm a Meeting Request

	Chapter 12: Confirmations
	Confirmation Overview
	Confirm Reservations

	Chapter 13: Wait List
	Wait List Overview
	Enable the Wait List
	View the Wait List
	Manage an Overridden Reservation
	Reassigning an Entry
	Delete an Entry
	Send Status Notice

	Chapter 14: LCD Panel Configuration
	LCD Panel Overview
	Step One: MRM Server Service Pack Installation
	Step Two: LCD Hardware Setup and Network Login
	Step Three: LCD Panel Client Components Installation
	Step Four: Configure the LCD Panel
	Summary Tab
	Setup Tab
	Rooms Tab
	Room Details Tab
	Schedule Tab

	Chapter 15: SunGard Banner Data Import
	SunGard Banner Data Import Overview
	Creating a New Field
	Import Process

	Chapter 16: Find
	Find Reservations
	Find Rooms and Resources

	Chapter 17: Filters
	Filters Overview
	Apply a Location Filter
	Apply a Resource or Reservation Filter
	Add a Filter
	Delete a Filter
	Apply a Custom Filter

	Chapter 18: Reports
	Generate a Grid View Report
	Generate a Report

	Chapter 19: Product Feedback



